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Declaration

Manufacturer: Thermo Fisher Scientific

Thermo Fisher Scientific is the manufacturer of the instrument described in this manual and, 
as such, is responsible for the instrument safety, reliability and performance only if:

• installation

• re-calibration

• changes and repairs

have been carried out by authorized personnel and if:

• the local installation complies with local law regulations

• the instrument is used according to the instructions provided and if its operation is only 
entrusted to qualified trained personnel

Thermo Fisher Scientific is not liable for any damages derived from the non-compliance with 
the aforementioned recommendations.

Thermo Fisher Scientific

19 Mercers Row
Cambridge
CB5 8BZ
United Kingdom
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Preface

This Operating Manual contains descriptions of the features and components of the Flash 
2000 Elemental Analyzer, inside, you will find all of the information necessary for routine 
operation of your Elemental Analyzer, including operating sequences, sample injection 
techniques, diagrams and descriptions of the major components.

This manual is organized as follows:

Chapter 1, “Preliminary Information,” , provides information on the classification of the 
equipment, its safety and configurations. Basic technical features are also described.

Part 1, “Description,” , describes the structure of the instrument and the pneumatic circuits.

Chapter 2, “Structure of the Instrument,” , describes the structure of the instruments and its 
major features.

Chapter 3, “Instrument Description,” , gives you a detailed description of the instrument 
components.

Chapter 4, “Pneumatic Circuits,” , describes the pneumatic circuit of each instrument 
configuration in the pre-run condition.

The Flash 2000 Elemental Analyzer
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Part 2, “Preparation,” , provides description of the reactors and adsorption filters required to 
run analyses with instructions for their preparation, and also description of gas 
chromatographic columns. Moreover it contains instructions to install and remove the system 
reactors and filters, to perform sample preparation and weighing, and also how to start up the 
instrument before running analyses.   

Chapter 5, “Preparation of Reactors and Adsorption Filters,” , provides instructions for the 
preparation of the reactors and the adsorption filters, and it also reports the types of analytical 
columns currently used.

Chapter 6, “Connecting Reactors and Adsorption Filters,” , contains the instructions to install 
reactors and adsorption filters into the elemental analyzer, and it also provides information on 
how to remove them. 

Chapter 7, “Preparing the Sample,” , describes some techniques for the sample preparation, 
also it provides basic instructions to homogenize and weigh the sample.

Chapter 8, “Analytical Methods,” , describes the analytical methods used for all configurations 
of the Flash 2000 elemental analyzer.

Part 3, “Analysis,” , contains information and operating sequences to perform the analysis 
preparation, execution and interpretation.

Chapter 9, “Instrument Start-up,” , contains information and operating procedures to prepare 
the instrument for running analyses.

Chapter 10, “Guide to Run Analyses,” , contains information and operating sequences to run 
sample analyses, and it also describes the comparison methods for a correct evaluation of 
results. Practical advise for daily operation is also provided.

Chapter 11, “Applications,” , contains guidelines referring to the applications of the Flash 
2000 elemental analyzer.

Chapter 12, “Use of Eager Simplified User Interface,” , provides information about the use of 
the “easy” version of the Eager 300 software.

Part 4, “Maintenance and Troubleshooting,” , contains information and operating sequences 
to perform the necessary maintenance of the instrument and also information concerning 
troubleshooting in case of malfunctioning.

Chapter 13, “Maintenance,” , provides information on the current and periodic maintenance 
of the instrument, and it also contains the operating sequences for installation and 
maintenance of the MAS 200 R Autosampler and the CM2 Manual Sampler.

Chapter 14, “Troubleshooting,” , provides the information necessary to give you some hints 
on instrument problems and how to solve them.

Appendix A, “Customer Communication.” , contains information for direct contact with 
Thermo Fisher Scientific offices worldwide. This appendix also contains a one-page Reader 
Survey.

The Abbreviations contains definitions of terms used in this guide. It also includes 
abbreviations, acronyms, metric prefixes, and symbols.
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The Index contains an alphabetical list of key terms and topics in this guide, including cross 
references and the corresponding page numbers.

Compliance
We thoroughly test and evaluate our products to ensure full regulatory compliance with 
applicable domestic and international regulations. Your system (hardware and software) is CE 
Compliant and meets Electromagnetic Compatibility (EMC) and safety standards.

Safety Alerts and Special Notices
In this paragraph, safety alerts and other special notices appear in boxes. 
Safety alerts are a combination of safety symbols and signal words designed to alert you to protect 
yourself and/or your instrument. Please read about the types of safety alerts, signal words, and 
the safety symbols that are presented in this guide and presented on the instrument. 

Safety Symbols

Safety and special notices that may be found on your instrument and in this manual include 
the following:

CAUTION  Instrument Damage. Flash 2000 systems operate safely and reliably under 
carefully controlled environmental conditions. If the equipment is used in a manner not 
specified by the manufacturer, the protections provided by the equipment may be impaired. 
If you maintain a system outside the specifications listed in this guide, failures of many 
types may occur. The repair of such failures may be excluded from the documents regarding 
your standard warranty and service contract coverage. 

The General Warning symbol/sign is a triangle with an exclamation mark that is 
used next to the signal word. In the vocabulary of ANSI Z535 signage this 
symbol indicates a possible personal injury hazard exists. The ISO 3864-2 
standard refers to this as the general warning sign. This symbol alerts you to an 
action or sequence that, if improperly performed could results in damage to the 
instrument or possible personal injury. This symbol is followed by signal words 
such as Danger, Warning, or Caution indicating the risk.

This symbol indicates that an electrical shock hazard will, could, or may occur.

This symbol indicates a hot surface. Make sure the instrument is at room 
temperature before touching, or else you will, could, or may incur burn injuries.

This symbol indicates a risk of fire or flammability, or that fire/flammability 
damage will, could, or may occur.

This symbol indicates that a biohazard will, could, or may occur.
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Types of Alerts and Signal Words

Safety alerts that may or may not be associated with the use of this instrument. These 
instructions are defined as follows:

Special Notices

Instrument Markings and Symbols
The following table explains the symbols used on Thermo Fisher Scientific instruments. Only 
a few of them are used on the Flash 2000. See the asterisk.

This symbol indicates that chemical damage or physical injury will, could, or 
may occur.

This symbol indicates the presence of radioactive material.

This symbol indicates that eye damage will, could, or may occur. Eye protection 
must be worn.

This symbol indicates the user must wear gloves when performing the 
sequence.

DANGER safety alerts an imminent hazard exists that WILL result in death or serious 
personal injury. 

WARNING    safety alerts you to an action or sequence that, if improperly performed, could 
result in damage to the instrument or possible physical harm to the user. This symbol may 
be followed by icons indicating special precautions that should be taken to avoid injury. 

CAUTION  safety alerts you to an action or sequence that, if performed improperly, could 
damage the instrument. 

Note  alerts you to important information related to the test. 

Tip  Helpful information that can make a task easier. 

Symbol Description

Direct Current

*
Alternating Current
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Both direct and alternating current

Three-phase alternating current

Earth (ground) terminal

Protective conductor terminal

Frame or chassis terminal

Equipotentiality

*
On (Supply)

*
Off (Supply)

Equipment protected throughout by DOUBLE INSULATION or 
REINFORCED INSULATION (Equivalent to Class II of IEC 536)

* Instruction manual symbol affixed to product. Indicates that the user must 
refer to the manual for specific Warning or Caution information to avoid 
personal injury or damage to the product.

Caution, risk of electric shock

*
Caution, hot surface

*
Caution, biohazard

In-position of a bistable push control

Out-position of a bistable push control

*
Jack socket

Symbol Description

3
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Using the Flash 2000 Document Set
The Flash 2000 Document Set (CD-Rom PN 317 095 10) includes all manuals in electronic 
format, and serves as your library for information about the hardware and software of your 
elemental analyzer. 

The Flash 2000 Document Set (PN 317 120 50) as paper copy is also available Furthermore, 
Thermo Fisher Scientific part numbers (PN) for the paper copy manuals are provided for each 
book title.

• Site Preparation and Installation Requirements (PN 317 120 51)
This manual describes how to set up a workspace for the instrument and accessories and 
how to connect the main unit to the gas supplies and peripheral devices.

• Operating Manual (PN 317 120 52)
This manual provides the descriptions of the hardware and software and detailed 
instructions for their use.

• Consumables and Spare Parts Catalog (PN 317 082 50)
This catalog contains a list of consumables and spare parts for the Flash 2000.

Other available manuals are:

• Eager Xperience Software Manual (PN 317 110 55)
This manual contains instruction to operate with Eager Xperience to the fully control of 
the Flash elemental analyzers.

• AI 3000/AS 3000 II Autosampler for Flash Operating Manual (PN 317 094 45) 
This manual contains description of the features and components of the AI 3000/AS 
3000 II Autosampler for Flash elemental analyzers.

• Flash HT Elemental Analyzer User Guide (PN 317 082 71)
This guide is an additional section of the Flash 2000 Operating Manual containing the 
instruction to operate on the Flash HT Elemental Analyzer.

* Symbol in compliance to the Directive 2002/96/EC on Waste Electrical and 
Electronic Equipment (WEEE) placed on the european market after 
August, 13, 2005.

Symbol Description
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Preliminary Information

This chapter provides information on the classification of the equipment, its safety and 
configurations. Basic technical features are also described.

Classification of the Instrument

Environmental Conditions

• Internal use.

• Altitude up to 2000 meters.

• Temperature from 15 to 35 °C.

• Maximum relative humidity between 30% and 85%.

• Voltage variations not exceeding % of the nominal value.

• Transients according to installation categories II.

• Degree of pollution according to IEC 664 (3.7.3) 2.

Contents

• Classification of the Instrument

• Technical Features

• Safety Information

• Safety Cut Off Device

• Instrument Cleaning

• Instrument Configuration

• Standard Outfit

10±
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Technical Features
Technical Features
The following table summarizes the major technical features of the Flash 2000 elemental 
analyzer.

Safety Information

Use of Gases

The following gases are used with the instrument:

• Helium (He) as carrier gas.

• Oxygen (O2) as gas for sample oxidation.

Purity of Gases

The Flash 2000 uses Helium and Oxygen with 99.995% minimum purity.

Table 1. Technical features of the instrument

Features Description

Instrument configurations Fourteen

Detector Thermal conductivity detector (TCD)

External interface RS 232 serial line

Instrument control Eager Xperience for Windows™

Power supply 230 Vac; 50/60 Hz; 1400 VA

Dimensions (cm) Height 50 (54 with fittings); Width 59, Depth 58

Mass (kg) 65

WARNING    The instrument must be used according to the specifications of this guide. 
Improper use can adversely affect the instrument protection. If the equipment is connected 
to optional instruments, such as computer, balance, etc., the degree of insulation of 
peripheral devices should be equivalent or higher (double or reinforced) than that of the 
Flash 2000. The analyzer operation requires the use of chemical substances having different 
hazard specifications. Before using chemicals, please read the hazard indications and 
information reported in the Safety Sheet supplied by the manufacturer referring to the 
relevant CAS (Chemical Abstract Service) number.

WARNING    Before using gases, carefully read the hazard indications and information 
reported in the Safety Sheet supplied by the manufacturer referring to the CAS (Chemical 
Abstract Service) number. It is the user’s responsibility to see that all local safety regulations 
for the use of gases are obeyed.
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Safety Cut Off Device
Nominal Pressure of Gases

The nominal pressure of the gases to supply the Flash 2000, as indicated on the instrument rear 
panel, are:

• Maximum 250 kPa (2.5 bar) for He

• Maximum 250-300 kPa (2.5-3 bar) for O2 according to the analytical configuration

Safety Cut Off Device
When an alarm condition is detected, this device cuts off the power to the heating resistors of 
the oxidation, reduction furnaces and to the traps.
For more details please refer to Chapter 14, “Troubleshooting,” 

Instrument Cleaning
 Instruments Cleaning

1. Externally clean the instrument with a soap and water solution, or with a household 
non-abrasive product, carefully avoid seeping of the products used inside the instrument.

2. If you just suspect that a substance used for cleaning or a product submitted to analysis has 
infiltrated inside the instrument, immediately shut down the instrument and call an 
authorized customer support engineer for proper actions.The service engineer must be 
fully informed on the nature of the concerned substance.

Instrument Configuration
The Flash 2000 elemental analyzer is available in fourteen different versions. Analytical 
techniques, pneumatic circuits and standard outfits are different for each version.

WARNING    Cleaning must be performed with the instrument off, the furnaces at room 
temperature and the power cord disconnected.

WARNING    It is your responsibility to avoid that dangerous liquids and/or materials 
seeping inside the elemental analyzer during operation and maintenance.

Table 2. Flash 2000 Series: Instrument versions

Configuration Description

CHN Analyzer For the determination of the amount (%) of carbon, hydrogen 
and nitrogen, contained in organic and inorganic chemical 
products and in substances of different nature and origin, be they 
solid, liquid or gaseous samples.
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Instrument Configuration
CHN-O Analyzer For the determination of the amount (%) of carbon, hydrogen, 
nitrogen and determination of oxygen, contained in organic and 
inorganic chemicals and in substances of different nature and 
origin, be they solid, liquid or gaseous samples. 

The determination of carbon, hydrogen and nitrogen is performed in 
a single sample analysis, whereas oxygen determination is performed 
separately.

CHNS Analyzer For the simultaneous determination of the amount (%) of carbon, 
hydrogen, nitrogen and sulfur, contained in organic and inorganic 
chemical products and in substances of different nature and 
origin, be they solid, liquid or gaseous samples.

CHNS-O Analyzer For the determination of the amount (%) of carbon, hydrogen, 
nitrogen, sulfur and determination of oxygen, contained in 
organic and inorganic chemical products and in substances of 
different nature and origin, be they solid, liquid or gaseous 
samples. 

The determination of carbon, hydrogen, nitrogen and sulfur is 
performed in a single sample analysis, whereas oxygen determination 
is performed separately.

S Analyzer For the determination of the amount (%) of sulfur contained in 
organic and inorganic chemical products and in substances of 
different nature and origin, be they solid, liquid or gaseous 
samples.

O Analyzer For the determination of the amount (%) of oxygen contained in 
organic and inorganic chemical products and in substances of 
different nature and origin, be they solid, liquid or gaseous 
samples.

N Analyzer For the determination of the total amount of nitrogen present in 
organic and inorganic chemical products and in substances of 
different nature and origin, be they solid, liquid or gaseous 
samples.

N Lubricant Analyzer For the determination of the total amount of nitrogen present in 
lubricants, lubricant additives, fuel additives, petrochemical 
products.

Table 2. Flash 2000 Series: Instrument versions, continued

Configuration Description
16 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



 1 Preliminary Information
Standard Outfit
1.For detains about these configurations refer to the Flash 2000 HT User 

Standard Outfit 
Flash 2000 elemental analyzer is provided with its own standard outfit.
Use the standard outfit checklist accompanying the instrument to verify that all items have 
been received.

NC Analyzer For the determination of the amount (%) of nitrogen and carbon 
contained in materials of different kinds: 

• Synthetic materials: polymers, rubbers, tyres, etc.
• Explosives: nitrocellulose, TNT, gun powder, etc. 
• Special materials: carbon fibers, glass fibers, conductive 

polymers, graphite, etc. 
• Metallurgy: metal powders, steels, etc. 
• Environmental analyses: muds, discards, organic wastes, etc.

NCS Analyzer For the simultaneous determination of the amount (%) of 
nitrogen, carbon and sulfur contained in organic and inorganic 
chemical products and in substances of different nature and 
origin, be they solid, liquid or gaseous samples.

NC-Soils Analyzer For the determination of the nitrogen and carbon content in soil 
samples.

NC-Sediments Analyzer For the determination of the nitrogen and carbon content in 
sediments.

NC-Filters Analyzer For the determination of the nitrogen and carbon content in 
particulate samples filtered on Whatman filters.

N/Protein Analyzer For the determination of the nitrogen and protein amount in 
products of biological origin; it can also be used in determining 
nitrogen content in samples of different nature, generally 
agricultural products and foodstuff.

N-Brew Analyzer For the determination of nitrogen content in samples of different 
nature, belonging to the brewing industry, such as malt, barley, 
wort and beers.

NC-IRMS Analyzer 1 Flash 2000 analyzer able to be coupled to an Isotopic Ratio Mass 
Spectrometer (IRMS).for the determination of Nitrogen and 
Carbon.

Flash 2000 HT analyzer 
1

Flash 2000 analyzer with the left furnace at high temperature 
(1450 °C) for the determination of Oxygen and Hydrogen by 
pyrolysis and with the right furnace at 1000 °C for the 
determination of Nitrogen and Carbon (or Sulfur).

Table 2. Flash 2000 Series: Instrument versions, continued

Configuration Description
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Standard Outfit
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Structure of the Instrument

This chapter describes the structure of the instrument and its major features.

The Units Constituting the Instrument
The instrument, in its different configurations, consists in a single structure subdivided into 
two sections:

• Analytical Section

• Control Section

Analytical Section
It comprises the following major components:

Furnaces

Each furnace consists of a candle surrounded by an electrical resistor. The candle is plunged in 
a refractory material housed in a metal compartment.

• Furnace Temperature
The temperature is monitored by a thermocouple appropriately located in the furnace.

• Furnace Cooling
The cooling time varies according to the operating temperature setting. 

The Flash 2000 analyzer can be equipped with one or two furnaces according to the 
instrument configuration.

Contents

• The Units Constituting the Instrument

• Analytical Section

• Control Section

• Automation

• Pneumatic Circuit
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2 Structure of the Instrument
Control Section
• LEFT Furnace
Present in all configurations.

• RIGHT Furnace
Present only when required by the instrument configuration.

Thermal Conductivity Detector (TCD)

It is located in a thermostatic chamber at controlled programmable temperature. This 
chamber also accommodates the analytical column.

Chromatographic Columns

The chromatographic column performs the chromatographic separation of the reaction 
products generated during the combustion or pyrolysis process. 

The column can be kept at room temperature, or it can be placed in the thermostatic chamber 
of the TCD detector according to the instrument configuration. 

The CHNS-O and CHN-O instrument versions use two analytical columns placed inside the 
thermostatic chamber. 

Adsorption Filters

They can be made of glass or Plexiglas according to the analytical configuration. Refer to 
Chapter 5, “Preparation of Reactors and Adsorption Filters,” .

Reactors

These are tubes made of quartz or special alloy filled with different materials according to the 
analytical configuration. Refer to Chapter 5, “Preparation of Reactors and Adsorption Filters,” 
.

Autosampler

It performs the automatic injection into the reactor of samples.

Control Section
The control section consists of two major components:

Pneumatic Compartment

It consists of two pressure reducers, two pressure gauges and of several lines fitted with an 
thermoregulator electronic flow controller (EFCt), which ensures the switching between 
helium and oxygen, and controls the flow values.
For more details, please refer to Chapter 4, “Pneumatic Circuits,” .
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 2 Structure of the Instrument
Automation
Electronic Compartment

It comprises the electronic boards for the instrument power supply and control. 

Automation
The instrument is fully controlled by the computer through Eager Xperience dedicated 
software which is also used for data acquisition, data handling and interpretation of the 
acquired results. Therefore the instrument is not provided with independent keyboard and 
display. On the instrument front there is a synoptic panel where you can monitor the 
instrument statuses.

Eager Xperience is designed to be compatible with commercially available computers and 
Windows™ 2000/XP/Vista operating system.

Pneumatic Circuit 
Each configuration of the Flash 2000 elemental analyzer has its own dedicated pneumatic 
circuit. For details, please refer to Chapter 4, “Pneumatic Circuits,” .

Table 3. Hardware minimum requirements

Components Description

Computer Any PC can be used, including laptop computer

Operating System: Windows™ 2000/XP/Vista

Pentium Processor minimum 256 MHz

Hard drive with at least 1 GB free

One free COM port for instrument contr

One free COM port for balance, if required

One free COM port for AI 3000/AS 3000 II autosampler, if required

CD driver

Monitor Color 1024 x 768 or better

Printer Any printer accepted by the operating system
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2 Structure of the Instrument
Pneumatic Circuit
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3

Instrument Description

This chapter gives you a detailed description of the instrument components.

Contents

• Front Panel

• Rear Panel

• Top Panel

• Furnaces Compartment

• Fixing Plates for the Reactors

• Fittings for Gas Connections

• Detector Compartment

• Description of the Detection System

• Electrical Compartment

• Connections Panel

• Transformers Compartment

• Synoptic Panel

• Autosamplers

• Manual Injection Device for Liquids
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3 Instrument Description
Front Panel
Front Panel
It comprises:

• Furnaces compartment 
Also refer to paragraph “Furnaces Compartment” on page 28.

• Synoptic panel
Also refer to paragraph “Synoptic Panel” on page 38.

• Compartment for the TCD detector thermostatic chamber and for the gas 
chromatographic column.
Refer to paragraph “Detector Compartment” on page 30.

Figure 1. Instrument front panel

Rear Panel
It comprises:

• Panel for connections including:

− interface section

− gas inlet section

− electrical section

Also refer to paragraph “Connections Panel” on page 35.

• Cooling fan

• Transformers compartment
Also refer to paragraph “Transformers Compartment” on page 37.

Access to the furnaces

Access to the thermostatic 
chamber

Synoptic panel
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 3 Instrument Description
Top Panel
Figure 2. Instrument rear panel

Top Panel
It comprises:

• Fittings for mounting and securing the furnaces reactors

• Fittings for gas connection.

Also refer to paragraph “Fixing Plates for the Reactors” on page 29

Figure 3. Instrument top panel

Cooling fan

Connection panel

Transformer compartment panel

Autosampler

Fittings for reactors

Gas connections
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3 Instrument Description
Furnaces Compartment
Furnaces Compartment
The furnaces compartment can be reached from the instrument front and removing (lifting) 
the cover. The furnaces are accessible by removing the protecting plate.

Figure 4. Furnace compartment with protecting plate

Figure 5. Furnaces compartment

Plate protecting
the furnace 
compartment

WARNING    Do not open the furnaces compartment during operation because very high 
temperatures are reached.

The protecting plate can be removed only when the furnaces temperature shown is near 
the room temperature.

Left furnace Right furnace
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 3 Instrument Description
Fixing Plates for the Reactors
The furnaces can reach the following maximum temperatures:

• LEFT Furnace: 1100 °C (1500 °C for HT)

• RIGHT Furnace: 1100 °C

The furnace temperature is monitored by a thermocouple located inside the furnace. 
The furnaces are cooled when required by the operator.
The cooling time depends on the operating temperature.

Fixing Plates for the Reactors
These plates, on top of the furnaces compartment, accommodate the following components: 

• Connections and fittings for the reactors.

• Automatic or manual sampler.

Figure 6. Fixing Plates for the Reactors

Fittings for Gas Connections
They are located on the middle bottom part of the instrument rear panel. Gas inlet ports are 
directly connected to the pressure regulators.

Figure 7. Gas connection ports

Fixing plate

Gas inlet port
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3 Instrument Description
Detector Compartment
Gas pressures must be set and controlled through the pressure regulators and the gauges of the 
instrument. Table 5 provides indications on the most currently used units of pressure. 

Detector Compartment
It is located on the right front part of the instrument and can be reached by opening the door. 
Figure 8 shows the inside of the detector compartment. 

Figure 8. View of the detector compartment

Table 4. Gas Inlet Ports and Pressure Setting

Port Description Pressure value to be set

He Inlet port for Helium 250 kPa (2.5 bar)

O2 Inlet port for Oxygen 250-300 kPa (2.5-3 bar) according to 
the instrument configuration

Table 5. Pressure units conversion

To convert into multiply by

kPa bar 0.01

psi 0.145

bar kPa 100

psi 14.51

psi kPa 6.89476

bar 0.0689476

Adsorption filters
Protecting plate

Gauges
30 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



 3 Instrument Description
Detector Compartment
The detector compartment houses the pressure regulators, the gauges and the thermal 
conductivity detector (TCD), located behind the protecting plate and the gas 
chromatographic column. Refer to “Access to the Detector” on page 31. The adsorption filters 
are housed in this compartment.

 Access to the Detector

1. Open the right side door to have access to the thermostatic chamber, 

2. To reach the detector, remove the adsorption filters from the fastening clips.

3. Undo the four fixing screws on the protecting plate.

Figure 9. Access to the detector

Figure 10 shows the detector compartment, the heating block surrounding the detector, and 
the gas chromatographic column.

Note  One or two adsorption filters may be required, according to the instrument 
configuration.

Note  One or two analytical columns may be required, according to the instrument 
configuration.

Protecting plate

Fixing screws

Fixing screws

adsorption filters
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3 Instrument Description
Description of the Detection System
Figure 10. TCD detector compartment

Description of the Detection System
It consists of a thermal conductivity detector (TCD) sensitive to any substance with thermal 
conductivity other than that of the carrier gas used. 

The detector essentially consists of a stainless steel block provided with two pairs of filaments 
(generally of tungsten/rhenium) having the same electrical resistance. The detector is housed 
in a thermally insulated metal block (detector oven) and maintained at constant temperature.
The two pairs of filaments are electrically connected according to a Wheatstone bridge circuit 
powered at constant voltage. 
The first pair of filaments is fed with pure carrier gas (reference channel), whereas the second 
pair is fed with the gas flowing from the reactor (analytical channel). 
When the bridge is powered, the filaments heat at a temperature (resistance) that is a function 
of the thermal conductivity of the gas feeding the filaments. The reference channel is exposed 
only to pure carrier gas, whereas the analytical channel is exposed to the reactor effluents 
(carrier gas + sample). 
When pure carrier gas flows through both the reference and the analytical channels, a constant 
temperature gradient is established between the elements and the detector walls, and the 
Wheatstone bridge is balanced, namely there is no output signal. As a component is eluted, a 
change in heat transfer occurs, with consequent variation of the filaments temperature. Since 
electrical resistance is a function of temperature, the bridge unbalances and the detector 
generates a signal proportional to the difference in thermal conductivity between the eluted 
component and the carrier gas. The output signal is then sent to the data acquisition board.

TCD detector

Heating block

Chromatographic
column

Note  The filaments are powered at 5 V constant voltage and are electrically protected if 
their temperature exceeds 220 °C (Safety Cut Off )
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 3 Instrument Description
Electrical Compartment
Electrical Compartment
It is located on the right part of the instrument, and it is accessible by removing the right side 
cover. Behind the electrical compartment, there is the Connections Panel (for more details, 
refer to the relevant paragraph, page 35).

The electrical compartment, shown in Figure 11, comprises:

• Low voltage section

• Mains voltage section 

• EFC electronic flow controller for gas regulation

Figure 11. Electrical compartment internal view

Low Voltage Section

It contains the electronic boards to operate and control the instrument. These boards (in 
double EUROCARD format, except the EV Control Box and FP1112 boards) are interlocked 
through a mother board. 

Function of the Electronic Boards 

The following Table 6 reports the function of each electronic board present in the low voltage 
section:

CAUTION  Before opening the electrical compartment, cut off power supply to the 
instrument and disconnect the power cord.
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3 Instrument Description
Electrical Compartment
Main Voltage Section

It contains the mains power circuits and the Safety Cut Off device.

The following Table 7 reports the function of each component present in the mains voltage 
section.

Table 6. Description of the Function of the Electronic Boards

Board Function

MB 1112 Mother board. It provides interlocking between low voltage boards 
and with the rest of the instrument. 

This board can be connected to a NiCd 3,6 V; 280 mA/h 
rechargeable battery located nearby. 

The rechargeable battery replacement must be performed by specialized 
technical personnel

CPU 1112 This board has full control of the instrument operation.
It controls the communication between operator and machine 
through Eager Xperience. 

Actuates the Safety Cut Off device, which puts the instrument in safe 
conditions, when an alarm condition occurs. 

EV Control Box Receives voltage supply from the TRF 1112 board. It operates the gas 
controlling solenoid valves contained in the EFC flow controller. 

The board is provided with a T0,16A 127/III (5 x 20 mm) protection 
fuse. 

HWD 1112 Provides power supply to the HWD detector filaments. 

Allows the detector oven thermoregulation and also amplifies and 
converts the detector signal to send it to the PC.

TCR 1112 Operates and controls the furnaces thermoregulation.

PWR 1112 Receives voltage supplies from the TRF 1112 transformers board. 

It generates voltage supply for the electronic control circuits.

FP 1112 Synoptic panel
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 3 Instrument Description
Connections Panel
Description

Connections Panel
The panel, shown in Figure 12, is subdivided into three sections:

• interface 

• power supply

• gas inlets

Table 7. Description of the components of the Main voltage section

Component Description

TRF 1112 Transformers 
Board

Receives the mains power and supplies it to the following devices:

• Cooling fan

• Furnaces transformers

• Heater of the detector thermostatic chamber

Six fuses are provided on the board. See Table 8.

AC 1112 Furnaces 
Power Supply 

Supplies 48 Vac power to the furnaces. It contains the SSR relays 
for the furnaces control. 

Also refer to paragraph “Devices for the Furnaces Control” on 
page 37. 

Two fuses are provided on the board. See Table 8.

Breaker Instrument ON/OFF main switch.

Table 8. Fuses of the High voltage section

Board Fuse Type Protection

TRF 1112 F1 F1A; IEC 127/I (5 x 20 mm) Power supply to LEFT and 
RIGHT furnaces transformers

F2 F0.315A; IEC 127/I (5 x 20 mm) Fan

F3 F1.6A; IEC 127/I (5 x 20 mm) Main power (Breaker)

F4 F1A; IEC 127/I (5 x 20 mm) LEFT and RIGHT furnaces 
transformers

F5 F0.315A; IEC 127/I (5 x 20 mm) Fan

F6 F1,6A; IEC 127/I (5 x 20 mm) Mains power (Breaker)

AC 1112 F1 FF12 A; IEC 269 (1.3 x 38 mm) LEFT Furnace power circuit

F2 FF12 A; IEC 269(1.3 x 38 mm) RIGHT Furnace power circuit
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3 Instrument Description
Connections Panel
Figure 12. View of the Connections Panel

Interface Section

It comprises:

• 9-pin connector marked RS 232 to dialog with the computer via serial line.

• 25-pin connector marked AUX CONNECTOR for the autosampler for liquids if 
required.

• 2-pin connector marked Autosampler for the MAS 200R autosampler for solids.

Power Supply Section

It comprises: 

• Breaker marked MAINS to switch the instrument on/off. 
Position I = instrument on.
Position O = instrument off.

• 230 V; 50/60 Hz mains connector.

Gas Supply Section

It comprises the gas inlet ports. Refer to paragraph “Fittings for Gas Connections” on page 29.

Interface Section

Power supply Gas inlets
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 3 Instrument Description
Transformers Compartment
Transformers Compartment
Located in the right bottom part of the instrument, it is accessible from the rear panel by 
removing the relevant cover.

It contains the electrical devices to power the furnaces and control their temperature. 

Figure 13 shows the devices contained in this compartment.

Figure 13. Transformer compartment internal view

Devices for the Furnaces Control

The following Table 9 describes the function of each device:

CAUTION  Before opening the compartment, switch the instrument off and disconnect 
the power cord.

Table 9. Description of the Devices Controlling the Furnaces

Device Function

LTA-1 LEFT
LTA-1 RIGHT

They read the values of the thermocouple present in the relevant furnace 
and send the signals to the TCR 1112 board.
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3 Instrument Description
Synoptic Panel
Devices Supplying the Furnaces

The following Table 10 reports the function of each device:

Synoptic Panel
This panel shows the instrument operating conditions, and it is located on the right side of the 
instrument front panel.
Each synoptic is provided with a LED, which lights up when the relevant function is active.

Figure 14. Synoptic panel

The following Table 11 illustrates the meaning of each synoptic:

SSR LEFT 
SSR RIGHT

Solid state relays contained in the AC 1112 board. 
Each SSR is coupled with a proper safety sensor, which detects any 
malfunction. 
The SSRs control the power supply to the relevant furnace and cut off 
power to the heating resistor when the thermocouple detects temperature 
values exceeding the setpoint.

Table 9. Description of the Devices Controlling the Furnaces, continued

Device Function

Table 10. Description of the Devices Supplying the Furnaces

Device Function

T1 Transformer Supplies 48V voltage to the right furnace resistor. It is provided with a 
safety thermal protection, which cuts off power in case of overheating 
and then displays an error message.

T2 Transformer Supplies 48V voltage to the left furnace resistor. It is provided with a 
safety thermal protection, which cuts off power in case of overheating 
and then displays an error message.
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 3 Instrument Description
Synoptic Panel
Table 11. Description of the synoptic

Synoptic LED Meaning

Power On When lit, the instrument is powered.

Ready When lit, the instrument is ready to run analyses.

Run When lit, an analysis is in progress.

Stand By When lit, the instrument is in stand-by condition.
During this condition, gas flows are decreased to 
10 ml/min, and the furnaces temperature is 
reduced to 50% of the set value.

Wake Up When lit, the instrument has been programmed 
for a timed automatic startup (Ready Condition).

Furnace On Two LEDs are provided, one for each furnace.
When one is lit, the relevant furnace is powered.

Oven On When lit, the detector oven is powered.

TCD When lit, the detector filaments are powered.

Safety Cut Off It lights up when an alarm condition occurs.
Thermo Scientific Flash 2000 Elemental Analyzer - Operating Manual 39



3 Instrument Description
Autosamplers
Autosamplers 
The Flash 2000elemental analyzer can be configured with the following autosamplers:

MAS 200R Autosampler for Solid Samples

It is mounted directly on the connecting fitting of the concerned reaction tube. 
It consists of:

• Anodized aluminium block provided on the left with fittings for carrier gas and purge gas 
lines connection.

• 32-position sample-holding tray.
Up to 4 optional trays are available to accommodate 125 samples.

NoBlank Sampling Device

This device, interposed between MAS 200R autosampler and Flash 2000 instrument, reduces 
the Nitrogen blank value due to the sampler movement.
The device is particularly suggested for Flash 2000 configuration coupled to IRMS 
instrument. 

AI 3000/AS 3000 II Autosampler for Liquid Samples

It is mounted on the analyzer by means of the appropriate support.

It consists of: 

• Sampling unit

• 8-position (AI 3000) or 105-position (AS 3000) sample tray

CM2 Manual Sampler

It is mounted directly on the connecting fitting of the concerned reaction tube. It consists of:

• Base block provided with a hole for the manual introduction of samples.

Manual Injection Device for Liquids
It allows the direct injection of a liquid sample into the reactor using a syringe.

Note  When the analyzer is equipped with two MAS 200R autosamplers, it is possible to 
switch from a channel to the other by using a dedicated Switching Box. See “To Install the 
MAS 200R Autosampler on the Flash 2000” on page 200.
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4

Pneumatic Circuits

This chapter describes the pneumatic circuit of each instrument configuration in the pre-run 
condition.

Introduction
Each of the instrument configurations of the Flash 2000 Elemental Analyzer works with a 
different analytical technique, and therefore has a different pneumatic circuit. 
All pneumatic circuits have the following common components:

• The EFC Electronic Flow Controller for gases. 

• Inlet gases pressure regulators and relevant gauges.

• The TCD Thermal Conductivity Detector.

According to each analytical configuration, the pneumatic circuit can comprise:

• One or two reactors.

• One or two gas chromatographic columns.

Contents

• Introduction

• Pressure Regulators

• EFC-t Module

• Pneumatic Circuit for CHNS-O and CHN-O Configurations

• Pneumatic Circuit for CHN and CHNS Configurations

• Pneumatic Circuit for O, S and NCS Configurations

• Pneumatic Circuit for NC, NC-Soils, NC-Filters and NC-Sediments 
Configurations

• Pneumatic Circuit for N, N Lubricant, N/Protein and N-Brew 
Configurations

• Pneumatic Circuit for NC-IRMS Configuration

• Pneumatic Circuit for Flash HT Configurations
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4 Pneumatic Circuits
Pressure Regulators
• One or two adsorption filters or none.

The filling of reactors and absorbent filters, and the type of analytical columns vary according 
to the instrument configuration. For more details refer to Chapter 7, “Preparing the Sample,” 

Pressure Regulators
Pressure regulators, located in the detector compartment and schematically shown in 
Figure 15, allow the manual adjustment of the Helium and Oxygen inlet pressure.

Figure 15. Pressure Regulators

Pressure regulators are common to all analyzers. They consist of the following components. 
See Figure 12:

IMPORTANT  All the pneumatic circuits described in this chapter are represented in the 
PreRun condition.

Table 12. Pressure regulators

Component Description and function

He Inlet port for Helium.

O2 Inlet port for Oxygen

PRV1 Helium pressure regulator

PI1 Helium pressure gauge

PRV2 Oxygen pressure regulator

PI2 Oxygen pressure gauge

2O He

PRV1PRV2

PI2 PI1

HeO 2
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 4 Pneumatic Circuits
EFC-t Module
EFC-t Module
The EFC-t module, schematically shown in Figure 16 is common to all analyzers. It consists 
of the following components. See Table 13.

Figure 16. Thermoregulated EFC-t module

Table 13. Parts of the EFC-t module

Component Description

He Inlet port for Helium.

O2 Inlet port for Oxygen.

EV1 Two-way solenoid valve to control Oxygen inlet. 

EV2 Three-way solenoid valve to control Helium inlet and to allow switching 
between Helium and Oxygen.

EV3 Two-way solenoid valve, normally open, to control the inlet of Helium 
flowing back from the TCD detector analytical channel. 
The gas is exhausted to the outside through the Vent port.
The valve is closed during the leak test.

EV4 Two-way solenoid valve, normally open, to control the inlet of Helium 
flowing back from the TCD detector reference channel. The gas is used to 
eliminate air from the MAS 200R autosampler. 
The valve is closed during the leak test.

S1 Electronic flow sensor for Helium as carrier gas and Oxygen during the 
sampling stage. It cooperates with the EVP1 electronic controller 
(proportional valve). 

S2 Electronic flow sensor for Helium as reference gas. It cooperates with the 
EVP2 electronic controller (proportional valve). 

EVP1 Electronic flow controller for Helium as carrier gas and Oxygen to control 
the flowrates of gases according to the flow values set.

EVP2 Electronic flow controller for Helium as reference gas to control the 
flowrate according to the required flow value.
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4 Pneumatic Circuits
Pneumatic Circuit for CHNS-O and CHN-O Configurations
Pneumatic Circuit for CHNS-O and CHN-O Configurations
The pneumatic diagram shown in Figure 17 is common to CHNS-O and CHN-O 
configurations.

Figure 17. Pneumatic Circuit for CHNS-O and CHN-O Configurations

It comprises the following components:

Table 14. Components of the Pneumatic Circuits for CHNS-O and CHN-O

Component Description

EV1-EV2 
EV3-EV4 
EVP1-EVP2
S1-S2

They constitute the EFC module. Refer to paragraph “EFC-t Module” on 
page 43.

AS Autosampler

R1 Quartz reactor for CHNS determination 

R2 Quartz reactor for Oxygen determination

F1 Adsorption filter

CC1 Gas chromatographic column for CHNS determination

CC2 Gas chromatographic column for Oxygen determination

TCD TCD thermal conductivity detector
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 4 Pneumatic Circuits
Pneumatic Circuit for CHN and CHNS Configurations
Pneumatic Circuit for CHN and CHNS Configurations
The pneumatic diagram shown in Figure 18 is common to CHN and CHNS configurations.

Figure 18. Pneumatic Circuit for CHNS and CHN Configurations

It comprises the following components:

Table 15. Components of the Pneumatic Circuits for CHNS and CHN 

Component Description

EV1-EV2 
EV3-EV4 
EVP1-EVP2
S1-S2

They constitute the EFC module. Refer to paragraph “EFC-t Module” on 
page 43.

AS Autosampler

R1 Reactor

F1 Adsorption filter

CC1 Gas chromatographic column

TCD TCD thermal conductivity detector
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4 Pneumatic Circuits
Pneumatic Circuit for O, S and NCS Configurations
Pneumatic Circuit for O, S and NCS Configurations
The pneumatic diagram shown in Figure 19 is common to O, S and NCS configurations.
Pneumatic Circuit for O, S and NCS Configurations.

Figure 19. Pneumatic Circuit for O, S and NCS Configurations

It comprises the following components:

Table 16. Components of the Pneumatic Circuit for O, S and NCS 

Component Description

EV1-EV2 
EV3-EV4 
EVP1-EVP2
S1-S2

They constitute the EFC module. Refer to paragraph “EFC-t Module” on 
page 43.

AS Autosampler

R1 Reactor 

F1 Adsorption filter

CC1 Gas chromatographic column

TCD TCD thermal conductivity detector
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 4 Pneumatic Circuits
Pneumatic Circuit for NC, NC-Soils, NC-Filters and NC-Sediments Configurations
Pneumatic Circuit for NC, NC-Soils, NC-Filters and NC-Sediments 
Configurations

The pneumatic diagram shown in Figure 20 is common to NC, NC-Soil, NC-Filters and 
NC-Sediments configurations.

Figure 20. Pneumatic Circuit for NC, NC-Soils, NC-Filters and NC-Sediments Configurations

It comprises the following components:

Table 17. Components of the Pneumatic Circuit for NC, NC-Soils, NC-Filters, NC-Sediments

Component Description

EV1-EV2 
EV3-EV4 
EVP1-EVP2
S1-S2

They constitute the EFC module. Refer to paragraph “EFC-t Module” on 
page 43.

AS Autosampler

R1 Oxidation reactor

R2 Reduction reactor

F1 Adsorption filter for carbon dioxide

F2 Adsorption filter for water

CC1 Gas chromatographic column

TCD TCD thermal conductivity detector
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4 Pneumatic Circuits
Pneumatic Circuit for N, N Lubricant, N/Protein and N-Brew Configurations
Pneumatic Circuit for N, N Lubricant, N/Protein and N-Brew 
Configurations

The pneumatic diagram shown in Figure 21 is common to N, N Lubricant N/Protein and 
N-Brew configurations.

Figure 21. Pneumatic Circuit for N, N Lubricant N/Protein and N-Brew Configurations

It comprises the following components:

Table 18. Components of the Pneumatic Circuit for N, N Lubricant, N/Protein and N-Brew

Component Description

EV1-EV2 
EV3-EV4 
EVP1-EVP2
S1-S2

They constitute the EFC module. Refer to paragraph “EFC-t Module” on 
page 43.

AS Autosampler

R1 Oxidation reactor

R2 Reduction reactor

F1 Adsorption filter for carbon dioxide

F2 Adsorption filter for water

CC Gas chromatographic column

TCD TCD thermal conductivity detector

CP Pressure stabilizing cylinder
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 4 Pneumatic Circuits
Pneumatic Circuit for NC-IRMS Configuration
Pneumatic Circuit for NC-IRMS Configuration
The pneumatic diagram shown in Figure 22 is common to N and C configurations with the 
IRMS detector.

Figure 22. Pneumatic Circuit for NC-IRMS Configuration

It comprises the following components:

Table 19. Components of the Pneumatic Circuit for NC-IRMS Determinations

CAUTION  The pressure stabilizing cylinder CP is not present in the N Configuration.
It avoids the introduction of air from the point 4 during the extended combustion of 
samples with very high weigh. 

Component Description

EV1-EV2 
EV3-EV4 
EVP1-EVP2
S1-S2

They constitute the EFC module. Refer to paragraph <Pantone>EFC-t 
Module page 43.

AS Autosampler

R2 Oxidation reactor

F2 Adsorption filter for water

CC Gas chromatographic column

TCD TCD thermal conductivity detector
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4 Pneumatic Circuits
Pneumatic Circuit for Flash HT Configurations
Pneumatic Circuit for Flash HT Configurations
The left furnace at high temperature (1450 °C) is used for the determination of Oxygen and 
Hydrogen by pyrolysis while the right furnace, at 1000 °C, is used for the determination of 
Nitrogen and Carbon (or Sulfur).

OH Configuration

The pneumatic diagram is shown in Figure 23. The OH configuration use the left furnace at 
high temperature.

Figure 23. Pneumatic Circuit Flash HT for OH Configuration

It comprises the following components:

Table 20. Components of the Pneumatic Circuit for O and H Determinations

Component Description

EFC-t Electronic Flow Controller Termoregulated module

AS Autosampler

Left Furnace Left furnace at high temperature (1450 °C)

Right Furnace Right furnace (1100 °C)

H2O Trap Filter for water

TCD Thermal Conductivity Detector 

Note  For detains about this configuration refer to the Flash HT User Guide 
(PN 317 082 71).
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 4 Pneumatic Circuits
Pneumatic Circuit for Flash HT Configurations
NC Configuration

The pneumatic diagram is shown in Figure 24. The NC configuration uses the right furnace.

Figure 24. Pneumatic Circuit Flash HT for NC Configuration.

It comprises the following components:

Table 21. Components of the Pneumatic Circuit for NC Determinations

Component Description

EFC-t Electronic Flow Controller Thermoregulated module

AS Autosampler

Left Furnace Left furnace at high temperature (1450 °C)

Right Furnace Right furnace (1100 °C)

H2O Trap Filter for water

TCD Thermal Conductivity Detector 

Note  For detains about this configuration refer to the Flash 2000 HT User Guide 
(PN 317 082 71).
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4 Pneumatic Circuits
Pneumatic Circuit for Flash HT Configurations
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5

Preparation of Reactors and Adsorption Filters

This chapter provides instructions for the preparation of the reactors and the adsorption 
filters, and it also reports the types of analytical columns currently used.

Introduction
Each instrument configuration requires its own dedicated reactors, adsorption filters and 
analytical columns. Except for a few “ready for use” reactors, the reactors and the adsorption 
filters must be prepared by the user.

Reactors 

The reactors can be quartz tubes or special steel tubes. 

• The quartz and special steel tubes have a conical bottom end.

• The special steel reactors have their top end provided with two through-holes.

The filling materials used vary according to the analytical determination required. 
Refer to paragraph “Filling Materials” on page 56. 

Adsorption Filters 

They can be glass or Plexiglas filters. 

Contents

• Introduction

• Filling Materials

• Introduction to the Preparation of Reactors and Filters

• Preparing the Reactors

• Preparing the Adsorption Filters

Note  The special steel reactors, used for combustion, require the presence of a crucible. 
For more details, refer to the operating sequence on page 78.
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5 Preparation of Reactors and Adsorption Filters
Filling Materials
The filling materials used vary according to the analytical determination required. 
Refer to paragraph “Filling Materials” on page 56. 

Gas Chromatographic Columns 

The columns are made of steel, except in N, N/Protein and N-Brew configurations, which 
require PTFE columns.

The following Table 22 reports the characteristics of reactors, filters and gas chromatographic 
columns required for each analytical determination.

Table 22. Characteristic of reactors, filters and gas chromatographic columns

Filling Materials
The following table reports the materials used to fill reactors, adsorption filters and gas 
chromatographic columns.

Note  Gas chromatographic columns are “ready for use”, and therefore they do not require 
any preparation.
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Steel 100 6 5  

200 6 5    

300 6 5  

PTFE 15 6 4 

50 8 6  

80 6 4 

100 8 6  

200 6 5   
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 5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
Table 23. Material required for filling reactors, filters and chromatographic columns

Introduction to the Preparation of Reactors and Filters
The preparation of reactors and adsorption filters must be done according to the specifications 
and quantities reported in the table referring to each instrument configuration. If required, 
also refer to Chapter 4, “Pneumatic Circuits,” .

Characteristics Analytical Determination
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Multi-separation Column (PTFE) 

Multi-separation Column (S.Steel)    

Oxygen Separation Column 

Nitrogen Separation Column (50 cm)  

Nitrogen Separation Column (100 cm)  

CHNS/NCS Packed Column  

Sulphur Separation Column  

IRMS Separation Column   
Thermo Scientific Flash 2000 Elemental Analyzer - Operating Manual 57



5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
CHN Configuration

The following Table 24 reports the characteristics of the components required for CHN 
determination, and the type and size of the filling materials to be used for a proper 
preparation of the reactor. 

Table 24. Components required for CHN determination

Reference Component Characteristic Filling material

R Reactor Material: Quartz 1. Quartz Wool

2. Copper Reduced

3. Chromium Oxide 

4. Silvered Copulates/Copulated 
Oxide

CC Gas chromatographic 
column

Material: Steel
Length: 2 meters
Diameter: 6 x 5 mm

---

Size of the Filling Material

IMPORTANT  If the sample to be analyzed presents particular characteristics (high presence of 
inorganic material) we suggest to insert the quartz crucible into the oxidation/reduction reactor. In 
this case it is necessary to eliminate the Quartz Wool between Chromium Oxide and high quality 
Copper reduced and between the high quality Copper reduced and Copulates-Cobalt Oxide.
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 5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
CHN-O Configuration

The following Table 25 reports the characteristics of the components required for CHN-O 
determination, the type and size of the filling materials to be used for a proper preparation of 
reactors and adsorption filter. 

Table 25. Components required for CHN-O determination

Reference Component Characteristic Determination Filling material

R1 Reactor Material: Quartz CHN 1. Quartz Wool

2. Copper Reduced

3. Chromium Oxide

4. Silvered Cobaltous/Colbaltic 
Oxide

CC1 Gas chromatographic 
column

Material: Steel
Length: 2 meter
Diameter: 6 x 5 mm

CHN ---

R2 Reactor Material: Quartz Oxygen 1. Quartz Wool

5. Quartz Turnings

6. Nickel Plated Carbon

F Adsorption filter Material: Quartz Oxygen 1. Quartz Wool

7. Soda Lime

8. Magnesium Perchlorate 
(Anhydrone)

CC2 Gas chromatographic 
column

Material: Steel
Length: 1 meter
Diameter: 6 x 5 mm

Oxygen ---

Size of the Filling Material
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5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
CHN Determination

Oxygen Determination

IMPORTANT  If the sample to be analyzed presents particular characteristics (high presence 
of inorganic material) we suggest to insert the quartz crucible into the oxidation/reduction 
reactor. In this case it is necessary to eliminate the Quartz Wool between Chromium Oxide 
and high quality Copper reduced and between the high quality Copper reduced and 
Cobaltous-Cobaltic Oxide.

IMPORTANT  If the sample to be analyzed presents particular characteristics (high 
presence of inorganic material) we suggest to insert the quartz crucible into the reactor of 
pyrolysis. In this case it is necessary to reduce from 30 mm to 20 mm the Quartz Wool in 
the lower section of the reactor
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 5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
CHNS Configuration

The following Table 26 reports the characteristics of the components required for CHNS 
determination, and the type and size of the filling materials to be used for a proper 
preparation of the reactor. 

Table 26. Components required for CHNS determination

Reference Component Characteristic Filling material

R Reactor Material: Quartz 1. Quartz Wool

2. Electrolytic Copper

3. Copper Oxide

C Crucible Material: Quartz ---

CC Gas chromatographic 
column

Material: Steel
Length: 2 meters
Diameter: 6 x 5 mm

---

Size of the Filling Material

IMPORTANT  If the sample to be analyzed presents particular characteristics (high 
presence of inorganic material) we suggest to insert the quartz crucible into the 
oxidation/reduction reactor. In this case it is necessary to reduce the Quartz Wool between 
Copper Oxide and Electrolytic Copper up to obtain a thin layer and to reduce the Copper 
Oxide proportionally as shown in the previous figure.
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5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
CHNS-O Configuration

The following Table 27 reports the characteristics of the components required for CHNS-O 
determination, and the type and size of the filling materials to be used for a proper 
preparation of reactors and adsorption filter. 

Table 27. Components required for CHNS-O determination

Reference Component Characteristic Determination Filling material

R1 Reactor Material: Quartz CHNS 1. Quartz Wool

2. Copper Oxide

3. Electrolytic Copper 

C Crucible Material: Quartz --- ---

CC1 Gas chromato-graphic 
column

Material: Steel
Length: 2 meters
Diameter: 6 x 5 mm

CHNS ---

R2 Reactor Material: Quartz Oxygen 1. Quartz Wool

4. Nickel Plated Carbon

5. Quartz Turning

F Adsorption filter Material: Glass Oxygen 1. Quartz Wool

6. Soda Lime

7. Magnesium Perchlorate 
(Anhydrone)

CC2 Gas chromatographic 
column

Material: Steel
Length: 1 meter
Diameter: 6 x 5 mm

Oxygen ---

Size of the Filling Material
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 5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
CHNS Determination

Oxygen Determination

IMPORTANT  If the sample to be analyzed presents particular characteristics (high 
presence of inorganic material) we suggest to insert the quartz crucible into the 
oxidation/reduction reactor. In this case it is necessary to reduce the Quartz Wool between 
Copper Oxide and Electrolytic Copper up to obtain a thin layer and to reduce the Copper 
Oxide proportionally as shown in the previous figure.

IMPORTANT  If the sample to be analyzed presents particular characteristics (high 
presence of inorganic material) we suggest to insert the quartz crucible into the reactor of 
pyrolysis. In this case it is necessary to reduce from 30 mm to 20 mm the Quartz Wool in 
the lower section of the reactor.
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5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
S (Sulfur) Configuration

The following Table 28 reports the characteristics of the components required for S 
determination, and the type and size of filling materials to be used for a proper preparation of 
reactor and adsorption filter. 

Table 28. Components required for S (Sulfur) determination

Reference Component Characteristic Filling materials

R Reactor Material: Quartz 1. Quartz Wool

2. Copper Oxide

3. Electrolytic Copper

C Crucible Material: Quartz

F Adsorption filter Material: Glass 1. Quartz Wool

4. Magnesium Perchlorate (Anhydrone)

CC Gas chromatographic 
column

Material: Steel
Length: 1 meter
Diameter: 6 x 5 mm

---

Size of the Filling Material

IMPORTANT  If the sample to be analyzed presents particular characteristics (high 
presence of inorganic material) we suggest to insert the quartz crucible into the 
oxidation/reduction reactor. In this case it is necessary to reduce the Quartz Wool between 
Copper Oxide and Electrolytic Copper up to obtain a thin layer and to reduce the Copper 
Oxide proportionally as shown in the previous figure.
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 5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
O (Oxygen) Configuration

The following Table 29 reports the characteristics of the components required for O 
determination, and the type and size of the filling materials to be used for a proper 
preparation of reactor and adsorption filter. 

Table 29. Components required for O (Oxygen) determination

Reference Component Characteristic Filling materials

R Reactor Material: Quartz 1. Quartz Wool

2. Metallized Carbon

3. Quartz Turnings

F Adsorption filter Material: Glass 1. Quartz Wool

4. Soda Lime

5. Magnesium Perchlorate (Anhydrone)

CC Gas chromatographic 
column

Material: Steel
Length: 1 meter
Diameter: 6 x 5 mm

---

Size of the Filling Material

IMPORTANT  If the sample to be analyzed presents particular characteristics (high 
presence of inorganic material) we suggest to insert the quartz crucible into the reactor of 
pyrolysis. In this case it is necessary to reduce from 30 mm to 20 mm the Quartz Wool in 
the lower section of the reactor. 
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5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
N (Nitrogen) Configuration

The following Table 30 reports the characteristics of the components required for N 
determination, and the type and size of the filling materials to be used for a proper 
preparation of reactors and adsorption filters. 

Table 30. Components required for N (Nitrogen) determination

Reference Component Characteristic Filling materials

R1 Reactor Material: Quartz 1. Quartz Wool

2. Copper Oxide

3. Silvered Cobaltous/Cobaltic Oxide

R2 Reactor Material: Quartz 1 Quartz Wool 

4. Copper Reduced

F1 Adsorption filter Material: Plexiglas 1. Quartz Wool 

5. Soda Lime

F2 Adsorption filter Material: Plexiglas 1. Quartz Wool 

6. Molecular Sieves 

7. Silica Gel

CC Gas chromatographic 
column

Material: PTFE
Length: 50 cm
Diameter: 8 x 6 mm

---

Size of the Filling Material
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 5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
N Lubricant Configurations

The following Table 31 reports the characteristics of the components required for N 
Lubricant determination, and the type and size of the filling materials to be used for a proper 
preparation of reactors and adsorption filters. 

Table 31. Components required for N Lubricant determination

Reference Component Characteristic Filling materials

R1 Reactor (See note below) Material: Special Steel 1. Quartz Wool

2. Oxidation Catalyst

R2 Reactor Material: Special Steel 1. Quartz Wool

3. Copper Reduced

F1 Adsorption filter Material: Plexiglas 1. Quartz Wool

4. Soda Lime

F2 Adsorption filter Material: Plexiglas 1. Quartz Wool

5. Molecular Sieves

6. Silica Gel

CC Gas chromatographic 
column

Material: PTFE
Length: 100 cm
Diameter: 8 x 6 mm

---

CR Crucible Material: HPAR --

Size of the Filling Material

Note  The R1 combustion reactor requires the use of a crucible CR.
Thermo Scientific Flash 2000 Elemental Analyzer - Operating Manual 67



5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
NC Configuration

The following Table 32 reports the characteristics of the components required for NC 
determination, and the type and size of the filling materials to be used for a proper 
preparation of reactors and adsorption filter. 

Table 32. Components required for NC determination

Reference Component Characteristic Filling materials

R1 Reactor Material: Quartz 1. Quartz Wool

2. Copper Oxide

3. Silvered Cobaltous/Cobaltic Oxide

R2 Reactor Material: Quartz 1. Quartz Wool

4. Copper Reduced

F Adsorption filter Material: Glass 1. Quartz wool

5. Magnesium perchlorate (Anhydrone)

CC Gas chromatographic 
column

Material: Steel
Length: 2 meters
Diameter: 6 x 5 mm

---

Size of the Filling Material
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 5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
NCS Configuration

The following Table 33 reports the characteristics of the components required for NCS 
determination, and the type and size of the filling materials to be used for a proper 
preparation of reactor and adsorption filter. 

Table 33. Components required for NCS determination

Reference Component Characteristic Filling materials

R Reactor Material: Quartz 1. Quartz Wool

2. 3. Copper Oxide

Electrolytic Copper

C Crucible Material: Quartz ---

F Adsorption filter Material: Glass 1. Quartz wool

4, Magnesium Perchlorate (Anhydrone)

CC Gas chromatographic 
column

Material: Steel
Length: 2 meters
Diameter: 6 x 5 mm

---

Size of the Filling Material

IMPORTANT  If the sample to be analyzed presents particular characteristics (high 
presence of inorganic material) we suggest to insert the quartz crucible into the 
oxidation/reduction reactor. In this case it is necessary to reduce the Quartz Wool between 
Copper Oxide and Electrolytic Copper up to obtain a thin layer and to reduce the Copper 
Oxide proportionally as shown in the previous figure.
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5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
NC-Soils, NC-Sediments, NC-Filters Configurations

The following Table 34 reports the characteristics of the components required for NC-Soils, 
NC-Sediments and NC-Filters determinations, and the type and size of the filling materials 
to be used for a proper preparation of reactors and adsorption filter. 

Table 34. Components required for NC-Soils, NC-Sediments and NC-Filters Determinations

Reference Component Characteristic Filling materials

R1 Reactor (See note below) Material: Special Steel 1. Quartz Wool

2. Oxidation Catalyst

R2 Reactor Material: Quartz 1. Quartz Wool

3. Copper Reduced

F Adsorption filter Material: Glass 1. Quartz Wool

4. Magnesium Perchlorate  (Anhydrone)

CC Gas chromatographic 
column

Material: Steel
Length: 2 meters
Diameter: 6 x 5 mm

---

CR Crucible Material: HPAR ---

Size of the Filling Material

Note  The R1 combustion reactor requires the use of a crucible CR.
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 5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
N/Protein and N-Brew Configurations

The following Table 35 reports the characteristics of the components required for N/Protein 
and N-Brew determinations, and the type and size of the filling materials to be used for a 
proper preparation of reactors and adsorption filters. 

Table 35. Components required for N/Protein and N-Brew Determinations

Reference Component Characteristic Filling materials

R1 Reactor (See note below) Material: Special Steel 1. Quartz Wool

2. Oxidation Catalyst

R2 Reactor Material: Special Steel 1. Quartz Wool

3. Copper Reduced

F1 Adsorption filter Material: Plexiglas 1. Quartz Wool

4. Soda Lime

F2 Adsorption filter Material: Plexiglas 1. Quartz Wool

5. Molecular Sieves

6. Silica Gel

CC Gas chromatographic 
column

Material: PTFE
Length: 50 cm
Diameter: 8 x 6 mm

N/Protein

Material: PTFE
Length: 100 cm
Diameter: 8 x 6 mm

N-Brew

Size of the Filling Material

Note  The R1 combustion reactor requires the use of a crucible CR.
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5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
NC Configuration with the Flash IRMS

The following Table 36 reports the characteristics of the components required for NC 
determinations with the Flash IRMS, and the type and size of the filling materials to be used 
for a proper preparation of reactors and adsorption filter. 

Table 36. Components required for NC Determination with the Flash IRMS

Reference Component Characteristic Filling materials

R1 Reactor Material: Quartz 1. Quartz Wool

2. Chromium Oxide

3. Silvered Cobaltous-Cobaltic Oxide

R2 Reactor Material: Quartz 1. Quartz Wool

4. Copper Reduced

F Absorption Filter Material: Plexiglas ---

CC Gas chromatographic 
Column

Material: Stainless Steel
Length: 3 meters
Diameter: 6 x 5 mm

---

Size of the Filling Material
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 5 Preparation of Reactors and Adsorption Filters
Introduction to the Preparation of Reactors and Filters
NC Configuration with the Flash HT

The following Table 37 report the characteristics of the components required for NC 
determinations with the Flash HT, and the type and size of the filling materials to be used for 
a proper preparation of reactor and adsorption filter.

Table 37. Components required for NC Determination with the Flash IRMS

Reference Component Characteristic Filling materials

R2 Reactor Material: Quartz 1. Quartz Wool

2. Chromium Oxide

3. Silvered Cobaltous-Cobaltic Oxide

F2 Absorption Filter Material: Plexiglas 1. Quartz Wool

4. Magnesium Perchlorate (Anhydrone)

CC2 Gas chromatographic 
Column

Material: Stainless Steel
Length: 3 meters
Diameter: 6 x 5 mm

---

Size of the Filling Material
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5 Preparation of Reactors and Adsorption Filters
Preparing the Reactors
Preparing the Reactors
According to the instrument configurations, the filling materials are introduced into the 
reactor in a way to form a series of layers of defined dimensions.

For a proper preparation of the filling layers, refer to the filling diagram of the concerned 
instrument configuration, as described in paragraph “Introduction to the Preparation of 
Reactors and Filters” on page 57.

Please remember that:

• all reactors have a conical bottom end.

• special steel reactors have the upper end provided with two through-holes.

The filling procedure should be carried out on a wide and clean workbench.

 To Fill the Quartz Reactor

The following procedure provides instructions for filling a quartz reactor. 

Use the following procedure to fill the quartz reactor:

1. Starting from the reactor bottom (conical end), introduce a sufficient amount of quartz 
wool to form the required layer, as shown in Figure 25.

I

WARNING    Before using the filling materials required for this operation, please read the 
hazard warnings and information reported in the Safety Data Sheets provided, referring to 
the relevant CAS (Chemical Abstract Service) number.

  The filling of reactors requires the use of quartz wool. Before handling 
quartz wool, we recommend to wear gloves and face protection.

Always use original Thermo Fisher Scientific materials and products. The use of materials 
not meeting the technical specifications of our products does not ensure a good operation 
of the instrument and may even damage it.

Material Required

Quartz reactor

Compression rod

Filling material

Note  In the CHNS, NCS and S Configuration, Electrolytic Copper is used. The copper 
wires (about 14 cm long) must be inserted in the reactor through the conical part and 
pulled inside avoiding their braiding.
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 5 Preparation of Reactors and Adsorption Filters
Preparing the Reactors
Figure 25. Introduction of quartz wool into the reactor conical end

2. Plug with your finger the mouth of the reactor conical end. Gently press the quartz wool 
using the rod provided, as shown in Figure 26.

Figure 26. .Compression of quartz wool into the quartz reactor

Figure 27. Filling of the quartz reactor

3. Turn the reactor conical end downward and rest it delicately onto the workbench.

Conical part

Quartz wool
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5 Preparation of Reactors and Adsorption Filters
Preparing the Reactors
4. Pour sequentially the required filling materials into the reactor, as shown in Figure 27, 
ensuring that each layer has the indicated size. At each step gently press the quartz wool 
using the rod provided.

5. The last step of the sequence consists in introducing a sufficient quantity of quartz wool 
to form the last required layer, as shown in Figure 28. 

Figure 28. Introduction of quartz wool as last layer of the sequence

6. Delicately press the quartz wool using the rod provided. 

 To Fill the Special Steel Reactor

The following operating procedure provides instructions for filling a steel reactor. 

Use the following procedure to fill the steel reactor:

1. Introduce into the bottom end of the reactor a sufficient amount of quartz wool to form 
the required layer, as shown in Figure 29.

Material required

Special steel reactor

Compression rod

Filling materials

Note  To measure the different layers, we recommend the use of the compression rod 
marking each time the measure on the reactor.

Quartz wool
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 5 Preparation of Reactors and Adsorption Filters
Preparing the Reactors
Figure 29. Introduction of quartz wool into the bottom end of the reactor

2. Plug with your finger the mouth of the reactor bottom end. Gently press the quartz wool 
using the rod provided, as shown in Figure 30. 

Figure 30. Compression of quartz wool into the special steel reactor

3. Turn the bottom end of the reactor downward and delicately rest it onto the workbench.

Figure 31. Filling of the special steel reactor and compression of materials

Quartz woolReactor bottom end
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5 Preparation of Reactors and Adsorption Filters
Preparing the Reactors
4. Pour sequentially the required filling materials into the reactor, ensuring that each layer 
has the indicated size. 

At each step gently press the quartz wool using the rod provided.

5. The last step of the sequence consists in introducing a sufficient quantity of quartz wool 
to form the last required layer, as shown in Figure 32. 

Figure 32. Introduction of quartz wool as last layer of the sequence

6. Gently press the quartz wool using the rod provided.

 To Prepare the Crucible 

The following operating procedure provides instructions for the preparation of the crucible 
you will use with the special steel reactors required for combustion. 

Use the following procedure to prepare the crucible:

1. Hold the crucible as shown in Figure 33. Introduce into the bottom end of the crucible a 
sufficient quantity of quartz wool to form a 2 cm layer.

Note  When the oxidation catalyst is used (refer to Table 23 on page 57), it must be 
introduced into the reactor homogeneously. 

Material required

Quartz wool

Compression rod
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 5 Preparation of Reactors and Adsorption Filters
Preparing the Adsorption Filters
Figure 33. Introduction of quartz wool into the crucible

2. Gently press the quartz wool using the rod provided, as shown in Figure 34.

Figure 34. Compression of quartz wool into the crucible

Preparing the Adsorption Filters
According to the instrument configurations, the filling materials are introduced into the 
empty filter to form a series of layers of defined dimensions.

For a proper preparation of the layers, refer to the filling diagram of the concerned instrument 
configuration, as described in paragraph “Introduction to the Preparation of Reactors and 
Filters” on page 57.

Quartz wool

Crucible
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5 Preparation of Reactors and Adsorption Filters
Preparing the Adsorption Filters
According to the analytical configuration required, the following adsorption filters can be 
used:

• large filter (Plexiglas)

• small filter (Glass)

The filling procedure should be carried out on a wide and clean workbench.

 To Fill the Adsorption Filter

The following procedure provides instructions for filling an adsorption filter. 

Introduce into either of the tube ends a sufficient amount of quartz wool to form the required 
layer as shown in Figure 35.

Figure 35. Introduction of quartz wool into the tube

3. While plugging the tube mouth with your hand, press gently the quartz wool using the 
rod provided.

WARNING    Before using the filling materials required for this operation, please read the 
hazard warnings and information reported in the Safety Data Sheets provided, referring to 
the relevant CAS (Chemical Abstract Service) number.

  The filling of reactors requires the use of quartz wool. Before handling 
quartz wool, we recommend to wear gloves and face protection.

Always use original Thermo Fisher Scientific materials and products. The use of materials 
not meeting the technical specifications of our products does not ensure a good operation 
of the instrument and may even damage it.

Material required

Glass or Plexiglas filter according to the instrument configuration

Compression rod

Filling materials

Threaded end Quartz wool
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Preparing the Adsorption Filters
4. Screw the nut complete with its seal onto the threaded mouth, as shown in Figure 36.

Figure 36. Nuts and seals for adsorption filters

5. Pour sequentially the required filling materials into the adsorption filter, ensuring that 
each layer has the indicated size. At each step gently press the quartz wool using the rod 
provided.

6. Do the last layer using a sufficient quantity of quartz wool to form the required layer.

7. Complete the procedure by screwing on the second nut complete with its seal, as shown 
in Figure 37. 

Figure 37. Preparation of the adsorption filters

Figure 38 shows the result of the filling operation of an adsorption filter.

 

CAUTION  Soda Lime must be wetted before using. Pour 0.5 ml of water on the Soda 
Lime surface on the side that will be connected to the reduction reactor

Nut

Seal

Nut

Seal

SealNut

Nut
Packing material

Seal

Nut Nut

Packing material
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Preparing the Adsorption Filters
Figure 38. Result of the filling of a large adsorption filter and of a small one 
82 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



6

Connecting Reactors and Adsorption Filters 

This chapter contains the instructions to install reactors and adsorption filters into the 
elemental analyzer, and it also provides information on how to remove them. 

Installing the Reactors into the Furnaces
The following Table 38summarizes the type of reactor to be used and the furnace where it 
must be installed according to your instrument configuration.

Refer to paragraph “Introduction to the Preparation of Reactors and Filters” on page 57.

Contents

• Installing the Reactors into the Furnaces

• Installing the Adsorption Filters

• Removing the Reactors

• Removing the Adsorption Filters

Note  The reactors of special steel used for combustion require the use of a crucible.

Table 38. Reactors and furnaces

Determination Left furnace Right furnace

CHN Quartz reactor ---

CHN-O Quartz reactor Quartz reactor

CHNS Quartz reactor ---

CHNS-O Quartz reactor Quartz reactor

S (Sulphur) Quartz reactor ---

O (Oxygen) Quartz reactor ---

N (Nitrogen) Quartz reactor Quartz reactor

N Lubricant Special steel reactor + SS crucible Special steel reactor

NC Quartz reactor Quartz reactor

NCS Special steel reactor ---
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6 Connecting Reactors and Adsorption Filters
Installing the Reactors into the Furnaces
Preliminary Operations

Before installing the reactors do the following:

1. Check that the furnaces are at room temperature.

2. Open the furnaces compartment by lifting the cover and removing the protecting plate. 
Refer to paragraph “Furnaces Compartment” on page 28.

3. Remove the autosampler, if installed, by manually undoing the fixing nut, as shown in 
Figure 39.

Figure 39. Removing the autosampler

 To Install the Quartz Reactors into the Furnaces

The following procedure contains the instructions to install the quartz reactors.
.

NC-Soils Special steel reactor + SS crucible Quartz reactor

NC-Sediments Special steel reactor + SS crucible Quartz reactor

NC-Filters Special steel reactor + SS crucible Quartz reactor

N/Protein Special steel reactor + SS crucible Special steel reactor

N-Brew Special steel reactor + SS crucible Special steel reactor

 IRMS (NC) Quartz reactor ---

HT (NC) Quartz Reactor

HT (O/H) Special reactor ---

Table 38. Reactors and furnaces, continued

Determination Left furnace Right furnace

Note  The figures in this operating sequence show the installation of a reactor into the left 
furnace.

Autosampler Nut
84 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



 6 Connecting Reactors and Adsorption Filters
Installing the Reactors into the Furnaces
1. Remove the fixing nut.

2. Delicately introduce the reactor into the furnace ensuring that the tube conical end is 
turned downward, as shown in Figure 40.

Figure 40. Introduction of the quartz reactor into the furnace

3. Guide the reactor inside the furnace. The reactor conical end must fit into the coupling 
union located on the base of the furnaces compartment, as shown in Figure 41.

WARNING    The reactors must be installed with the furnaces at room temperature.

Material required

O-ring

CAUTION  Do not use mechanical tools to screw or unscrew the fixing nut.

Reactor

Conical end
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Installing the Reactors into the Furnaces
Figure 41. Driving the reactor into the furnace

4. Gently press the edge of the reactor until introduction is complete, as shown in Figure 42.

Figure 42. Complete the introduction of the reactor

5. Slip on the O-ring with its conical section turned upwards as shown in Figure 43. 

Figure 43. O-ring

6. Manually screw the autosampler fixing nut.

Note  If required by your instrument configuration, install the reactor into the right 
furnace following the same instructions reported in this operating sequence. 

The autosampler installed on the right channel is used only for CHNS-O and CHN-O 
configurations

Base

Furnace

Reactor

Coupling union

O-ring
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 6 Connecting Reactors and Adsorption Filters
Installing the Reactors into the Furnaces
7. To complete the operation manually screw the fixing nut or the autosampler nut if 
installed.

8. Put on again the protecting plate and the cover of the furnaces compartment. 

 To Install the Special Steel Reactors into the Furnaces

The following procedure contains the instructions to install the special steel reactors into the 
left and right furnaces.
.

1. Remove the fixing nut.

Figure 44. Introducing the special steel reactor into the furnace

2. Introduce the tool, provided in the standard outfit, into the holes located on the top end 
of the reactor.

3. Guide the reactor into the furnace. The conical part should slide into the coupling union 
located on the base of the furnaces compartment, as shown in Figure 45.

Note  The figures in this operating sequence show the installation of a reactor into the left 
furnace.

WARNING    The reactors must be installed with the furnaces at room temperature.

Material required

Tool for steel tubes

O-ring

CAUTION  Do not use mechanical tools to screw or unscrew the fixing nut.

Tool for steel tube

Reactor
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Installing the Reactors into the Furnaces
Figure 45. Driving the reactor into the furnace

4. Turn the reactor clockwise and push until completely in place, as shown in Figure 46.

Figure 46. The reactor in place

5. Slip on the O-ring as shown in Figure 47. 

Figure 47. O-ring

6. By using the tool for special steel reactors, introduce the crucible into the combustion 
reactor, which is in the left furnace. See Figure 48.

Base

Furnace

Reactor

Coupling union
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 6 Connecting Reactors and Adsorption Filters
Installing the Reactors into the Furnaces
Figure 48. Introduction of the crucible into the combustion reactor

7. Manually screw the autosampler nut. See Figure 49.

Figure 49. Mounting the autosampler on the left furnace

8. Install the reduction reactor into the right furnace: in case of steel tubes following the 
instructions of previous operating sequence. In case of quartz tubes refer to the operating 
sequence “To Install the Quartz Reactors into the Furnaces” on page 84.

9. At the end of the operation, manually screw the fixing nut or the autosampler nut if 
installed. See Figure 50.

CAUTION  Do not use mechanical tools to screw or unscrew the fixing nut.

Note  The autosampler installed on the right channel is used only for CHNS-O and 
CHN-O configurations.

Crucible

Crucible

Combustion reactor 
(housed in the 
left furnace)

Tool
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Installing the Adsorption Filters
Figure 50. Mounting the fixing nut on the right furnace

10. Put on again the protecting plate and the cover of the furnaces compartment. 

Installing the Adsorption Filters
The following Table 39 summarizes the type of adsorption filter required and the channel to 
which it should be connected according to instrument configuration.
Refer to paragraph “Introduction to the Preparation of Reactors and Filters” on page 57.

Table 39. Adsorption filters

Determination Left furnace Right furnace

CHN --- ---

CHN-O --- Glass filter

CHNS --- ---

CHNS-O --- Glass filter

S (Sulphur) Glass filter ---

O (Oxygen) Glass filter ---

N (Nitrogen) --- Two Plexiglas filters in series

N Lubricant --- Two Plexiglas filters in series

NC --- Glass filter

NCS Glass filter ---

NC-Soils --- Glass filter

NC-Sediments --- Glass filter

NC-Filters --- Glass filter

N/Protein --- Two Plexiglas filters in series

N-Brew --- Two Plexiglas filters in series

 IRMS (NC) Plexiglas filter ---

HT (NC) --- Plexiglas filter

HT (O/H) Plexiglas filter ---
90 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



 6 Connecting Reactors and Adsorption Filters
Installing the Adsorption Filters
Preliminary Operations

The following preliminary operations are required to install the adsorption filters. 

1. Have access to the detector compartment by opening the right side door of the 
instrument. Refer to paragraph “Detector Compartment” on page 30. Figure 51shows the 
detector compartment.

Figure 51. Detector compartment

 To Connect and Install the Adsorption Filters

The following operating procedure contains the instructions to install the adsorption filters. 
Figure 52 shows the result of the installation of two adsorption filters connected in series. 

Figure 52. Adsorbtion filters installed in the detector compartment

According to your instrument configuration, do the installation and connection of the 
adsorption filters following the instructions of next paragraphs Single Filter or Two Filters in 
series.

Single filter Two filters in series
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Installing the Adsorption Filters
Single Filter

To connect the filter do the following:

1. Connect the filter inlet to the connection coming from the reactor.

2. Connect the filter outlet to the connection coming from the gas chromatographic 
column.

3. Secure the filter by means of the appropriate clips.

Two Filters in series

To connect two filters in series do the following:

1. Connect the filters to one another, as shown in Figure 53, and then to the circuit as per 
relevant diagram. Refer to “Introduction to the Preparation of Reactors and Filters” on 
page 57.

Figure 53. Connection of two filters in series

2. Introduce the filter into the securing clips, as shown in Figure  on page 93.

Figure 54. Installation of the filters into the detector compartment
92 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



 6 Connecting Reactors and Adsorption Filters
Removing the Reactors
Removing the Reactors 
Before starting this operation:

• Check that the furnaces are at room temperature.

• Open the furnaces compartment by lifting the cover and removing the protecting plate. 
Refer to paragraph “Furnaces Compartment” on page 28.

• Undo the nuts securing the reactors. If the autosampler is installed, manually unscrew the 
fixing nut to remove it as shown in Figure 39 page 84.

 To Remove the Quartz Reactors from the Furnaces

The following operating procedure contains the instructions to remove the quartz reactors 
from the left and right furnaces.
.

1. Remove the O-ring from the top of the reactor as shown in the left image of Figure 55.

2. Using both hands turn the tube counterclockwise and simultaneously pull it upward as 
shown in the right image of Figure 55.

Figure 55. O-ring and removal of the reactor from the furnace

Note  The figures in this operating sequence show the installation of a reactor into the left 
furnace.

WARNING    The reactors must be installed with the furnaces at room temperature.
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Removing the Reactors
 To Remove Special Steel Reactors from the Furnaces

The following operating procedure contains the instructions to remove the special steel 
reactors from the left and right furnaces.

1. Remove the O-ring from the top of the reactor as shown in Figure 56.

Figure 56. Removal of the steel reactor o-ring

2. Remove the crucible from the combustion reactor (left furnace) using the appropriate tool 
as shown in Figure 57. 

Figure 57. Removal of the crucible

WARNING    The reactors must be installed with the furnaces at room temperature.

Material required

Tool for special steel reactor 

Tool for crucible
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 6 Connecting Reactors and Adsorption Filters
Removing the Adsorption Filters
3. By using the proper tool, remove the reactor turning it counterclockwise and 
simultaneously pulling it upwards, as shown in Figure 58.

Figure 58. Removal of the reactor

Removing the Adsorption Filters
Before starting this operation:

1. Open the right side door of the instrument to have access to the detector compartment. 
Refer to paragraph “Detector Compartment” on page 30.

 To Remove the Adsorption Filter

The following operating procedure contains the instructions to remove the adsorption filter 
from the system.

1. Remove the filter from the securing clips.

2. Disconnect the filter inlet and then its outlet from the relevant connections.
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7

Preparing the Sample

This chapter describes some techniques for the sample preparation, also it provides basic 
instructions to homogenize and weigh the sample.

Introduction

Homogenizing the Sample
Before the analysis the sample must be properly homogenized. This paragraph gives you basic 
information on how to prepare the most currently analyzed materials.

Table 40 on page 98 gives you indications to weigh the sample according to your instrument 
configuration.

Contents

• Introduction

• Homogenizing the Sample

• Sample Weighing Technique

WARNING    Be very careful in preparing samples, because the substances to be analyzed 
may be dangerous. Read the Safety Data Sheets referring to the different chemicals and 
handle them in the appropriate environment (e.g. under a fumes hood), strictly obeying 
the company safety regulations.
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Homogenizing the Sample
Soils, Sediments and Minerals

Before the analysis, samples of such nature and origin require homogenizing, which can be 
performed by means of proper mills allowing the simultaneous preparation of several samples.
A first coarse homogenizing on sample amounts of a few hundreds of grams is followed by 
finer homogenizing on a few dozens of grams, until optimum granularity (100-200 μm) is 
reached. The resulting sample is dried in an oven.

Carbons

The technique to homogenize carbons is the same as that used for the preparation of soils, 
sediments and minerals, but the sample drying requires specific operations:
The samples are dried in an oven for one hour at 105°C, left in the air for the same time to let 
them acquire again their natural moisture and then stored in airtight containers. Finally they 
are put into driers. 

Metals

The sample preparation technique is a function of the metal hardness.
Special machines can be used as drills, mills or lathes.
In case of particularly hard materials, use a diamond file.

Table 40. Information on sample weighing

Sample Information

Su
lfu

r

Soils In soils, sulfur is often present as ion sulfate, and therefore it is 
necessary to add 5-10 mg of vanadium pentoxide (V2O5) every 
10-20 mg of soil to ensure complete conversion of inorganic sulfur 
into sulfur dioxide.

Minerals The sulfur content in minerals can vary from a few percent units 
(e.g. bauxite) to definitely higher values (e.g. pyrite). 
If the mineral to be analyzed is unknown, a pre-analysis is 
recommended. Once the sulfur content is defined, the required 
analyses with proper sample amounts can be performed: 

Example: For minerals rich in sulfur, samples of 2-5 mg are 
prepared. For minerals with sulfur traces, samples of 10-20 mg are 
prepared.

Plants Plants are rich in Nitrogen, Carbon and Hydrogen, but relatively 
poor in Sulfur. Therefore, after the first analysis, check that the peak 
of sulfur dioxide is correctly integrated.

N
itr

og
en

Soils 
Sediments

The Nitrogen content in such samples is generally very low (0.1%). 
Set a very high sensitivity of integration and use Oxygen of 
maximum purity grade.
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Sample Weighing Technique
You should obtain metal chips as small and light as possible. The homogenizing degree 
depends on the particle size.

The quantity of sample for the analysis is a function of the alloy composition.

• For cast irons, prepare samples of 10-20 mg.

• For steels and other metal alloys, weigh 40-50 mg.

Plastics

Polymers are generally available as pellets, or only rarely as powders.
If you don’t want or cannot homogenize the sample, you can cut the pellets into small pieces 
and analyze 2-3 mg.

The same process is used for synthetic and natural rubbers.

Vegetal

To prepare samples of vegetal products, two types of mills are normally used:

• Blade mills to homogenize cereals, leaves, forage and wood. In these mills, devices with 1 
mm mesh sieves are used for N/Protein determination.

• Ball mills to homogenize samples of fruit and vegetables after lyophilization. These mills 
use devices for finer granulometry.

The sample amount to be analyzed depends on the type of determination and on the 
homogenizing degree. 

Liquids

Liquid samples are prepared according to a procedure that depends on the sample volatility.
Liquid samples with limited volatility are weighed in traditional tin containers.
However, to avoid sample losses, we suggest to use two containers for each sample.
If the sample is characterized by high viscosity, it should be properly mixed before being 
drawn for injection. 

Samples injectable by micro syringes can be introduced manually using the optional manual 
injection device, or automatically using the autosampler for liquids.

Sample Weighing Technique
To define the weighing range, you should know the nature (organic, inorganic, metal-organic) 
and origin (pure chemical, natural product) of the substance to be analyzed.

For weighing samples, the following materials are required:

• Balance 

• Tools to seal the container containing the sample. 
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Sample Weighing Technique
Samples of different nature require specific weighing techniques.

The weighing procedure requires a series of operations according to the sample nature.

Solid Samples

Solid samples are introduced directly into the tin container using a spatula. 

According to the sample quantity to be analyzed, refer to the following operating procedures:

• “Weighing Technique for Large Quantities of Solid Samples” on page 101.

• “Weighing Technique for Small Quantities of Solid Samples” on page 104.

Liquid Samples 

The weighing procedure changes according to the sample type.

Samples Characterized by Limited Volatility 

• If the sample density is 1 or close to 1
Introduce the sample directly into the tin container for liquids using a syringe of 10 or 
100 μl capacity according to the instrument configuration.

• If the sample density varies significantly, even in samples of the same nature (milk is a typical 
example)
Only for N determination, let the sample be adsorbed on a Chromosorb WAW® layer 
previously introduced into the container.

Refer to the following operating procedures:

• “Weighing Technique for Liquid Samples” on page 105.

• “Weighing Technique for Liquid Samples Deposited on Adsorbent Material” on 
page 107.

Samples Characterized by High Viscosity 

They must be properly mixed before being drawn. 
To introduce the sample, take some using a spatula and let it slide along the container walls as 
shown in Figure 59 on page 101.

Refer to the following operating procedure:

• “Weighing Technique for Viscous Samples” on page 108.

Note  The technique of two containers is suggested to prevent sample losses due to 
defective sealing of the container and consequently prevent the autosampler 
contamination.

Note  Only for N Determination, according to the sample viscosity, it may be necessary to 
adsorb the sample on a Chromosorb WAW® (only for N, N-Brew and N/Protein 
Configurations) layer previously introduced into the tin container. 
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Sample Weighing Technique
Samples Available in Liquid Phase 

They can be injected directly into the reactor as follows:

• Manually, through the manual injection device using a micro syringe.

• Automatically, using the autosampler for liquids.

 Weighing Technique for Large Quantities of Solid Samples

The following procedure contains the instructions to weigh large quantities of solid samples.

Figure 59. Accessories required to weigh solid samples

1. By using the tweezers, take a tin disk and rest it on the cavity of the sealing device, as 
shown in Figure 60.

2. By sing the cylindrical tool, press the tin disk and make it enter the cavity of the sealing 
device, as shown in Figure 60.

Materials required

Balance

Tin disks

Spring tweezers

Sealing device and cylindrical tool

Spatula

Brush

Tin disks

Cylindrical tool

Brush

Spring rweezers

Lever

Sealing device
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Sample Weighing Technique
Figure 60. Preparation of the tin container (1)

3. Press the top of the sealing device downwards to have the container come out of the 
cavity. 

4. Take out the container using the spring tweezers, as shown in Figure 61.

5. Put the prepared container on a clean surface.

Figure 61. Preparation of the tin container (2)

6. Using a spatula, introduce some sample into the tin container until sufficiently filled, then 
delicately press the sample using the cylindrical tool, as shown in Figure 62.

Tin disk Tweezers

Sealing device

Cylindrical toolTin disk
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Sample Weighing Technique
Figure 62. Introduction and compression of the sample

7. IClose the container using the lever located on the top surface of the sealing device. 

8. Press the top of the sealing device downwards to have the container come out of the 
cavity. 

9. Remove the container using the spring tweezers, as shown in Figure 63.

Figure 63. Removal of the closed container and cleaning of the contact surface

10. Weigh the container obtained and take note of the value.

We suggest the following weighing procedure to prevent sample losses due to defective sealing.

a. Using the tweezers, take a tin disk and rest it on the cavity of the sealing device, as 
shown in Figure 60.

b. Using the cylindrical tool, press the tin disk and make it enter the cavity of the sealing 
device, as shown in Figure 60.

c. Press the top of the sealing device downwards to have the container come out of the 
cavity. 
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Sample Weighing Technique
d. Take out the container using the spring tweezers, as shown in Figure 61. 

e. Put the prepared container on a clean surface.

f. Prepare a second container placing another tin disk on the cavity of the sealing device. 

g. Using the cylindrical tool, gently press the disk to obtain a half-open container.

h. Place both containers on the balance pan and do the tare.

i. Take the first container and put it into the cavity of the sealing device.

j. Using a spatula, introduce some sample into the tin container until sufficiently filled, 
then delicately press the sample using the cylindrical tool, as shown in Figure 62.

k. Close the container using the lever located on the top surface of the sealing device. 

l. Press the top of the sealing device downwards to have the container come out of the 
cavity. 

m. Remove the container using the spring tweezers, as shown in Figure 63, and rest it on 
a clean surface.

n. Clean the contact surfaces using the brush.

o. Put the half-open container on the cavity of the sealing device and place thereon the 
container containing the sample,

p. Using the cylindrical tool, introduce the containers into the sealing device and then 
repeat steps k, l, m and n of this procedure.

q. Weigh the container obtained and take note of the value.

 Weighing Technique for Small Quantities of Solid Samples

We suggest the following weighing procedure to prevent sample losses due to defective sealing.

The following procedure contains the instructions to weigh small quantities of solid samples.

1. Take two containers for small weighings, put them onto the balance pan and do the tare.

2. Remove one of the containers from the balance pan and put it onto a clean surface. Using 
a spatula, introduce into the container the sample quantity required for the analysis. 

3. Weigh the container with sample and read the value. If the weight is correct for the 
analysis to be run, remove the two containers from the balance pan and rest them on a 
clean surface.

4. Close the container containing the sample using two spring tweezers, as shown in 
Figure 64, to obtain a pellet.

Materials required

Electronic micro balance

Tin containers for small weighings

Two spring tweezers

Spatula
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Sample Weighing Technique
Figure 64. Preparation of the container for small sample quantities

5. Introduce the pellet into the second container and close the latter in the same way.

6. Put the container obtained onto the balance pan, weigh it and take note of the value.

 Weighing Technique for Liquid Samples

The following operating procedure contains the instructions to properly weigh liquid samples. 

Materials required

Electronic micro balance

Tin container for liquid samples

Spring tweezers

Sealing device (optional)

Spatula

10 or 100 μl syringe according to the instrument configuration
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Figure 65. Accessories to weigh liquid samples

1. Take a tin container for liquid samples and put it onto the micro balance pan. Do the tare.

2. Place the tin container into the appropriate position in the slide of the sealing device, then 
inject the sample using a syringe, as shown in Figure 66.

Figure 66. Housing for the container and sample injection

3. Put the slide with the container into the sealing device and tighten the container using the 
appropriate lever, as shown in Figure 67.

Figure 67. Closing and removing the container

4. Remove the slide from the sealing device and then the container with the sample from the 
slide, as shown in Figure 67.

5. Put the container onto the micro balance pan, weigh it and take note of the weight value.

1. Container for liquid 2. Spring tweezers

3. Sealing device 4. Lever

5. Sample-holding slide 6. Syringe

4

1

2

3 6

5
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 Weighing Technique for Liquid Samples Deposited on Adsorbent Material

The following operating procedure contains the instructions to properly weigh liquid samples 
previously deposited on adsorbent material. 

1. Introduce one or two spatula tips of Chromosorb WAW® into the tin container.

2. Put the container with the adsorbent material and an empty container onto the balance 
pan and do the tare.

3. Remove the containers from the balance pan and rest them onto a clean surface.

4. Using the syringe, introduce the liquid sample depositing it on the layer of adsorbent 
material contained in the container, as shown in Figure 68.

Figure 68. Weighing of a liquid sample deposited on adsorbent material

5. Close the container using two spring tweezers or the sealing device.

6. Introduce the container with the sample into the second container and close the latter in 
the same way.

7. Weigh the container and take note of the weight value. 

Materials required

Balance 

Tin containers for liquid samples

Two spring tweezers

Spatula

100 μl syringe

Chromosorb WAW® (Only for N, N/Protein and N-Brew Determinations) 

Note  Chromosorb WAW ® is an extremely porous inert inorganic material, made of 
silicates and completely free from Nitrogen. When Chromosorb is free from 
contamination, its contribution to the blank value is negligible.

CAUTION  Do not wet the container walls during sample introduction.

1. Empty container 2. Layer of adsorbent material

3. Introduction of the sample 4. Closed container

1                   2                  3                          4
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 Weighing Technique for Viscous Samples

The following operating procedure contains the instructions to properly weigh viscous 
samples.

According to its viscosity, a sample can be weighed as described in either of the following 
operating sequences:

• “Weighing Technique for Liquid Samples” on page 105.

• “Weighing Technique for Liquid Samples Deposited on Adsorbent Material” on 
page 107. 

Figure 69. Introduction of a viscous sample into the container

CAUTION  When a liquid sample is too viscous to be drawn by means of a syringe, use the 
spatula provided in the instrument standard outfit, as shown in Figure 69.
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8

Analytical Methods

This chapter describes the analytical methods used for all configurations of the Flash 2000 
elemental analyzer.

Contents

• Introduction

• Analytical Method for CHN Configuration

• Analytical Method for CHN-O Configuration

• Analytical Method for CHNS Configuration

• Analytical Method for CHNS-O Configuration

• Analytical Method for S (Sulfur) Configuration

• Analytical Method for O (Oxygen) Configuration

• Analytical Method for N (Nitrogen) Configuration

• Analytical Method for NC Configuration

• Analytical Method for NCS Configuration

• Analytical Method for NC-Soils, NC-Sediments and NC-Filters Configurations

• Analytical Method for N Lubricant, N/Protein and N-Brew Configurations

• Analytical Method for NC-IRMS Configuration

• Analytical Method for NC-HT Configuration
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8 Analytical Methods
Introduction
Introduction
Each configuration of the Flash 2000 elemental analyzer has its own dedicated analytical 
method. 

The description of the analytical method is illustrated by diagrams referring to the concerned 
instrument configuration.

When necessary, also refer to Chapters 1, 4 and 5 for more information concerning the 
components of the instrument and their functions. The analytical method used in each 
instrument configuration includes different subsequent steps leading to determine the percent 
composition of the components of interest through the transformation of the solid or liquid 
sample into gas.

Note  To develop and perform the analytical cycle, refer to the relevant chapter contained 
in Section III.

For correct sample analyses all pneumatic lines must be leak-free. Therefore, a preliminary 
leak check is recommended before starting analytical cycles. 

IMPORTANT  All the pneumatic diagram visualized in the chapter are in the Pre-analysis 
stage.
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 8 Analytical Methods
Analytical Method for CHN Configuration
Analytical Method for CHN Configuration
An autosampler AS is connected to a quartz reactor R1 housed in an furnace at a temperature 
of 900 °C. This reactor is connected to the analytical column CC, which on its turn is 
connected to a channel of the thermal conductivity detector TCD.

Figure 70. Instrument parts diagram and pneumatic diagram for CHN determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to relevant proportional valves EVP1 and 
EVP2. 
The proportional valve EVP1, connected to the autosampler AS, controls the Helium flow 
through the whole pneumatic circuit as far as the solenoid valve EV3. This valve, normally 
open, exhausts Helium to the atmosphere through Vent 4. 
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8 Analytical Methods
Analytical Method for CHN Configuration
The proportional valve EVP2, connected to the detector reference channel RF, controls the 
Helium flow as far as the solenoid valve EV4. This valve, normally open, allows Helium to 
reach point 1 of the autosampler and purge the zone where the sample is housed.
The Oxygen line O2 is connected to the solenoid valve EV1.
This valve controls the Oxygen inlet.

Sequence of the Method Stages

During pre-analysis the solenoid valve EV1 shuts off the Oxygen flow, whereas the solenoid 
valve EV2 allows Helium to flow in the circuit. When Start Analysis is pressed, the valve EV1 
opens, whereas the valve EV2 switches to allow Oxygen to flow in as far as the combustion 
reactor R1 for a preset time.
After a few seconds, the sample, weighed in a tin container and stored in the autosampler, is 
dropped into the combustion reactor. Tin, coming in contact with the extremely oxidizing 
environment, triggers a strong exothermic reaction. 
Temperature rises to approximately 1800 °C instantly causing the sample combustion.
At the end of the time set for Oxygen introduction, valves EV1 and EV2 return to their 
original position restoring Helium flow.
The combustion products are conveyed across the reactor R1, where oxidation is completed. 
Nitrogen oxides possibly formed are reduced to elemental nitrogen and Oxygen excess is 
retained.

Then the gas mixture (N2, CO2 and H2O) flows into the chromatographic column CC1, 
where separation takes place. 
The eluted gases are conveyed to the thermal conductivity detector TCD that generates 
electrical signals, which properly processed by the Eager Xperience software provide Nitrogen, 
Carbon and Hydrogen percentages.

Note  Sulfur and halogenated compounds (Chlorine, Bromine, etc.), possibly present in 
the sample, do not affect the analysis, since the silvered cobaltous/cobaltic oxide catalyst 
holds back both SO2 and halogens.
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 8 Analytical Methods
Analytical Method for CHN-O Configuration
Analytical Method for CHN-O Configuration
CHN Determination: An autosampler AS is connected to a quartz reactor R1 placed in an 
furnace at a temperature of 900 °C. This reactor is connected to the analytical column CC1, 
on its turn connected to a channel of the thermal conductivity detector TCD.

Oxygen Determination: A second autosampler AS is connected to a reactor R2 placed in an 
furnace at a temperature of 1060 °C. An adsorption filter F is connected to the reactor outlet. 
The F outlet is connected to the analytical column CC2, on its turn connected to the other 
channel of the thermal conductivity detector TCD.

Figure 71. Instrument parts diagram and pneumatic diagram for CHN-O determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to relevant proportional valves EVP1 and 
EVP2. 

The proportional valve EVP1, connected to the autosampler AS, controls the Helium flow 
through the whole pneumatic circuit as far as the solenoid valve EV3. 
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8 Analytical Methods
Analytical Method for CHN-O Configuration
This valve, normally open, exhausts Helium to the atmosphere through Vent 4. 
The proportional valve EVP2 controls Helium flowing to the circuit comprising R2, F and 
CC2 as far as the solenoid valve EV4. This valve, normally open, allows Helium to reach point 
1 of the autosampler and purge the area where the sample is housed.

When a single autosampler is installed, to pass from the CHN configuration to the O 
Configuration, or vice-versa, change the position of the autosampler from R1 to R2 or 
voice-overs. The Oxygen line O2 is connected to the solenoid valve EV1.This valve controls 
the Oxygen inlet.

Sequence of the Method Stages

CHN Determination

During pre-analysis, the solenoid valve EV1 shuts off the Oxygen flow, whereas the solenoid 
valve EV2 allows Helium to flow in the circuit. When Start Analysis is pressed, the valve EV1 
opens, whereas the valve EV2 switches to allow Oxygen to flow in as far as the combustion 
reactor R1 for a preset time.
After a few seconds the sample, weighed in a tin container and stored in the autosampler, is 
dropped into the combustion reactor.
Tin, coming in contact with an extremely oxidizing environment, triggers a strong exothermic 
reaction. Temperature rises to approximately 1800 °C instantly causing the sample 
combustion. At the end of the time set for Oxygen introduction, valves EV1 and EV2 return 
to their original position restoring Helium flow. 
The combustion products are conveyed across the reactor R1, where oxidation is completed. 
Nitrogen oxides possibly formed are reduced to elemental nitrogen, and Oxygen excess is 
retained.

Then the gas mixture (N2, CO2 and H2O) flows into the chromatographic column CC1, 
where separation takes place. The eluted gases are conveyed to the thermal conductivity 
detector TCD that generates electrical signals, which properly processed by the Eager 300 
software provide Nitrogen, Carbon and Hydrogen percentages.

Oxygen Determination

No switching of valves. When Start Analysis is pressed, the sample, weighed in a silver 
container and stored in the autosampler, is dropped into the reactor R2 where it undergoes 
instant pyrolysis. During pyrolysis, N2, CO and H2 form. The pyrolysis products cross the 
adsorption filter F where halogenated compounds (Chlorine, Bromine, etc.) are retained. 
The gas mixture flows into the chromatographic column CC2, where carbon monoxide is 
separated from other gases. 
Then the eluted gases are conveyed to the thermal conductivity detector TCD that generates an 
electrical signal, which properly processed by the Eager Xperience software provides Oxygen 
percentage.

Note  When two autosamplers are installed on the elemental analyzer, the point 1 (purge) 
must be connected to the autosampler that you intend to use for the analysis.

Note  Sulfur and halogenated compounds (Chlorine, Bromine, etc.), possibly present in 
the sample, do not affect the analysis, since the silvered cobaltous/cobaltic oxide catalyst 
holds back both SO2 and halogens.
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 8 Analytical Methods
Analytical Method for CHNS Configuration
Analytical Method for CHNS Configuration
An autosampler AS is connected to a quartz reactor R1 placed in an furnace at a temperature 
of 900 °C. This reactor is connected to the analytical column CC, on its turn connected to a 
channel of the thermal conductivity detector TCD.

Figure 72. Instrument parts diagram and pneumatic diagram for CHNS determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to relevant proportional valves EVP1 and 
EVP2. 
The proportional valve EVP1, connected to the autosampler AS, controls the helium flow 
through the whole pneumatic circuit as far as the solenoid valve EV3. This valve, normally 
open, exhausts Helium to the atmosphere through Vent 4. 
The proportional valve EVP2, connected to the detector reference channel TCD, controls the 
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8 Analytical Methods
Analytical Method for CHNS Configuration
Helium flow as far as the solenoid valve EV4. This valve, normally open, allows Helium to 
reach point 1 of the autosampler and purge the zone where the sample is housed.
The Oxygen line O2 is connected to the solenoid valve EV1.
This valve controls the Oxygen inlet.

Sequence of the Method Stages

During pre-analysis, the solenoid valve EV1 shuts off the Oxygen flow, whereas the solenoid 
valve EV2 allows Helium to flow in the circuit.
When Start Analysis is pressed, the valve EV1 opens, whereas the valve EV2 switches to allow 
Oxygen to flow in as far as the combustion reactor R1 for a preset time.
After a few seconds the sample, weighed in a tin container and placed in the autosampler, is 
dropped into the combustion reactor. Tin, coming in contact with an extremely oxidizing 
environment, triggers a strong exothermic reaction.
Temperature rises to approximately 1800 °C instantly causing the sample combustion. 
At the end of the time set for Oxygen introduction, the valves EV1 and EV2 return to their 
original position restoring the Helium flow. The combustion products are conveyed across the 
reactor R1 where oxidation is completed. Nitrogen oxides and sulfur trioxide, possibly 
formed, are reduced to elemental nitrogen and sulfur dioxide, and the Oxygen excess is 
retained. 
Then the gas mixture (N2, CO2, H2O e SO2) flows into the chromatographic column CC1 
where separation takes place. The eluted gases are sent to the thermal conductivity detector 
TCD that generates electrical signals, which, properly processed by the Eager Xperience 
software, provide the percentages of Nitrogen, Carbon, Hydrogen and Sulfur contained in the 
sample.
116 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



 8 Analytical Methods
Analytical Method for CHNS-O Configuration
Analytical Method for CHNS-O Configuration
CHNS Determination: An autosampler AS is connected to a quartz reactor R1 placed in an 
furnace at the temperature of 900 °C. This reactor is connected to the analytical column CC1, 
on its turn connected to a channel of the thermal conductivity detector TCD.

Oxygen Determination: A second autosampler AS is connected to a reactor R2 placed in an 
furnace at the temperature of 1060 °C. To the reactor outlet an adsorption filter F is 
connected. The F outlet is connected to the analytical column CC2, on its turn connected to 
the other channel of the thermal conductivity detector TCD.

Figure 73. Instrument parts diagram and pneumatic diagram for CHNS-O determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to relevant proportional valves EVP1 and 
EVP2. 
The proportional valve EVP1, connected to the autosampler AS, controls the Helium flow 
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8 Analytical Methods
Analytical Method for CHNS-O Configuration
through the pneumatic circuit as far as the solenoid valve EV3. This valve, normally open, 
exhausts Helium to the atmosphere through Vent 4. 
The proportional valve EVP2 controls the Helium flow in the circuit comprising R2, F and 
CC2 as far as the solenoid valve EV4. This valve, normally open, allows Helium to reach point 
1 of the autosampler and purge the area where the sample is housed.

When a single autosampler is installed, to pass from the CHNS configuration to the O 
Configuration, or vice-versa, change the position of the autosampler from R1 to R2 or 
vice-versa. The Oxygen line O2 is connected to the solenoid valve EV1. This valve controls the 
Oxygen inlet.

Sequence of the Method Stages

CHNS Determination 

During pre-analysis the solenoid valve EV1 shuts off the Oxygen flow, whereas the solenoid 
valve EV2 allows Helium to flow in the circuit. When Start Analysis is pressed, the valve EV1 
opens, whereas the valve EV2 switches to allow Oxygen to flow in as far as the combustion 
reactor R1 for a preset time. 
After a few seconds the sample, weighed in a tin container and stored in the autosampler. is 
dropped into the combustion reactor.
Tin, coming in contact with an extremely oxidizing environment, triggers a strong exothermic 
reaction. Temperature reaches approximately 1800 °C instantly causing the sample 
combustion. At the end of the time set for Oxygen introduction, the valves EV1 and EV2 
return to their original position restoring the Helium flow. 
The combustion products are conveyed across the reactor R1 where oxidation is completed. 
Nitrogen oxides and sulfur trioxide possibly formed are reduced to elemental nitrogen and 
sulfur dioxide, and Oxygen excess is retained. 
Then the gas mixture (N2, CO2, H2O e SO2) flows into the gas chromatographic column 
CC1 where separation occurs. 
The eluted gases are conveyed to the thermal conductivity detector TCD that generates 
electrical signals, which, properly processed by the Eager 300 software, provide the Nitrogen, 
Carbon, Hydrogen and Sulfur percentages contained in the sample.

Oxygen Determination

No switching of valves. When Start Analysis is pressed, the sample, weighed in a silver 
container and stored in the autosampler, is dropped into the reactor R2 where it undergoes 
instant pyrolysis. 
During pyrolysis, N2, CO and H2 form. The pyrolysis products cross the adsorption filter F 
where halogenated compounds (Chlorine, Bromine, etc.) are retained. 
The gas mixture flows into the chromatographic columns CC2 where carbon monoxide is 
separated from the other gases. 
Then the eluted gases are conveyed to the thermal conductivity detector TCD that generates an 
electrical signal, which, properly processed by the Eager Xperience software, provides the 
Oxygen percentage.

Note  When two autosamplers are installed on the elemental analyzer, the point 1 (purge) 
must be connected to the autosampler that you intend to use for the analysis.
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 8 Analytical Methods
Analytical Method for S (Sulfur) Configuration
Analytical Method for S (Sulfur) Configuration
An autosampler AS is connected to a reactor R1 placed in an furnace at the temperature of 
900°C. To the reactor outlet an adsorption filter F1 is connected. The F1 outlet is connected 
to the analytical column CC, on its turn connected to the thermal conductivity detector TCD.

Figure 74. Instrument parts diagram and pneumatic diagram for S (Sulfur) determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to the relevant proportional valves EVP1 and 
EVP2. 
The proportional valve EVP1, connected to the autosampler AS, controls the Helium flow in 
the whole pneumatic circuit as far as the solenoid valve EV3. This valve, normally open, 
exhausts Helium to the atmosphere through Vent 4. 
The proportional valve EVP2, connected to the detector reference channel TCD, controls the 
Helium flow as far as the solenoid valve EV4. This valve, normally open, allows Helium to 
reach point 1 of the autosampler and purge the zone where the sample is housed.
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8 Analytical Methods
Analytical Method for S (Sulfur) Configuration
The Oxygen line O2 is connected to the solenoid valve EV1.
This valve controls the Oxygen inlet.

Sequence of the Method Stages

During pre-analysis the solenoid valve EV1 shuts off Oxygen flow, whereas the solenoid valve 
EV2 allows Helium to flow in the circuit.

When Start Analysis is pressed, the valve EV1 opens, whereas the valve EV2 switches to allow 
Oxygen to flow in as far as the combustion reactor R1 for a preset time. 
After a few seconds, the sample, weighed in a tin container and stored in the autosampler, is 
dropped into the combustion reactor.

Tin, coming in contact with an extremely oxidizing environment, triggers a strong exothermic 
reaction. Temperature rises to approximately 1800 °C instantly causing the sample 
combustion.
At the end of the time set for Oxygen introduction, the valves EV1 and EV2 return to their 
original position restoring the Helium flow. The combustion products are conveyed across the 
reactor R1 where oxidation is completed. Nitrogen oxides and sulfur trioxide possibly formed 
are reduced to elemental nitrogen and sulfur dioxide, and the Oxygen excess is retained.
Then the gas mixture (N2, CO2, H2O and SO2) flows through the adsorption filter F1, 
which retains water, then into the chromatographic column CC1 where separation takes place. 
The eluted gases are conveyed to the thermal conductivity detector TCD that generates an 
electrical signal, which, properly processed by the Eager Xperience software, provides the 
Sulfur percentage.
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 8 Analytical Methods
Analytical Method for O (Oxygen) Configuration
Analytical Method for O (Oxygen) Configuration
An autosampler AS is connected to a reactor R1 placed in an furnace at the temperature of 
1060 °C. To the reactor outlet an adsorption filter F1 is connected. The filter F1 outlet is 
connected to the analytical column CC, on its turn connected to the thermal conductivity 
detector TCD.

Figure 75. Instrument parts diagram and pneumatic diagram for O (Oxygen) determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to the relevant proportional valves EVP1 and 
EVP2. 
The proportional valve EVP1, connected to the autosampler AS, controls the Helium flow in 
the whole pneumatic circuit as far as the solenoid valve EV3. This valve, normally open, 
exhausts Helium to the atmosphere through Vent 4. The proportional valve EVP2, connected 
to the detector reference channel TCD, controls the Helium flow as far as the solenoid valve 
EV4. 
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8 Analytical Methods
Analytical Method for O (Oxygen) Configuration
This valve, normally open, allows Helium to reach point 1 of the autosampler and purge the 
zone where the sample is housed. 
The Oxygen line O2 is connected to the solenoid valve EV1. This valve controls the Oxygen 
inlet.

Sequence of the Method Stages

No switching of valves. When Start Analysis is pressed, the sample, weighed in a tin container 
and stored in the autosampler, is dropped into the reactor R1 where it undergoes instant 
pyrolysis.
During pyrolysis, N2, CO and H2 form. The pyrolysis products cross the adsorption filter F 
where halogenated compounds (Chlorine, Bromine, etc.) are retained. 
The gas mixture flows into the chromatographic column CC where carbon monoxide is 
separated from the other gases. 
Then the eluted gases are conveyed to the thermal conductivity detector TCD that generates an 
electrical signal, which, properly processed by the Eager Xperience software, provides the 
Oxygen percentage.
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 8 Analytical Methods
Analytical Method for N (Nitrogen) Configuration
Analytical Method for N (Nitrogen) Configuration
An autosampler AS is connected to a quartz reactor R1 placed in an furnace at the 
temperature of 900 °C. This reactor, on its turn, is connected in series to a second reactor R2 
placed in an furnace at the temperature of 680 °C. To the reactor R2 outlet two filters F1 e F2 
are connected in series. The filter F2 outlet is connected to the analytical column CC, on its 
turn connected to the thermal conductivity detector TCD.

Figure 76. Instrument parts diagram and pneumatic diagram for N (Nitrogen) determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to the relevant proportional valves EVP1 and 
EVP2. The proportional valve EVP1, connected to the autosampler AS, controls the Helium 
flow in the whole pneumatic circuit as far as the solenoid valve EV3. This valve, normally 
open, exhausts Helium to the atmosphere through Vent 4. 
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8 Analytical Methods
Analytical Method for N (Nitrogen) Configuration
The proportional valve EVP2, connected to the detector reference channel TCD, controls the 
helium flow as far as the solenoid valve EV4. 
This valve, normally open, allows Helium to reach point 1 of the autosampler and purge the 
zone where the sample is housed. The Oxygen line O2 is connected to the solenoid valve EV1.
This valve controls the Oxygen inlet.

Sequence of the Method Stages

During pre-analysis the solenoid valve EV1 shuts off Oxygen, whereas the solenoid valve EV2 
allows Helium to flow in the circuit.

When Start Analysis is pressed, the valve EV1 opens, whereas the valve EV2 switches to allow 
Oxygen to flow in as far as the combustion reactor R1 for a preset time. After a few seconds, 
the sample, weighed in a tin container and stored in the autosampler, is dropped into the 
combustion reactor. tin, coming in contact with an extremely oxidizing environment, triggers 
a strong exothermic reaction. 
Temperature rises to approximately 1800 °C instantly causing the sample combustion. 
At the end of the time set for Oxygen introduction, the valves EV1 and EV2 return to their 
original position restoring the Helium flow.
The gas mixture (N2, CO2, H2O and SO2) generated by combustion is conveyed across the 
reactor R1 where the oxidation of components is completed. Then, the mixture crosses the 
reactor R2 where nitrogen oxides possibly formed are converted into elemental nitrogen, and 
the Oxygen excess is retained.
Then the gas mixture passes across the two adsorption filters F1 e F2 connected in series. The 
first filter holds back carbon and sulfur dioxides, whereas the second filter retains water. 
Nitrogen is then eluted in the chromatographic column CC and conveyed to the thermal 
conductivity detector TCD that generates an electrical signal, which, properly processed by the 
Eager Xperience software, provides the Nitrogen percentage.
124 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



 8 Analytical Methods
Analytical Method for NC Configuration
Analytical Method for NC Configuration
An autosampler AS is connected to a quartz reactor R1 placed in an furnace at the 
temperature of 900 °C. This reactor, on its turn, is connected in series to a second reactor R2 
placed in an furnace at the temperature of 680 °C. To the R2 outlet an adsorption filter F1 is 
connected. The filter F1 outlet is connected to the analytical column CC, on its turn 
connected to the thermal conductivity detector TCD.

Figure 77. Instrument parts diagram and pneumatic diagram for NC determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to relevant proportional valves EVP1 and 
EVP2. The proportional valve EVP1, connected to the autosampler AS, controls the Helium 
flow in the whole pneumatic circuit as far as the solenoid valve EV3. This valve, normally 
open, exhausts Helium to the atmosphere through Vent 4. 
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8 Analytical Methods
Analytical Method for NC Configuration
The proportional valve EVP2, connected to the detector reference channel TCD, controls the 
Helium flow as far as the solenoid valve EV4. 
This valve, normally open, allows Helium to reach point 1 of the autosampler and purge the 
zone where the sample is housed. The Oxygen line O2 is connected to the solenoid valve EV1.
This valve controls the Oxygen inlet.

Sequence of the Method Stages

During pre-analysis the solenoid valve EV1 shuts off Oxygen, whereas the solenoid valve EV2 
allows Helium to flow in the circuit. When Start Analysis is pressed, the valve EV1 opens, 
whereas the valve EV2 switches to allow Oxygen to flow in as far as the combustion reactor R1 
for a preset time. 
After a few seconds, the sample. weighed in a tin container and stored in the autosampler, is 
dropped into the combustion reactor.
Tin, coming in contact with an extremely oxidizing environment, triggers a strong exothermic 
reaction. Temperature rises to approximately 1800 °C instantly causing the sample 
combustion. 
At the end of the time set for Oxygen introduction, the valves EV1 and EV2 return to their 
original position restoring the Helium flow.
The gas mixture (N2, CO2, H2O and SO2) generated by combustion is conveyed across the 
reactor R1 where the oxidation of components is completed. Then, the mixture crosses the 
reactor R2 where nitrogen oxides possibly formed are converted into elemental nitrogen, and 
the Oxygen excess is retained.

The gas mixture then crosses the adsorption filter F1 that retains water. Nitrogen and carbon 
are eluted in the chromatographic column CC and then conveyed to the thermal conductivity 
detector TCD that generates electrical signals, which, properly processed by the Eager 
Xperience software, provide the Nitrogen and Carbon percentages.

Note  Sulfur and halogenated compounds (Chlorine, Bromine, etc.), possibly present in 
the sample, do not affect analysis, since the silver-plated cobalt oxide catalyst holds back 
both   SO2 and halogens.
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 8 Analytical Methods
Analytical Method for NCS Configuration
Analytical Method for NCS Configuration 
An autosampler AS is connected to a reactor R1 placed in an furnace at the temperature of 
900 °C. To the reactor outlet an adsorption filter F1 is connected. The filter F1 outlet is 
connected to the analytical column CC, on its turn connected to the thermal conductivity 
detector TCD.

Figure 78. Instrument parts diagram and pneumatic diagram for NCS determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to relevant proportional valves EVP1 and 
EVP2. 
The proportional valve EVP1, connected to the autosampler AS, controls the Helium flow in 
the whole pneumatic circuit as far as the solenoid valve EV3. This valve, normally open, 
exhausts Helium to the atmosphere through Vent 4. 
The proportional valve EVP2, connected to the detector reference channel TCD, controls the 
Helium flow as far as the solenoid valve EV4. This valve, normally open, allows Helium to 
reach point 1 of the autosampler and purge the zone where the sample is housed. 
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8 Analytical Methods
Analytical Method for NCS Configuration
The Oxygen line O2 is connected to the solenoid valve EV1. This valve controls the Oxygen 
inlet.

Sequence of the Method Stages

During pre-analysis the solenoid valve EV1 shuts off Oxygen, whereas the solenoid valve EV2 
allows Helium to flow in the circuit. When Start Analysis is pressed, the valve EV1 opens, 
whereas the valve EV2 switches to allow Oxygen to flow in as far as the combustion reactor R1 
for a preset time.
After a few seconds, the sample. weighed in a tin container and stored in the autosampler, is 
dropped into the combustion reactor.
Tin, coming in contact with an extremely oxidizing environment, triggers a strong exothermic 
reaction. Temperature rises to approximately 1800 °C instantly causing the sample 
combustion. 
At the end of the time set for Oxygen introduction, the valves EV1 and EV2 return to their 
original position restoring the Helium flow. The gas mixture (N2, CO2, H2O and SO2) 
generated by combustion is conveyed across the reactor R1 where oxidation is completed. 
Nitrogen oxides and sulfur trioxide possibly formed are converted into elemental nitrogen and 
sulfur dioxide, and the Oxygen excess is retained.
Then the gas mixture (N2, CO2, H2O and SO2) crosses the adsorption filter F1 that retains 
water, and flows to the chromatographic column CC1 where separation occurs. 
The eluted gases are conveyed to the thermal conductivity detector TCD that generates 
electrical signals, which, properly processed by the Eager Xperience software, provide 
Nitrogen, Carbon and Sulfur percentages.
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 8 Analytical Methods
Analytical Method for NC-Soils, NC-Sediments and NC-Filters Configurations
Analytical Method for NC-Soils, NC-Sediments and NC-Filters 
Configurations

An autosampler AS is connected to a steel reactor R1 placed in an furnace at the temperature 
of 900 °C. This reactor on its turn is connected to a second reactor R2 placed in an furnace at 
the temperature of 680 °C. To the R2 outlet an adsorption filter F1 is connected. The filter 
F1 outlet is connected to the analytical column CC, on its turn connected to the thermal 
conductivity detector TCD.

Figure 79. Instrument parts diagram and pneumatic diagram for NC-Soils, Sediments and Filters determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to relevant proportional valves EVP1 and 
EVP2. The proportional valve EVP1, connected to the autosampler AS, controls the Helium 
flow in the whole pneumatic circuit as far as the solenoid valve EV3. This valve, normally 
open, exhausts Helium to the atmosphere through Vent 4. 
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8 Analytical Methods
Analytical Method for NC-Soils, NC-Sediments and NC-Filters Configurations
The proportional valve EVP2, connected to the detector reference channel TCD, controls the 
helium flow as far as the solenoid valve EV4. This valve, normally open, allows Helium to 
reach point 1 of the autosampler and purge the zone where the sample is housed. The Oxygen 
line O2 is connected to the solenoid valve EV1. This valve controls the Oxygen inlet.

Sequence of the Method Stages

During pre-analysis the solenoid valve EV1 shuts off Oxygen, whereas the solenoid valve EV2 
allows Helium to flow in the circuit. When Start Analysis is pressed, the valve EV1 opens, 
whereas the valve EV2 switches to allow Oxygen to flow in as far as the combustion reactor R1 
for a preset time. 
After a few seconds, the sample, weighed in a tin container and stored in the autosampler, is 
dropped into the combustion reactor.
Tin, coming in contact with an extremely oxidizing environment, triggers a strong exothermic 
reaction. Temperature rises to approximately 1800 °C instantly causing the sample 
combustion. 
At the end of the time set for Oxygen introduction, the valves EV1 and EV2 return to their 
original position restoring the Helium flow. 
The gas mixture (N2, CO2, H2O e SO2) generated by combustion is conveyed across the 
reactor R1 where oxidation is completed. Then the mixture crosses the reactor R2 where 
nitrogen oxides possibly formed are converted into elemental nitrogen, and the Oxygen excess 
is retained. Then the gas mixture crosses the adsorption filter F1 which retains water. 
Nitrogen and Carbon are then eluted in the chromatographic column CC and conveyed to 
the thermal conductivity detector TCD that generates electrical signals, which, properly 
processed by the Eager Xperience software, provide the Nitrogen and carbon percentages 
contained in the sample.
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 8 Analytical Methods
Analytical Method for N Lubricant, N/Protein and N-Brew Configurations
Analytical Method for N Lubricant, N/Protein and N-Brew 
Configurations

An autosampler AS is connected to a steel reactor R1 placed in an furnace at the temperature 
of 950 °C. This reactor on its turn is connected to a second reactor R2 placed in an furnace at 
the temperature of 840 °C. To the R2 outlet two filters F1 and F2 are connected in series. 
The filter F2 outlet is connected to the analytical column CC, on its turn connected to the 
thermal conductivity detector TCD.

Figure 80. Instrument parts diagram and pneumatic diagram for N-Lubricant, N/Protein and N-Brew determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to relevant proportional valves EVP1 and 
EVP2. 
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8 Analytical Methods
Analytical Method for N Lubricant, N/Protein and N-Brew Configurations
The proportional valve EVP1, connected to the autosampler AS, controls the Helium flow in 
the whole pneumatic circuit as far as the solenoid valve EV3. This valve, normally open, 
exhausts Helium to the atmosphere through Vent 4. The proportional valve EVP2, connected 
to the detector reference channel RF, controls the Helium flow as far as the solenoid valve EV4. 
This valve, normally open, allows Helium to reach the point 1 of the autosampler and purge 
the zone where the sample is housed. The Oxygen line O2 is connected to the solenoid valve 
EV1. This valve controls the Oxygen inlet.

Sequence of the Method Stages

During pre-analysis the solenoid valve EV1 shuts off Oxygen, whereas the solenoid valve EV2 
allows Helium to flow in the circuit. When Start Analysis is pressed, the valve EV1 opens, 
whereas the valve EV2 switches to allow Oxygen to flow in as far as the combustion reactor R1 
for a preset time. 
After a few seconds, the sample, weighed in a tin container and stored in the autosampler, is 
dropped into the combustion reactor.
Tin, coming in contact with an extremely oxidizing environment, triggers a strong exothermic 
reaction. Temperature rises to approximately 1800 °C instantly causing the sample 
combustion. 
At the end of the time set for Oxygen introduction, the valves EV1 and EV2 return to their 
original position restoring the Helium flow. The gas mixture (N2, CO2, H2O and SO2) 
generated by combustion is conveyed across the reactor R1 where oxidation is completed. 
Then the mixture crosses the reactor R2 where nitrogen oxides possibly formed are converted 
into elemental nitrogen, and the Oxygen excess is retained. 
Then the gases pass through the two adsorption filters F1 and F2 connected in series. The 
first filter retains carbon and sulfur dioxides, whereas the second filter holds back water. 
Nitrogen is then eluted in the chromatographic column CC and conveyed to the thermal 
conductivity detector TCD that generates an electrical signal, which, properly processed by the 
Eager Xperience software, provides the nitrogen-protein percentage.
132 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



 8 Analytical Methods
Analytical Method for NC-IRMS Configuration
Analytical Method for NC-IRMS Configuration
An autosampler AS is connected to a quartz reactor R1 placed in an furnace at the 
temperature of 900 °C. This reactor, on its turn, is connected in series to a second reactor R2 
placed in an furnace at the temperature of 680 °C. To the R2 outlet an adsorption filter F1 is 
connected. The filter F1 outlet is connected to the analytical column CC, on its turn 
connected to the thermal conductivity detector TCD, the continuous flow interface CFI and 
to the isotopic ratio mass spectrometer IRMS.

Figure 81. Instrument parts diagram and pneumatic diagram for NC-IRMS determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to relevant proportional valves EVP1 and 
EVP2. The proportional valve EVP1, connected to the autosampler AS, controls the Helium 
flow in the whole pneumatic circuit as far as the solenoid valve EV3. This valve, normally 
open, exhausts Helium to the atmosphere through Vent 4. 
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8 Analytical Methods
Analytical Method for NC-IRMS Configuration
The proportional valve EVP2, connected to the detector reference channel TCD, controls the 
Helium flow as far as the solenoid valve EV4. 
This valve, normally open, allows Helium to reach point 1 of the autosampler and purge the 
zone where the sample is housed. The Oxygen line O2 is connected to the solenoid valve EV1.
This valve controls the Oxygen inlet.

Sequence of the Method Stages

During pre-analysis the solenoid valve EV1 shuts off Oxygen, whereas the solenoid valve EV2 
allows Helium to flow in the circuit. When Start Analysis is pressed, the valve EV1 opens, 
whereas the valve EV2 switches to allow Oxygen to flow in as far as the combustion reactor R1 
for a preset time. 
After a few seconds, the sample. weighed in a tin container and stored in the autosampler, is 
dropped into the combustion reactor.
Tin, coming in contact with an extremely oxidizing environment, triggers a strong exothermic 
reaction. Temperature rises to approximately 1800 °C instantly causing the sample 
combustion. 
At the end of the time set for Oxygen introduction, the valves EV1 and EV2 return to their 
original position restoring the Helium flow. 
The gas mixture (N2, CO2, H2O and SO2) generated by combustion is conveyed across the 
reactor R1 where the oxidation of components is completed. Then, the mixture crosses the 
reactor R2 where nitrogen oxides possibly formed are converted into elemental nitrogen, and 
the Oxygen excess is retained.

The gas mixture then crosses the adsorption filter F2 that retains water. Nitrogen and carbon 
are eluted in the chromatographic column CC and then conveyed to the thermal conductivity 
detector TCD (it generates electrical signals which, properly processed by the Eager Xperience 
software, provide the Nitrogen and Carbon percentages) to the CFI device.and to the IRMS 
detector.

Note  Sulfur and halogenated compounds (Chlorine, Bromine, etc.), possibly present in 
the sample, do not affect analysis, since the silver-plated cobalt oxide catalyst holds back 
both   SO2 and halogens.
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 8 Analytical Methods
Analytical Method for NC-HT Configuration
Analytical Method for NC-HT Configuration

An autosampler AS is connected to a quartz reactor R2 placed in the right furnace at the 
temperature of 950 °C. To the R2 outlet an adsorption filter F2 is connected. The filter F2 
outlet is connected to the analytical column CC2, on its turn connected to the thermal 
conductivity detector TCD, the continuous flow interface CFI and to the isotopic ratio mass 
spectrometer IRMS.

Figure 82. Instrument parts diagram and pneumatic diagram for NC-HT determination

Pneumatic Diagram Description

Helium He flows to the flow sensor S1, through the solenoid valve EV2, and directly to the 
flow sensor S2. Both flow sensors are connected to relevant proportional valves EVP1 and 
EVP2. The proportional valve EVP1, connected to the autosampler AS, controls the Helium 
flow in the whole pneumatic circuit as far as the solenoid valve EV3. This valve, normally 
open, exhausts Helium to the atmosphere through Vent 4.

IMPORTANT  Only the NC configuration is considered
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8 Analytical Methods
Analytical Method for NC-HT Configuration
The proportional valve EVP2, connected to the detector reference channel TCD, controls the 
Helium flow as far as the solenoid valve EV4. This valve, normally open, allows Helium to 
reach point 1 of the autosampler and purge the zone where the sample is housed. The Oxygen 
line O2 is connected to the solenoid valve EV1. This valve controls the Oxygen inlet. 

Sequence of the Method Stages

During pre-analysis the solenoid valve EV1 shuts off Oxygen, whereas the solenoid valve EV2 
allows Helium to flow in the circuit. When Start Analysis is pressed, the valve EV1 opens, 
whereas the valve EV2 switches to allow Oxygen to flow in as far as the combustion reactor R2 
for a preset time. 
After a few seconds, the sample. weighed in a tin container and stored in the autosampler, is 
dropped into the combustion reactor. Tin, coming in contact with an extremely oxidizing 
environment, triggers a strong exothermic reaction. 
Temperature rises to approximately 1800 °C instantly causing the sample combustion. 
At the end of the time set for Oxygen introduction, the valves EV1 and EV2 return to their 
original position restoring the Helium flow. The gas mixture generated by combustion is 
conveyed across the reactor R2 where the oxidation of components is completed.

The gas mixture then crosses the adsorption filter F2 that retains water. Nitrogen and carbon 
are eluted in the chromatographic column CC2 and then conveyed to the thermal 
conductivity detector TCD (it generates electrical signals which, properly processed by the 
Eager Xperience software, provide the Nitrogen and Carbon percentages) to the CFI 
device.and to the IRMS detector.

Note  Sulfur and halogenated compounds (Chlorine, Bromine, etc.), possibly present in 
the sample, do not affect analysis, since the silver-plated cobalt oxide catalyst holds back 
both   SO2 and halogens.
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Instrument Start-up

Introduction
To analyze any type of sample the instrument must be in the correct operating conditions.

Proceed according to the following operating sequences:

• Powering on 

• Installation of Eager Xperience software into the PC

• Analytical configuration

• Leak checking

• Adjustment of the detector signal level

Powering on the System
Switch on the instrument lifting the breaker located at the back of the instrument (position I). 
At the powering on, the indicating LED Power On on the synoptic panel light up. Switch on 
the computer and any complementary units by means of relevant switches.

Contents

• Introduction

• Powering on the System

• Installation of Eager Xperience

• Eager Xperience Main Menu

• Analytical Configuration

• Leak Test

• Detector Signal Level

CAUTION  Before starting the operating sequences, make sure that instrument, reactors, 
adsorption filters, autosampler (or manual injection device for liquids) and any 
complementary units are properly installed as described in previous chapters. 
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9 Instrument Start-up
Installation of Eager Xperience
Installation of Eager Xperience
 To Install Eager Xperience

The software Eager Xperience can be installed in a system provided with Windows™ 
2000/XP/Vista operating systems. The free space on the PC hard disk must be at least 30 MB. 
Eager Xperience is installed by using the CD provided in the standard outfit and operating as 
follows:

1. When the CD is introduced into the CD driver of the PC, the installation menu shown 
in Figure 83 is displayed.

Figure 83. Eager Xperience installation menu

2. Start installation by clicking the push-button  Install Eager Xperience for 
Flash.

3. Follow the instructions prompted step by step.

4. At the end of installation, in the page Start-Program Eager Xperience, double-click the 
Eager Xperience for Flash icon. The window of Figure 84 is displayed.

Figure 84. Selection of the instrument

5. Click the icon of the instrument selected.The program is designed to work with four 
instruments. Each icon corresponds to one instrument. The instrument name shown 

Material required

Eager Xperience package

Note  If the installation menu does not automatically appear, start the CD Autorun 
program through the Windows™ Start-Run command.
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 9 Instrument Start-up
Eager Xperience Main Menu
below the icon can be changed. To do this, click on the existing name and overwrite the 
new one.

6. Eager Xperience proceed with the registration and the activation of some drivers needed for 
the correct functioning of the software.

a. Click Ok to the answers prompted step by step. 

b. At the end of the operation, reboot the computer. Start Eager Xperience again selecting 
Start > Programs > Eager Xperience > Eager Xperience for FlashEA.

7. Follow the prompted indications. At the end of the installation, the Main Menu is 
displayed.

Eager Xperience Main Menu
The Main Menu of Eager Xperience, shown in Figure 85, is the starting point to enter all 
menus and relevant functions. Menus and icons of Main Menu are described in the following 
Table 41 and Table 42 respectively.

Figure 85. Eager Xperience Main Menu

Table 41. Main Menu: description of the menus

Menu Description Submenus and Options

File This menu contains functions 
concerning the instrument 
operation.
It is used during the analyzer 
installation procedure.

• Set language
• Colour set
• Instrument configuration
• System administration
• Installation qualification
• Load method
• Load system defined method
• Save method
• Copy method from...
• Printer setup
• Print method
• Exit Eager Xperience
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9 Instrument Start-up
Eager Xperience Main Menu
Run Use this menu to choose the type 
of start command to be sent to the 
analyzer, and also to stop the 
analytical cycle or abort the 
current analysis.

• Start sequence of samples
• Stop running sequence
• Start single sample data acquisition
• Stop data acquisition
• Abort data acquisition
• Run macro

Edit This menu provides functions 
related to the instrument setup 
and analytical parameters.

• Edit Method
• Component table
• Sample table
• Wizard method development
• Edit Elemental Analyzer parameters

View Use this menu to monitor the 
analysis in real time, read the 
result of the last sample run, check 
the calibration curve, compare 
and overlay chromatograms, 
check the instrument status and 
maintenance. 

• View sample being acquired
• Last sample calculated results
• View Calibration curve
• View Chromatograms
• Overlay Chromatograms
• Operate on Chromatograms
• Compare Chromatograms
• View Elemental Analyzer Status
• View Maintenance

Recalculation Use this menu to cancel the 
calibration curve and the results of 
previous analyses. You can 
recalculate previous results 
individually or sequentially.
It also provides the summary of 
results.

• Reset calibration factor
• Recalculation
• Summarize results

Tools Use this menu when the ashes 
removal and/or reactor 
replacement is required as 
maintenance

• Ashes removal
• Reactor replacement
• Cleaning the MAS piston

Help Use this menu to enter Eager 
Xperience help program. It is 
subdivided into different modules, 
each one designed to cover specific 
issues of the module currently in 
use.

• Help
• About Eager Xperience

Table 42. Main Menu: description of the icons

Icon Function Description

Load method Use this icon to load a previously saved analytical 
method.

Table 41. Main Menu: description of the menus, continued

Menu Description Submenus and Options
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 9 Instrument Start-up
Eager Xperience Main Menu
Save method Use this icon to store new operating methods.

Wizard method 
development

Use this icon to develop new operating methods

Edit method This icon accesses to the integration and calculation 
parameters, and to the parameters for printing 
analytical reports.

Components Table This table contains the stored retention times, which 
allow to identify N, C, H, S and O.

Sample Table This table contains all functions related to sample 
records, and the function allowing communication 
with the balance.

Summarize results This feature contains analytical results, print options 
and chromatograms.

Recalculation This function allows to recalculate previous results.

View Maintenance This icon allows to program current maintenance by 
recording the number of analyses run by each reactor 
of the analytical circuit.

Edit Elemental Analyzer 
Parameters

Use this icon to open the pages containing the 
commands for the setting of temperatures, flows, 
times, detector and the analyzer control functions.

View Elemental Analyzer 
Status

This function comprises the pages displaying the 
analyzer conditions. 
It contains special functions to check the system 
pneumatic tightness (Leak Test), to check the baseline 
level, and to program automatically the “Autoready” 
function.

Start sequence Use this icon to start a series of analyses having 
different current and timed requirements. At the end 
of the analytical cycle, the instrument can either be put 
in Standby Mode or the furnace and detectors be 
switched off, or the gas flows turned off.

Stop sequence Use this function to stop in any moment the sequence 
of analyses only completing the current run.

Table 42. Main Menu: description of the icons, continued

Icon Function Description
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Analytical Configuration
Analytical Configuration
The analytical conditions are set in our laboratories during the final test of the analyzer. To put 
the analyzer in operating conditions, you only have to follow the instructions reported in the 
next operating sequence.

 To Configure the Analyzer

1. In Main Menu of Figure 85 on page 141, choose File > Instrument Configuration. The 
following window is displayed.

Figure 86. Instrument name and configuration

a. In the section Instrument name, type the instrument serial number (6 digits; for 
example 991234). See the label located on the instrument rear panel.

b. In the section Analytical instrument configuration select the configuration of your 
instrument.

c. If the instrument is coupled with an IRMS detector, check the function Simple 
Instrument control for IRMS. At the reboot of Eager Xperience, the simplified 
Main Menu for IRMS is visualized as shown in Figure 87.

Figure 87. Main menu for IRMS

d. Click Elemental analyzer setup to enter the dialog window of Figure 88 where the 
configuration parameters have to be set.

CAUTION  NCS, CHN, CHNS, Sulfur and Oxygen configurations use the LEFT furnace 
only. Do not set any temperature for the RIGHT furnace.

Note  The option Undefined can be used in case the desired operating conditions 
are different from those defined for the instrument configuration.
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 9 Instrument Start-up
Analytical Configuration
Figure 88. Configuration dialog window

e. In the section Elemental Analyzer Connection select the computer serial port 
(COM1, COM2 etc.) to which the instrument is connected. 

f. In the section Type verify that the instrument in use is Flash 2000.

g. In the section Instrument Settings choose the following settings:

i. Line Frequency = 50 Hz

ii. TCD Settings Source = Internal

iii. TCD Settings Polarity = Positive 

h. In the section Sampler Setting select the type of autosampler installed on the 
instrument. 

i. In the case of autosampler for liquid sample, also specify the computer serial port, 
to which the autosampler is connected, and the number of vials.

ii. Click Ok to go back to the window of Figure 88, then click Ok to return to Main 
Menu.

2. In the main menu, select File and then the option Load System Defined Method. The 
file name of the loaded method is displayed in the grid Filename of method in use of 
Main Menu.

3. In Main Menu select Edit and then the option Edit Elemental Analyzer Parameters or

just click the icon . The following window appears where the analyzer operating 
parameters are displayed.

Note  For the Oxygen determination in CHN-O and CHNS-O configurations, 
select the negative polarity. If the same configurations two autosamplers are used, 
refer to the relevant Analytical Method described in Chapter 8.
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9 Instrument Start-up
Leak Test
Figure 89. Example of analyzer parameters

a. Click Send to transfer the operating parameters to the instrument.

b. From now on the analyzer is working. The furnaces begin to heat, Helium flows in 
the circuit and the LEDs Furnace, Oven and TCD lights up on the synoptic panel.

After about 50 minutes the instrument furnaces reach the temperature settings and 
the LED Ready on the synoptic panel lights up.

The instrument is now ready to run analyses. However, before starting an analytical 
cycle, a leak test must be carried out to check that reactors, filters, if any, and gas 
chromatographic columns have been properly installed. 

Leak Test
The leak test must be performed any time a component of the pneumatic circuit is replaced. 
Operate according to the instructions reported in the following operating sequence.

 To Check the Leaks 

1. In Main Menu select View and then the option View Elemental Analyzer Status or just

click the icon . The following window appears.
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Figure 90. Status of the analyzer

2. Select the option Special Functions. The following window will appear.

Figure 91. Special function window

3. In the section Command click the button Leak Test. The box of Figure 92 is displayed 
with the leak test parameters. 
Thermo Scientific Flash 2000 Elemental Analyzer - Operating Manual 147



9 Instrument Start-up
Detector Signal Level
Figure 92. Leal test parameters box

a. Click Start to begin the operation. A window will appear where you will be requested 
to perform the Autozero. After 300-360 seconds (Leak test time), Carrier Flow and 
Reference Flow must be within 0 and 3 mL/min. Higher values indicate that the 
system is not leak-free.

b. Leaks in the system are generally due to incorrect closure of the reactors and filters 
locking nuts. Rarely, leaks may be due to the autosampler. 

c. To terminate the leak test and restore the flow operating values, click Stop and Done.

Detector Signal Level
To adjust the level of the TCD detector signal, follow the instructions reported in the 
following operating sequence.

 To Adjust the Detector Signal Level

1. In Main Menu select View > View Elemental Analyzer Status or justclick the icon . 
The window of Figure 90 on page 147 will be displayed. 

2. Select the option Detector. The following window will appear.

Note  Leaks in the system are generally due to incorrect closure of the reactors and 
filters locking nuts. Rarely, leaks may be due to the autosampler. 
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Figure 93. Detector parameters status

3. In the section TCD, click the button Auto-Adjust Level at 1000 μV. At the end of the 
operation, the value 1000 is set representing the analysis starting point.
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10
Guide to Run Analyses

This chapter contains information and operating sequences to run sample analyses, and it also 
describes the comparison methods for a correct evaluation of results. Practical advise for daily 
operation is also provided.

Introduction
To program and analyze any type of sample, do the following:

• Create a directory of analyses

• Program the current maintenance (recommended operation)

• Choose the calibration 

• Set a sample table

• Determine the blank value

• Run the sequence of analyses

Contents

• Introduction

• Directory for Analyses

• Current Maintenance Program

• Instrument Calibration

• Sample Table

• Determination of the Blank Value

• Sequence of Analyses

• Quality Control and Check of Analytical Results

• Post-Analysis Operations

• Analytical Troubleshooting

IMPORTANT  Before starting operating sequences, make sure that the instrument 
start-up operations have been performed as described in Chapter 9, “Instrument 
Start-up,” 
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Directory for Analyses
Before analyzing a sample, you should create a directory where you will store the operating 
method comprising:

• Sample table

• Integration parameters

• Calculation parameters

• and all that is necessary to run the analysis.

Current Maintenance Program
Each reactor, each filter and relevant fillings need to be replaced according to the analytical 
configuration used. For each configuration, an average life of its components has been 
established. The View Maintenance option will indicate when the different components have 
to be replaced. To start the maintenance program, do what described in the following 
operating sequence.

 To Start-up the Current Maintenance Program

1. In the main menu select View > View Maintenance. According to your analytical 
configuration, a window like the following one is displayed.

Figure 94. Maintenance program schedule

The example of Figure 94 shows the analytical circuit components for which the 
maintenance routine is required. 
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In the diagram the active components are indicated with colored areas and show on the 
left the numerical scale of their lifetime. The meaning of each colored area is indicated in 
the upper section of the diagram. The components not present in the concerned 
instrument configuration are indicated by a dashed line. 

2. To view in detail the default conditions of the components of the concerned instrument 
configuration, in the menu Edit select Set Maintenance > Default. A window like the 
one below will appear. The values shown cannot be changed.

Figure 95. Maintenance: Example of default condition

Component Description

Left Represents the oxidation reactor
In Figure 94 Left 1 represents the crucible or ashes, whereas Left 2 
represents the oxidation reactor. 

Right Represents the reduction o pyrolysis reactor.

Ads Filter 1 Represents the first adsorbent filter.

Ads Filter 2 Represents the second adsorbent filter.

Condition Description

Life time indicates the preset maximum number of analyses each individual 
component can perform.

Number of runs to 
warning message

indicates that when any of the components will still have to run 
only 10 analyses to reach the number set in Lifetime, each 
program page will display the message Check Maintenance. 
If the message is ignored and analyses are continued, when the 
preset number of runs is reached, the message Alarm will be 
displayed. This does not stop the analytical cycle.

Number of runs until 
next maintenance

indicates the number of analyses to be performed before next 
maintenance

Number of runs since 
last maintenance

indicates the number of analyses performed after last maintenance
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3. If you want to use a different maintenance program from the default one, in the menu 
Edit, select the option Set Maintenance > Manual. A window like the following will be 
displayed.

Figure 96. Maintenance: Manual program

In the window of Figure 96, you can change any value by clicking on the different boxes and 
entering the desired new value.

Instrument Calibration
Eager Xperience offers three calibration methods:

• K-Factor

• Linear

• Non Linear

All tests are performed with the K-Factor method that is generally used by most users. This 
method consists in obtaining a constant of calculation by means of the following formula:

K =%Th*(I-b)/w 

where:

Th = Theoretical percentage of the standard
w = Weight in milligrams of the standard
I = Area integral of the standard
b = Blank area integral 

For the calculation of an Unknown sample, Eager Xperience will use the reverse formula:

%Unknown = K*w/(I-b)

where:
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K = K-factor
w = Weight in milligrams of the sample
I = Area integral of the sample
b = Blank area integral 

The Linear method is generally used when samples very different from each other are 
analyzed in the same analytical sequence. In this way the errors due to the detector response 
linearity are minimized.

The Non-Linear method is used when the analyzer is connected to another detector having a 
response of exponential type. To select the calibration method or view the calibration curves of 
a memorized method, do as described in the following operating s

To select the calibration method or view the calibration curves of a memorized method, do 
what described in the following operating sequence.

 To Calibrate Method and Curves

1. Select the calibration method.

a. In Main Menu choose Edit > Method or just click the  icon. The following 
window will be displayed:

Figure 97. Method editor

b. Select the option Calculation Parameter. 

i. In the section Calibration Method, select the calibration method required.

ii. If desired, in the section Heat value, select in the box Calculation the type of 
sample between the options None, Liquids and Solids. 
Click on the icon shown on the box right side to display the calculation scheme 
related to the selected option.

iii. In the case of N/Protein and N-Brew configurations, in the section Protein, tick 
Protein Calculation. Click on the icon shown on the box right side to display the 
relevant calculation scheme.

2. View the calibration curves. 

a. At the end of analyses of the standard samples, it is possible to visualize the calibration 
curve operating as follows:

b. In Main Menu choose View > View Calibration curve. A window similar to one 
below will be displayed.
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Figure 98. Example of Calibration curves

c. Select Calib. Method. According to the calculation method, the calibration points 
with peak area and concentration will be displayed. 

Sample Table
The sample table of the analytical method contains all information concerning the series of 
samples to be acquired and processed. To enter the sample table, do as described in the 
following operating sequences.

Figure 99. Example of Sample table

 To Fill Sample Table

1. Select Edit sample >Fill Sample table or just click the icon . The following window 
will be displayed, which offers all the functions necessary to fill, change or cancel Sample 
Table.
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Figure 100. Window to fill Sample Table

a. In the section Samples edit as follows: 

i. Do not enter Sample Name now. Sample name, or sample monogram will be 
entered from time to time as required. 

ii. In the text box Filename, enter the filename to be used to save the sample.

iii. In the box Number samples, enter the number of samples, up to 200, to be 
analyzed.

iv. Check that Unknown is ticked

2. Leave Sample name idx and Filename idx set as 1.

a. In the section Sampler, enter the parameters if the instrument is equipped with the 
autosampler for liquids. 

b. In the left bottom section, enter the following.

i. Leave Weight set as 1. 
The weight is entered time by time. In case of direct injections of constant 
volumes, the sample volume can be entered directly.

ii. Set Protein factor only if the instrument configuration is N/Protein or N-Brew. 
For all other configurations set 0 (zero).

iii. Select the Category to which the sample belongs only if the instrument 
configuration is N/Protein or N-Brew. For all other configurations this parameter 
is not edited. To enter the sample category, press the arrow. The following 
window is displayed.
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Figure 101. Window to select the sample category

3. At the end of editing, click Replace. The sample table appears again. In the sample table 
grid you will find all information entered.

The following Figure 102 and show an example of edited sample table referred to the 
N/Protein instrument configuration.

Figure 102. N/Protein: Window of sample table editing

Note  In the case of liquid samples analyses with the sampler for liquid, the column 
Density will be displayed in the sample table grid in which insert the density of the 
liquid sample that will automatically be turned into weight.
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Figure 103. N/Protein: Example of sample table

Determination of the Blank Value
For the determination of the blank value, do what described in the following operating 
sequence.

 To Determine the Blank Value

1. Put in the autosampler an airtightly closed container. When N/Protein is used, it is 
suggested to introduce about 50-80 mg of sugar into the container to avoid that a high 
quantity of oxygen freely flows on the reduction reactor.

2. In Main Menu select Edit > Sample table or just click the icon . The sample table 
appears. See Figure 99 on page 156.

a. In the sample table grid, click on the column Type. Click on the arrow displayed, and 
the following window will appear for the sample type selection.

Figure 104. Window for the sample type selection

b. In the window of Figure 104 select Blank, then click OK to confirm and go back to 
the sample table. 

c. Click OK to confirm and go back to Main Menu.

3. In Main Menu, select the menu Run > Start Single Sample Data Acquisition.

4. Once the analysis run time has elapsed, compare the chromatogram obtained with that of 
the final test provided with the instrument.
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To compare the chromatogram obtained with that of the final test and to check the blank 
value, there are two procedures according to whether a printer is available or not.

• In the first case refer to the operating sequence “To Check the Blank Value with a Printer 
Available” on page 160.

• In the second case refer to the operating sequence “To Check the Blank Value with No 
Printer Available” on page 162.

 To Check the Blank Value with a Printer Available 

Operate as follows:

1. In Main Menu select Edit > Method or just click the icon . The Method editor 
window is displayed.

Figure 105. Example of Method editor windows

2. Select Report Parameters. The window of Figure 106 will appear.

Figure 106. Report parameter window

a. In the section Report format, select in the box Report type the option Standard, 
then tick the option Append to summarize.
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b. In the section Report on, select in the box Report destination the option Printer.

3. In the window of Figure 105 select the tag Report Stripchart. The following dialog 
window is displayed. 

Figure 107. Report stripchart window

a. In the section Stripchart annotation uncheck the function Autoscaling.

b. If required, in the section Stripchart options modify the values as desired.

4. Click OK to confirm the settings.

5. In the main menu select Recalculation > Recalculation. The following dialog window is 
displayed. 

Figure 108. Recalculation window

a. In the section Integration options tick the function Identify peaks. 

b. In the section Chromatogram source tick the function Sample sequence.
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c. In the section Recalculate sample(s) from Sample Sequence set First Sample 1 and 
Last Sample 1.

6. Click OK. The report of values will be printed.

 To Check the Blank Value with No Printer Available

To check the blank value with no printer available, do the following:

1. In Main Menu select the menu Recalculation > Recalculation. The dialog window of 
Figure 109 is displayed. 

Figure 109. Recalculation window

a. In the section Integration options tick the function Review report text. 

b. In the section Integration options tick the function Identify peaks. 

c. In the section Chromatogram source tick the function Sample sequence.

d. In the section Recalculate sample(s) from Sample Sequence set First Sample 1 and 
Last Sample 1.

2. Click OK. The report of values is displayed.

Evaluation of the Blank Value

The blank value is a function of the type of containers used and of Oxygen purity. Check that 
the values found are within acceptable limits versus those reported in the final test certificate. 
If the values found are higher, refer to the following table.
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Sequence of Analyses

To correctly run the analysis, do what described in the following operating sequence.

 To Perform the Analytical Sequence

The sample weights may be manually entry or automatically transferred from the balance to 
the PC. These two modes are explained below.

• “Mode 1: Manual Entry of the Weights” on page 164

• “Mode 2: Automatic Entry of the Weights from the Balance to the PC” on page 165

Table 43. Blanl value diagnostic guide

Blank Cause and remedy

Nitrogen If the nitrogen value is definitely higher than that indicated, repeat the blank 
according to the above described procedures.

If the area value decreases, it means that the connection tube between 
oxygen cylinder and instrument contains air. To solve this problem 
disconnect the joint for some time and let oxygen flow to the atmosphere. 

Should the blank repetition not cause a significant decrease in the area value, 
it means that oxygen used has not a proper purity degree. Use oxygen of 
required purity.

Carbon High values are due to contamination. Always work on perfectly clean 
surfaces and always keep the containers in a closed container.

Hydrogen The hydrogen blank comes from catalysts and more generally from the 
circuit. The value tends to decrease in time.

Sulfur Generally absent or negligible

Oxygen Generally negligible. High values are due to the container contamination.

IMPORTANT  All blank values are memorized and subtracted to the sample values. As a 
consequence, definitely high values may affect analytical precision.

IMPORTANT  Before shipment, every instrument is submitted to an analytical final test 
procedure according to the concerned instrument configuration. 
The results of this test are included in the documentation set accompanying the 
equipment. When the instrument is used for the first time, before analyzing any unknown 
sample, it is advisable to repeat the test maintaining the selection of standards and their 
weighing range.
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Mode 1: Manual Entry of the Weights

1. Weigh the samples and put them sequentially into the autosampler tray.

2. In Main Menu select Edit > Sample Table or just click the icon . The sample table of 
Figure 99 on page 156 is displayed.

a. Enter the sample name, type and weight. In case of N/Protein and 
N-Brew analyzers, also specify the sample category. See Figure 99 on page 156.

3. The analytical sequence, after the blank analysis, includes an analysis named Bypass: a 
standard substance is analyzed to condition the instrument and at the same time to show 
the progress of the analysis to the operator, by means of the chromatogram obtained, then 
three standards and three unknown samples of other composition than the standard 
substance are analyzed.

a. In the sample table grid, click on the column Type. Click the arrow shown to display 
the window for the sample type selection.

b. According to the sample type, select Bypass, Standard, Unknown or Blank as shown 
in Figure 110. 

Figure 110. Selection of the sample type

Figure 111. Selection of the standard

4. Click OK to confirm and go back to the sample table.

Note  Selecting Standard, the following window appears. Set here the desired standard.

Note  New standards may be memorized by clicking Edit Standard Table. After the 
number 5, add the standards of interest and the percentages of the relevant elements. 
Refer to the following Figure 112.
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Figure 112. Edit standard table

5. At the end of the sample table editing, select the number following the last edited sample.

6. Select the menu Edit sample > Insert line or just click the icon . 

7. In the main menu, select the menu Run > Start sequence of sample.

8. Click Start Now.

9. At the end of the analytical sequence, the results obtained must be compared with those of 
the final test, doing what described in the operating sequence “Comparison Between 
Analytical Results and Final Test Results” on page 167.

Mode 2: Automatic Entry of the Weights from the Balance to the PC

1. Connect the RS 232 connecting cable between balance and PC.

2. Select Sample Table > Balance > Balance Setup. The following window is displayed:

Figure 113. Balance parameters setting

3. Select the computer serial port to which the balance is connected. Pay attention that the 
serial port must be different respect the serial port selected for the analyzer.

4. Select Balance menu.

a. Choose the type of balance in use.

b. Press OK. The dialog window of Figure 113 is displayed again. 
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c. Press OK to return to Sample Table.

5. In Sample Table select Balance > Receive weight. After you have selected the sample 
number desired (e.g. sample number 3), click on Weight. Pressing the down arrow the 
following window is visualized:

Figure 114. Weight from balance

6. Put the container on the balance plate. Perform the tare pressing Tare. Introduce the 
sample then wait for stabilization.

7. Clicking Weight, the value of the weight is automatically transferred. The sample table is 
ready to acquire the value of the next weight.

a. At the end of the sample table editing, to automatically stop the sample sequence, 
select the number following the last edited sample.
Select the menu Edit sample >Insert line or just click the icon . 

8. In Main Menu, select the menu Run > Start sequence of sample.

At the end of the analytical sequence, the results obtained must be compared with those of the 
final test, doing what described in the operating sequence “Comparison Between Analytical 
Results and Final Test Results” on page 167.

Note  If the balance Mettler Toledo AB54S is used, perform the tare by using the 
command located on the balance control panel.
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 Comparison Between Analytical Results and Final Test Results

To highlight results, do the following.

1. In Main Menu, select Recalculation > Summarize results or just click the icon . The 
following table is displayed.

Figure 115. Example of Summarize Results

2. In the text box Group, enter number 1 for samples 5, 6 and 7. 

a. If you want the data printout, select Print > Print single group.

b. If you want to read the statistical result, select one by one samples 6, 7 and 8, then 
select View > Statistical calculation. The display will show a window with the 
statistical data referring to the selected item.

Interpretation of Results

If the results obtained are satisfactory, go on with your samples sequence. If on the contrary 
the results are not correct, try to identify the cause and find the remedy.

The cause of the error is generally due to incorrect sample weighing. Always observe the 
indicated weighing ranges using, if possible, the direct connection between balance and 
computer, selecting in the Sample Table the option Receive Weight from Balance in Balance 
menu.

Tip  It is suggested to see Chapter 7, “Preparing the Sample,” 

Note  Should an electronic balance be connected to the instrument, remember to check 
the parameters of the connection, selecting in the Sample table the menu Balance and 
then the option Balance setup. Refer to “Mode 2: Automatic Entry of the Weights from 
the Balance to the PC” on page 165.
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3. If the weight of an unknown sample is wrong, the error immediately becomes clear from 
its percentage result. On the contrary, if the error is due to the weight of one or more 
standards, the three results of the unknown sample will all be wrong.

4. Another cause of error is the incorrect integration of the peak. If it happens, the correction 
of the baseline is required proceeding as follows:

a. Open the chromatogram selecting the sample to adjust. In Main Menu choose View 
> View Chromatogram > Peak.

b. To modify the baseline, choose the option Move peak start or Move peak end 
accordingly.

c. Save the new chromatogram.

d. Recalculate the chromatogram following the instruction in sub-paragraph Sample 
Recalculation.

Quality Control and Check of Analytical Results
Quality control, particularly for food, often requires the daily analysis of the same materials, 
specially in nitrogen-protein analyses.Therefore it is important to define the maximum and 
minimum acceptable values. These values can be stored and used as comparative parameters 
for next analyses.A similar condition occurs if the user has many samples to run for which he 
knows the supposed theoretical values. In this case too, we recommend to memorize the 
maximum and minimum values to make the comparison between the theoretical and found 
values easier and quicker. To use this comparison method, do what described in the following 
operating sequence.

 Method to Compare Results

After having analyzed the standard samples and checked the instrument precision. do the 
following:

1. In Main Menu, select the menu Recalculation > Summarize results or just click the

icon . The Summarize result table will be displayed. See Figure 115 on page 167.

2. Select the menu Edit and then the option Select reference compounds. A table like the 
following will be displyed.

Figure 116. Example of the reference compounds selection table

a. In the textbox Name, enter the sample name.
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b. In the text boxes Nitrogen, Carbon, Hydrogen, Sulphur, Oxygen, enter the 
supposed theoretical percentages of the different elements to be analyzed.

3. Click OK. 
For each value a minimum-maximum percent deviation (box +%) versus the entered value 
is automatically calculated. The calculation of this deviation is made by an algorithm, 
which takes into account the entered percentage and the instrumental error.

Comparison between Found Values and Theoretical Values 

At the end of the analytical cycle, to compare the values found with the theoretical ones, do 
the following:

4. Go to the table of Figure 116 doing what described in steps 1 and 2.

Select the sample to be compared, then click OK. The Summarize Results table will be 
displayed.

5. In Summarize Results, select the sample to be compared as shown in the example of 
Figure 117. 

Figure 117. Summarize Results Table: Comparison of samples (1)

a. Select View > Compare to reference compound. On the left side over the 
Summarize Results table, as shown in Figure 118, you will read the name of the 
analyzed sample followed by one or more LEDs according to the number of analyzed 
elements.

Figure 118. Summarize Results Table: Comparison of samples (2)

Note  If the acceptable error range is wider than that automatically calculated, it can be 
manually changed
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 Graphic Display of the Result

If a single element is analyzed, the result can be graphically displayed. This is particularly 
useful when the sample is routinely analyzed and when it is more important to have the result 
within the preset error limits rather than the absolute value found. 

To display the graph of the result, do the following:

1. In the Summarize results table, select the group of samples to be displayed.

2. Click the Show summary graph of selected group icon . A window like the following 
is displayed.

Figure 119. Summarize graphic (1)

a. Click Componds. In the Compound of reference selection window that appears, 
select the sample corresponding to the analyzed one and click OK. 

b. A window like the following appears, where a graph is plotted consisting of two 
parallel green lines, a white middle line and red small squares.

Green light = Indicates that the values found are close to the theoretical values and 
within the preset error limits.

Red light = Indicates that the values found are far from the theoretical values.
170 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



 10 Guide to Run Analyses
Quality Control and Check of Analytical Results
Figure 120. Summarize graphic (2)

c. If the analyzed sample, represented in the graph by a red square, is within the two 
green lines, it means that, independently of its absolute value, it has a value close to 
the theoretical one and is within acceptable error limits.
The red square, when clicked, becomes white and the percent value is displayed, as 
shown in Figure 121.

Figure 121. Summarize graphic (3)

Middle line = Theoretical value

Green lines = Minimum and maximum acceptable values

Red square = Sample analyzed
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Post-Analysis Operations
To obtain precise accurate and constant in time results, and at the same time to reduce 
operating costs, we recommend you follow some practical suggestions.

Putting the Instrument in Standby Mode

When the work session is over, the instrument should be put in Standby Mode. In this 
condition, the temperatures of the Left and Right Furnaces are reduced by 50% versus 
operating temperatures, and the Helium flows on both channels are brought to 20 mL/min.

When the instrument goes in Standby Mode, the deactivated adsorption filter is regenerated. 
After the regeneration the carrier flows through both adsorption filters and the filter purge is 
stopped.

The Standby function can be activated manually or automatically at the end of the analytical 
sequence.

 To Set the Standby Function Manually

Proceed as follows:

1. In Main Menu, select View > View Elemental Analyzer Status or just click the icon . 
The page of Figure 122 is displayed. 

Figure 122. Analyzer parameters

2. In the section Other, select the function Set instrument to St-By by ticking the proper 
box.

3. Click Send to send the command to the instrument and click OK.
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 Automatic Setting of the St-By Function

1. In Main Menu, click the icon . The window of Figure 123 is displayed.

Figure 123. Sequence start window (1)

2. In the section Elemental analyzer conditions while start sequence is finished, enable 
the Force to Stand-by function by ticking the appropriate check box.
The analyzer will automatically go to the Standby condition, when the last sample has 
been analyzed.

Shutting Off Furnaces, Detector and Cutting Off Gas Flows

The shut off of furnaces and detector and the cut off of gas flows can be programmed as 
described in the following operating sequence.

 To Shut Off Temperature, Detector and Gas

1. In Main Menu, just click the icon . The window of Figure 124 is displayed.

Figure 124. Sequence start window (2)
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2. In the section Elemental analyzer conditions while start sequence is finished, enable 
the function Shut-Off temperature, detector and gas by ticking the appropriate check 
box.

3. When the oxidation reactor requires cleaning, the furnace should be switched off and 
then the Helium flow reduced using the Stand-by function.

a. In Main Menu, select Edit > Edit Elemental Analyzer parameters or just click the 
icon . The window of Figure 125 on is displayed.

Figure 125. Edit elemental analyzer parameters

b. In the section Furnaces, tick the box Left Furnace to enable the Off condition.

c. In the section Other, enable the function Set instrument to Stand-by by ticking the 
appropriate check box.

d. Click Send to send the command to the instrument, then click OK. 

Wake-up and Auto-Start Functions

These are timed functions, which can be programmed to minimize dead times.

 To Set Weak-up Function

To pass from Stand-by to Ready status, operate as follows:

1. In Main Menu, select View > View Elemental Analyzer status or just click the icon . 

2. Select the Auto-ready menu. The window of Figure 126 is displayed.
174 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



 10 Guide to Run Analyses
Post-Analysis Operations
Figure 126. Status of the analyzer

a. In the section Control, set the desired date and time of activation of the Wake-up 
function.

b. Click Activate and then OK to confirm.

Auto-Start Function

If you desire Auto-Ready to be followed by Auto-Start, programming an analytical sequence, 
do the following:

 To Set Auto-Start Functions

1. In Main Menu, click the icon . The following window is displayed.

Figure 127. Start sequence
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2. Enable the function Enable time programmed sequence start by ticking the appropriate 
check box.

a. In the section Starting time click Now.

b. In the Start Date/Time text box enter the date and time of the function activation.

Analytical Troubleshooting
If the instrument has been correctly installed, the gas characteristics are as required and 
maintenance has been regularly carried out, Flash 2000 will provide correct results. 
The lack of the above conditions will be indicated by anomalies in the chromatograms and the 
relevant analytical reports. The following table reports the most common anomalies with the 
relevant diagnosis and remedy.

IMPORTANT  The function activation should be programmed with a delay of at least 
60 minutes versus the time programmed for the Auto-Ready Function to allow the 
analyzer to reach a good thermal equilibrium.

Table 44. Analytical troubleshooting guide

Problem Diagnosis Remedy

High Nitrogen blank. Presence of leak. Check that Helium and 
Oxygen lines are sealed and 
in case eliminate possible 
leak.

Oxygen line or cylinder 
contaminated.

Purge for any minutes. 
Replace the contaminated 
cylinder.

Autosampler not purged. Check that the Helium flow 
is correct.

High constant Nitrogen 
blank in several sequential 
analyses.

Oxygen cylinder 
contaminated.

Replace the Oxygen cylinder.

Presence of leak in the 
autosampler system.

Identify leaks and remove 
them.

Carbon peak tailing or split. Too much ashes inside the 
reactor.

Check ashes and remove 
them.

The sample analyzed was too 
large.

Weigh a lower amounts of 
sample.

Hydrogen peak is a split 
peak.

The tube connecting reactor 
and column is clogged.

Cut off the clogged tube 
portion.

Bad separation between 
Nitrogen and Carbon peaks.

High Nitrogen blank value. Check the Nitrogen blank 
value. Eventually repeat the 
analysis.

Copper exhausted. Replace the reactor.
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Peak between Nitrogen and 
Carbon peaks.

Oxygen line contaminated. Exclude autosampler and 
check the Oxygen blank.

Inadequate Oxygen purity. Use Oxygen with adequate 
purity.
Exclude autosampler and 
check the Oxygen blank.

High Carbon blank. Tin containers 
contaminated.

Check the tin container box, 
tweezers, work bench are 
clean.

Memory effect due to bad 
combustion of previously 
run analyses.

Remove ashes and analyze 
lower amounts of sample.

Decreasing Nitrogen blank 
values.

Oxygen line contaminated. Wait 10-20 minutes for 
complete purging of the 
Oxygen line. 
Repeat blank analysis.

Increasing Nitrogen blank 
values.

Copper exhausted Replace the reactor.

Retention times very delayed 
respect the normal 
chromatogram.

Presence of leaks in the 
pneumatic circuit.

Perform Leak Test.

Presence of obstructions in 
the pneumatic circuit.

Reach and remove the 
obstruction dissecting the 
pneumatic circuit 

Table 44. Analytical troubleshooting guide, continued

Problem Diagnosis Remedy
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Applications

This chapter contains guidelines referring to the applications of the Flash 2000 elemental 
analyzer.

Introduction
Elemental analysis has many fields of application. Among the most important are:

• Pharmaceuticals, with synthesis products.

• Petrochemical Industry, with oil and its derivatives,

• Industrial chemistry, with polymers.

• Environment, with the analyses of soils, sediments, waters.

• Food, with protein analysis, etc.

The Flash 2000 analyzer, thanks to the Eager Xperience software, can analyze different types 
of samples. You only have to follow the indications concerning the sample weighing to obtain 
precise and reproducible results, not only with standard substances, but also with all other 
substances you will analyze later. 

However, sometimes samples to be analyzed may not be homogeneous and others may be of 
difficult combustion. In any case, as a general rule, weigh a quantity of substance adequate to 
the sample nature and to the type of determination.

Sample Oxidation
To obtain precise and reproducible results the sample must be completely oxidized. 

This is simple enough when the sample weighing range is narrow, but when the weight is 
doubled or tripled, oxygen requirements must strictly follow the weight increase. 

Contents

• Introduction

• Sample Oxidation

• Automatic Oxygen Dosage
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This is obtained by changing the rate and time of oxygen introduction. On this matter please 
refer to the instructions given in the operating sequence To Change the Oxygen Quantity.

If the major objective of the analysis is to obtain the best precision of results, it is particularly 
important that catalysts, and specially copper, last as long as possible. Therefore you have to 
establish how much Oxygen is required to burn a sample of that particular nature as a 
function of its weight. 

For example, graphite requires more Oxygen than a soil or an organic substance, though at 
equal weight. If we always use for all samples the maximum Oxygen quantity, we will obtain 
excellent results, but copper will only last for few analyses.

To establish the Oxygen quantity required to combustion, do what described in the operating 
sequence “To Establish the Required Oxygen Quantity” on page 181.

For N/Protein and N-Brew analyzers we recommend to always use the OxyTune® function 
(Automatic Oxygen Dosing System). Refer to paragraph “Automatic Oxygen Dosage” on 
page 182.

 To Change the Oxygen Quantity

1. In Main Menu select Edit > Edit Elemental Analyzer Parameters or just press the icon

. The following window is displayed with the analyzer operating parameters.

Figure 128. Example of analyzer parameters

2. Select Flow/Timing tag. The following tag is displayed.
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Figure 129. FlowTTiming tag

a. To change the time of oxygen introduction, enter the desired value in the appropriate 
box Oxygen Injection End in the section System timing.

b. To change the oxygen flow rate, enter the flow value in the appropriate box Oxygen 
in the section Gas flow.

 To Establish the Required Oxygen Quantity

Do the following: 

1. Analyze the sample setting the Oxygen flow to its maximum value (300 mlLmin).

2. At the end of the analysis, run a blank. If the area value found is equal or very close to the 
traditional blank value (±50%), it means that the sample is completely burnt without 
leaving any memory effects. 

3. To know how much Oxygen was given in excess, repeat the sample run reducing the 
Oxygen flow until the blank value is definitely higher than the traditional one. So you will 
establish the Oxygen quantity required for the combustion of that kind of sample with 
that particular weight.

This procedure is useful when you have to analyze a number of samples of the same nature. In 
the analytical sequence, you will try to keep the same weighing range for all samples.

Choosing the Weighing Range

This choice is a function of the sample kind, but also of the type of determination.

Note  The same result can be obtained by presetting a value of oxygen flow and varying 
the time of oxygen injection Oxy Inj End.

IMPORTANT  The calibration and analysis of samples must be performed under the same 
conditions of Oxy Flow and Oxy Inj End.
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• Simultaneous Analysis of 3 or 4 elements (CHN, CHNS, NCS) 
The weighing range is generally between 1 and 3 mg for organic substances, and up to 
maximum 20 mg for inorganic samples (e.g. soils, sediments, rocks).

• Nitrogen-Carbon Analysis
The weighing range is generally between 1 and 3 mg for organic substances, and up to 
maximum 100 mg for soils and sediments.

• Single Runs of Sulfur and Oxygen
The weighing range is generally between 1 and 3 mg for organic substances, and up to 
maximum 20 mg for inorganic samples.

• Nitrogen analyses in samples of any nature except food samples
We recommend a weighing range between 1 and 20 mg independently of the sample 
nature.

• Nitrogen analyses in geological materials (soils, sediments, etc.)
We recommend a weighing range between 100 mg and 1g according to the sample nature. 
Refer to “Method for Oxygen Dosage (OxyTune®)” on page 182 on. 

• Nitrogen analyses in food and agricultural samples
We recommend a weighing range between 100 and 500 mg according to the sample 
nature. Refer to “Method for Oxygen Dosage (OxyTune®)” on page 182.

Automatic Oxygen Dosage
In nitrogen-protein analyses you may often need to analyze samples of very different 
composition both as percentage and nature.

There are samples that for them nature require a minimum Oxygen quantity versus other 
samples that require greater Oxygen amounts. To avoid that the user be obliged every time to 
modify the weighing range or adjust the Oxygen quantity, the software provides a table 
comprising various categories where samples of different nature are memorized or can be 
memorized. Refer to paragraph “Sample Table” on page 156.

Selecting, after the weight entry, the category to which the sample belongs, the system will 
deliver the right Oxygen quantity required for a complete combustion. This condition is 
obtained by a feature provided thanks to the method below:

Method for Oxygen Dosage (OxyTune®)

1. A fixed Oxygen flow of 300 mL/min was set.

2. The blank value (container + 50-80 mg of sugar) was checked by repeatedly injecting 
Oxygen (using Oxygen of 99.995% purity grade) for 30 seconds in a resulting theoretical 
quantity of 150 mL. 

3. Standardization was performed using Aspartic Acid with weight ranging from 50 to 100 
mg and injecting fixed Oxygen amounts for 30 seconds in a resulting theoretical quantity 
of 150 mL.

4. Samples having different nature were analyzed as follows:
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a. 200 mg of sample weighed and Oxygen was injected for 60 seconds in a resulting 
theoretical quantity of 300 mL.

b. At the end of the analysis, after taking note of the value, the blank was run again.

c. The same procedure (sample analysis and subsequent blank analysis) was followed 
reducing the injection time at every sequence run. Checking the increased blank 
value, the combustion critical point was established. 

d. After having established the combustion critical point, the ideal 
Oxygen/sample weight factor (obtained dividing the Oxygen quantity injected by the 
sample weight) was found and stored in an appropriate category. 

e. The sample analysis was repeated starting by reducing the weight to 
100 mg, and then progressively increasing the sample weight until reaching the 
maximum quantity accepted by the container. 
Being ideal factor multiplying value memorized, the Oxygen amount for each single 
analysis was automatically calculated simply selecting the category the sample belongs 
to.

Based on these results, the following table was created:

Table of Sample Category

This table, shown in Figure 130 is displayed following the instructions of the operating 
sequence “To Fill Sample Table” on page 156. 

Figure 130. Table of sample category

The table contains:

• Four categories of samples - A, B, C, D. where the ideal factor values (Oxygen/sample 
weight-sample nature) of the samples have been prefixed.
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• The nature of samples.

• Four free categories - E, F, G, H - where sample names not considered (extraneous) in 
categories - A, B, C, D - can be memorized.
When a free category is selected, the ideal factor value, calculated by using the Oxygen 
Dosage method OxyTune®, must be entered in the appropriate box.
Before memorizing the sample name in the new category and the ideal factor value, the 
procedure previously described must be repeated.

The sample category - Blank, Bypass and Standard - is the same and is marked by the symbol 
@.
When @ is selected, a set time is entered and consequently an equal Oxygen quantity 
independently of the sample quality and nature.
This time has been preset at 30 seconds, but it can be changed according to particular 
analytical requirements.

The @ category can also be used for Unknown samples, when sample quantities below 100 
mg are weighed. Independently of the nature of the weighed samples, enter:

• 10 seconds of Oxygen for samples between 0 and 20 mg.

• 20 seconds of Oxygen for samples between 20 and 50 mg.

• 30 seconds of Oxygen for samples between 50 and 100 mg.

Note  The correct selection of the group to which the sample belongs helps you keep the 
analyzer perfectly efficient.

CAUTION  Non compliance with allocation criteria may adversely affect analytical results.

CAUTION  In analyses of Nitrogen traces, e.g. in starches analysis where Nitrogen content 
is below 0.1%, it is advisable to evaluate the blank value injecting the same Oxygen 
quantity as that used for the sample.
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Use of Eager Simplified User Interface

This chapter provides information about the use of the simplified user interface of Eager 
Xperience.

The possibility of using a simplified version of Eager Xperience is mainly addressed to users 
who do not posses a specific expertise in the instrumental field. This option however also 
concerns those who, having to run every day analyses of samples of the same nature, do not 
need any special functions of Eager Xperience. For this purpose the software is provided with a 
“password” system, which makes the application of its functions more or less extended. 
Normally the password is dedicated to the laboratory head, which allows the use of the entire 
software, besides one or more passwords dedicated to the operator or operators of the 
instrument. In this way the laboratory head has the possibility to prevent the operator from 
using the appropriate software functions he deems and to act in any moment in case of need. 
To use the simplified version of Eager Xperience, do what described in the following operating 
sequence.

Simplified User Interface
 To use the Simplified User Interface

1. In Main Menu, select File > System administration. Reply by clicking Ok to the message 
displayed. The window of Figure 131 is visualized, where passwords must be entered.

Figure 131. User password window (1)

Contents

• Simplified User Interface

ATTENTION  The use of the simplified user interface is NOT available with Eager 
Xperience USB and A/D versions.
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• The first password, dedicated to the laboratory head (System Manager), becomes active by 
clicking Add Password and entering the name in the text-box. Press Ok to confirm. See 
the top section of Figure 132.

• The second password, dedicated to the operator (Limited rights), becomes active using the 
same procedure. See the bottom section of Figure 132.

Figure 132. User password window (2)

2. To exclude the functions that have not to be available to the operator, click Edit Path. 
The window of Figure 133 is displayed. 

Figure 133. User path window

3. Select the option Enable Simplified user interface by ticking the appropriate box.

4. Select the functions that have to be available by ticking the relevant boxes.

5. Click Update. In the page displayed, it is requested to generate a directory for this 
application. 
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6. Click OK. In the window of Figure 132 click Update again. A message concerning the 
password is displayed.

 to Start The Simplified User Interface

1. When the operator (Limited Rights) opens the software, a window like that shown in 
Figure 134 will be displayed.

Figure 134. Sample table of the simplified user interface (1)

2. In the window of Figure 135 select the  Submit new sample to analyze icon to edit the 
sample table. A window like the one below is displayed.

Note  The number of icons in the window corresponds to the previously selected 
functions.
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Figure 135. Window of submit sample to run

3. Enter the Sample name and the chr filename, followed by a number. Then the file names 
and the sample names will continue to be progressively numbered.

4. Select the type of the sample to be analyzed: Sample type.

5. In the section Instrument select, in Data Method, one of the methods previously saved 
in the folder Simplified UI Method:.

6. Enter the sample Weight and, in case of N/Protein and N-Brew configurations, the 
multiplying factor Protein f: and the sample Category. Click Add.

7. Edit the table for all samples to be analyzed. At the end of editing, the sample table will 
appear filled with all information previously entered, as shown in the example of 
Figure 136. The boxes of the Status column show a Q (Queue).

Figure 136. Sample table of the simplified user interface (2)

8. To send the start to the instrument select the  icon and reply Yes to the question Are 
you sure to run queued samples?. At the end of the analytical sequence the instrument 
automatically stops.

9. To view the results, choose View > View only result of sheet.

Note  If at the end of each analysis you want to read directly the result, in the menu 
View enable the function Last sample calculated results. If for any reason you need to 
stop the analytical cycle, click the icon named Put sample on queue (no run).
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13
Maintenance

This chapter provides information on the current and periodic maintenance of the 
instrument, and it also contains the operating sequences for installation and maintenance of 
the MAS 200R Autosampler and the CM2 Manual Sampler.

Instrument Maintenance

Contents

• Instrument Maintenance

• Installing and Servicing the MAS 200R Autosampler

• Installing and Servicing the CM2 Manual Sampler

WARNING    If, for technical reasons, it is necessary to work on parts of the machine that 
may involve hazardous operations (moving parts, components under voltage, etc.). 
Thermo Fisher Scientific authorized Technical Service has to be called.
This situation can be identified because the access to these moving parts is possible only 
using a tool and because the concerned removable protective covers bear a warning symbol 
that draws the operator’s attention to the specific warnings included in the documentation 
accompanying the instrument. In case the work has to be carried out by the operator, the 
latter must prove to be adequately trained to perform the specific maintenance operation.

WARNING    When the instrument is switched off, consider that its does not cool down 
immediately, but heat tends to concentration in the upper part of the furnaces area. The 
openings provided for the chamber aeration will cause a slow cooling of same, which 
however, in the vicinity of the areas marked with the symbol “hot surfaces”, might even 
reach temperatures higher than ambient temperature. Therefore in the minutes 
immediately following the instrument switching off, the operator must consider this risk 
and pay adequate attention during any maintenance operations following the use of the 
instrument.

Note  The instrument will be generally serviced by Thermo Fisher Scientific authorized 
technical personnel for all the warranty period or, after warranty, possibly according to a 
Programmed Service Contract. For more information contact your local Thermo Fisher 
Scientific office.
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Current Maintenance

• Replacement of reactors and adsorption filters and their filling materials. 
For instrument configurations using special steel reactors for combustion it may be 
necessary also to clean the crucible done with same material.

Periodic Maintenance

• Replacement of the gas chromatographic column. The column lifetime in Flash 2000 
instrument is evaluated in years.

• Replacement of the seals of the reactors coupling unions placed on the furnace 
compartment base.

Replacing Reactors and Adsorption Filters 

The replacement of reactors and adsorption filters is performed after a preset number of 
analyses according to the setting entered in paragraph “Current Maintenance Program” on 
page 152. 

Replace and install reactors and filters according to the operating sequences described in 
Chapter 6, “Connecting Reactors and Adsorption Filters,” 

• “To Remove the Quartz Reactors from the Furnaces” on page 93

• “To Remove Special Steel Reactors from the Furnaces” on page 94

• “To Remove the Adsorption Filter” on page 95

• “To Install the Quartz Reactors into the Furnaces” on page 84

• “To Install the Special Steel Reactors into the Furnaces” on page 87

Replacement of the Filling Materials

The replacement of reactors and adsorption filters requires the replacement of their filling 
materials. This operation comprises two steps:

• Removing the exhausted filling material from the reactor.

• Restoring the sequence of the layers of filling materials using new reagents.

Perform these operations according to the instructions given in the following operating 
sequences.

Note  For some maintenance operations, furnaces and oven need to be at room 
temperature. Follow the instructions given in paragraph “Shutting Off Furnaces, Detector 
and Cutting Off Gas Flows” on page 173.
192 Flash 2000 Elemental Analyzer - Operating Manual Thermo Scientific



 13 Maintenance
Instrument Maintenance
 To Replace the Filling Material in Quartz Reactors

Remove the quartz reactor from the furnace following the instructions given in the operating 
sequence “To Remove the Quartz Reactors from the Furnaces” on page 93, then do the 
following:

1. Introduce the cleaning tool into the reactor as shown in Figure 137.

Figure 137. Removing the Filling Material from a Quartz Reactor

2. Rotate the tool exerting a slight pressure to scrape off the filling material. 

3. Collect the removed filling material as shown in Figure 138.

4. Repeat steps 1 and 2 until complete elimination of the exhausted filling materials.

Figure 138. Collection of the Material Removed from a Quartz Reactor 

5. At the end of the operation restore the layers of filling materials introducing into the 
reactor the new ones. To do this, refer to paragraphs Chapter 5, “Preparation of Reactors 
and Adsorption Filters,” according to the analyzer configuration. 

Material required

Tool for cleaning quartz reactors P/N 276 06010 (included in the Standard Outfit of all 
Flash Configurations)

Filling materials

CAUTION  Before starting the operation, check that the furnaces are at room temperature.
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 To Replace the Filling Material in Special Steel Reactors 

Remove the special steel reactor from the furnace following the instructions given in the 
operating sequence “To Remove Special Steel Reactors from the Furnaces” on page 94, then 
do the following:

1. Introduce the cleaning tool into the reactor as shown in Figure 139.

Figure 139. Removal of the Filling Material from a Special Steel Reactor

2. Rotate the tool exerting a slight pressure to scrape off the filling material and collect the 
removed filling material as shown in Figure 140.

3. Repeat steps 1 and 2 until complete elimination of the exhausted filling materials.

Figure 140. Collection of the Filling Material Removed from a Special Steel Reactor

4. At the end of the operation restore the layers of filling materials introducing into the 
reactor the new ones. To do this, refer to paragraphs “Introduction to the Preparation of 
Reactors and Filters” on page 57 and “Preparing the Reactors” on page 74, according to 
the analyzer configuration. 

Material required

Tool for cleaning special steel reactors P/N 276 06025 (included in the Standard Outfit of 
N/Protein, N-Brew and NC-Soils, NC-Sediments and NC-Filters Configurations)

Filling materials

CAUTION  Before starting the operation, check that the furnaces are at room temperature.
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 To Clean the Crucible

Remove the crucible following the instructions given in the operating sequence “To Prepare 
the Crucible” on page 78, then do the following:

1. Introduce the cleaning tool into the crucible as shown in Figure 141.

Figure 141. Removal of Quartz Wool and Ashes from the Crucible

2. Rotate the cleaning tool exerting a slight pressure in a way to scrape off the filling material 
and collect the material removed.

3. At the end of the operation, introduce new quartz wool into the crucible as described on 
page 78. 

 To Replace the Filling Material in Adsorption Filters 

Remove the adsorption filter from the detector compartment according to the instructions 
given in the operating sequence “To Remove the Adsorption Filter” on page 95, then do the 
following:

1. Unscrew the filter nut and remove the filling material.

Materials Required

Tool for cleaning quartz reactors P/N 276 06010

Quartz wool

CAUTION  Perform the operation with the furnaces at room temperature.

Material Required

Filling materials

Note  ome adsorption filters contain materials that can be regenerated, such as for instance 
molecular sieves. Therefore it is recommended to properly collect the material removed 
from the filter.
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2. Restore the sequence of the layers of filling materials introducing the new ones into the 
filter. To do this, refer to paragraphs “Introduction to the Preparation of Reactors and 
Filters” on page 57 and “Preparing the Adsorption Filters” on page 79, according to the 
analyzer configuration.

Replacement of the Gas Chromatographic Column

The instrument rarely requires the gas chromatographic column replacement, however, in 
case, operate according to the instructions given in the following operating sequence.

 To Replace the Gas Chromatographic Column

The gas chromatographic column can be installed outside or housed in the detector 
compartment.

1. Open the instrument right door. Also refer to paragraph “Detector Compartment” on 
page 30.

Figure 142. View of the Detector Compartment 

2. Remove adsorption filters from their securing clips.

3. Undo the 4 fixing screws securing the protection panel.

Material Required

Open end wrenches for the column fittings

Note  According to the instrument configuration, there can be one or two adsorption 
filters in the detector compartment.
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Figure 143. Access to the detector

Figure 144 shows the detector compartment, the heating block where the detector is housed, 
and the gas chromatographic column.

Figure 144. Compartment housing the chromatographic column

Note  According to the instrument configuration there can be one or two analytical 
columns.

Protecting plate

Fixing screws

Fixing screws

Clips securing the 
adsorption filters

TCD detector

Heating block

Chromatographic
column
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4. Unscrew the fittings from the column ends and remove the column from the 
compartment.

5. Introduce the new column and connect its ends to the fittings.

6. Re-mount the protection panel and the adsorption filters.

Replacement of the O-Rings of the Reactors Coupling Unions

To perform this operation, operate as described in the following operating sequence.

 To Replace the O-Rings of the Reactors Coupling Unions

1. Open the furnaces compartment by lifting the cover and removing the protection wall. 
Also refer to paragraph “Furnaces Compartment” on page 28.

2. Remove the reactors from the furnaces according to the instructions given in the 
operating sequence “To Remove the Quartz Reactors from the Furnaces” on page 93 
or “To Remove Special Steel Reactors from the Furnaces” on page 94.

3. Loosen the allen screws securing the reactors coupling unions to the base as shown in 
Figure 145.

Figure 145. Removal of the Reactors Coupling Unions

4. Remove the reactors coupling unions from the base and rest them on a clean surface, as 
shown in Figure 146.

Materials Required

Allen wrench

Screwdriver 

Spare seals

CAUTION  Before starting the operation, check that the furnaces are at room temperature.

Allens crews 

Reactor
coupling
union
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Figure 146. View of the reactors coupling unions

5. Using the small screwdriver, remove the O-ring from each union, as shown in Figure 147. 

Figure 147. Removal of the O-ring from the coupling union

6. Put a new O-ring into each union making sure, by using an appropriate tool, it correctly 
fits its seat, as shown in Figure 148. 

Figure 148. Introduction of the O-ring from the coupling union

Reactor
coupling
unionO-ring

Screw-
driver
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Installing and Servicing the MAS 200R Autosampler 

Introduction 

The MAS 200R autosampler for solids consists of an anodized aluminium block having on its 
left side the inlets for carrier and purge gas lines. Its modular structure allows to run up to 125 
unattended analyses.

The base unit is provided with one 32-position sample tray, but it can accommodate three 
other 32-position trays to reach a capacity of 125 samples. Each sample tray is installed in a 
specific position defined by the numbering, and therefore they are not interchangeable.

Installation

The autosampler is directly installed on the connecting nut of the concerned reactor. 

 To Install the MAS 200R Autosampler on the Flash 2000

The following operating sequence provides instructions to install the autosampler on the Flash 
2000.

Proceed as follows:

1. Connect the tubes coming from the gases connections 1 and 2 located on the analyzer, to 
the relevant connections 1 and 2 of the autosampler. 

2. Manually screw the autosampler nut on the concerned channel. 

Figure 149. Installation of the MAS 200R on the Flash 2000

Note  The installation sequence is common to all instrument configurations.

Material Required

8 mm wrench

Note  The MAS 200 R Standard Outfit includes two reactor connectors: 18 mm OD 
for Quartz reactor and 25 mm OD for HPAR. Screw the suitable connectors to the 
autosampler inserting the right relative o-ring. Also the o-ring are included in the 
Standard Outfit.
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3. Connect the signal cable of the MAS 200R autosampler to the 2-pin connector, marked 
Autosampler, on the real panel of the analyzer.

Switching Box

When the analyzer is equipped with two MAS 200R autosamplers, it is possible to switch 
from a channel to the other by using a dedicated Switching Box as schematically shown in the 
following figure:

Figure 150. Scheme of the switching box

The Sample Tray

The sample tray, shown in Figure 151, can contain up to 32 samples numbered 0 to 31. 
It is provided with a reference pin to be introduced into the seat marked 0 (zero). 
The correct alignment of the pin is critical for the installation of the sample tray on the MAS 
200 R autosampler.

Figure 151. Sample tray
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 To Install the Sample Tray

The following operating sequence provides instructions for the correct installation of the 
sample tray.

1. Manually rotate the toothed wheel clockwise until the guide located on its rim is perfectly 
aligned with the metal pin of the autosampler body, as shown in Figure 152.

Figure 152. Alignment of the Toothed Wheel

2. Check that the tray reference pin is in correspondence with the seat marked “zero”, as 
shown in Figure 151..

3. Place the sample tray, with the reference pin in correspondence with the “zero” seat, onto 
the toothed wheel, paying attention to have the base match with the guides, as shown in 
Figure 153.

4. Rotate the sample tray clockwise to select the sample position 1.

Figure 153. Installation of the Sample Tray

5. Place the protection cover over the sample tray, as shown in Figure 154, with the surface 
marked “Side up” turned towards you.

Metal pin

Guide to the 
toothed wheel
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Figure 154. Protection cover

Current Maintenance of the MAS 200 R Autosampler

The MAS autosampler does not normally require maintenance. However, when the 
instrument is extensively used, it is a good practice to clean from time to time the shaft housed 
in the autosampler.

To do this, operate as described in the following operating sequence.

 To Clean the Shaft of the MAS 200R Autosampler

This operating sequence provides instructions for the MAS autosampler maintenance.

1. In Main Menu, select the menu Edit > Edit Elemental Analyzer parameters or just click 

the icon . The Analyzer Parameter window will be displayed.

2. Select the Flow/Timing option. Set Carrier Off in the Gas Flow box.

3. Click Send and wait 2-3 minutes to discharge the gas out the circuit.

4. Remove the autosampler cover undoing the two fixing screws, as shown in Figure 155.

CAUTION  Before starting samples analyses, make sure that the protection cover is 
positioned over the sample tray. A complete deaeration of the area where samples are 
housed is only possible if the cover is in place.
Pay attention to no invert the cover; the surface marked “Side-up” must be turned 
towards you.

Materials Required

Cross screwdriver

Cloth

Silicon grease (For use at pressures down to 10-6 mm Hg)
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Figure 155. Removal of the MAS 200R autosampler cover

5. From Main Menu select the menu View > View Elemental Analyzer status or directly

click the icon .

6. In the Status window select the Special function tag , then click Step sampler tray 
position. The autosampler mechanism pushes the shaft forward and then ejects it. 

7. Take out the shaft from the autosampler, as shown in Figure 156.

Figure 156. Removal of the shaft

8. Eliminate possible traces of dirt from the shaft seals using a dry clean cloth.

9. Place and smear a slight layer of silicon grease on the o-ring. Do not use solvents. 

Figure 157 shows the shaft of the MAS autosampler.

Figure 157. Shaft of the autosampler

Fixing screws

Cover

Cross 
screwdriver

RackO-ring
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10. Re-introduce the shaft into the autosampler until in place keeping its rack turned 
downward, as shown in Figure 158.

Figure 158. Reinstalling the shaft (1)

11. Slightly pushing the shaft with one finger of your hand, as shown in Figure 159, click 
Step Sampler tray position again. 
The autosampler mechanism first tries to eject the shaft, then, on the motor reversal, the 
mechanism will hook the shaft and draw it inside the autosampler (2). 

Figure 159. Reinstalling the shaft (2)

12. Re-install the autosampler cover using the two fixing screws.

13. Return to Analyzer Parameter window. Restore the operating conditions setting the 
carrier gas flow to the initial value.
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Installing and Servicing the CM2 Manual Sampler 

Introduction

The CM2 manual sampler, shown in Figure 160, consists of a base block provided with a 
sampling chamber and a lever for the injection of samples into the reactor.

The sample is placed inside the sampling chamber, which must then be closed by turning the 
appropriate nut. On the Start command, after the time delay set in the method, push the lever 
towards the sampler and the sample will fall into the reactor. The lever is the brought to its 
starting position.

Figure 160. CM2 manual sampler

Installation

The sampler is directly installed on the connecting nut of the concerned reactor. 

 To Install the CM2 Manual Sampler 

The following operating sequence provides instructions to install the autosampler on the Flash 
2000.

1. Connect the tubes coming from the gases connections, located on the analyzer, to the 
relevant connections on the sampler.

a. Connect the tube for Helium as carrier gas (connection 2) to the connection located 
on the left side of the sampler.

b. Connect the tube for Helium as reference gas (connection 1) to the connection 
located on the lower part of the sampler. 

2. Manually screw the autosampler nut on the concerned channel. 

Note  The installation sequence is common to all instrument configurations.

Material Required

8 mm wrench
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Current Maintenance of the CM2 Sampler

The CM2 sampler does not usually require maintenance. However, when the instrument is 
extensively used, it is a good practice to replace the three seals inside it. To do this, operate as 
described in the following operating sequence.

 To Replace the CM2 Sampler Seals

The following operating sequence provides instructions to maintaining the CM2 manual 
sampler.

Figure 161. Parts of the CM2 manual sampler

Proceed as follows referring to Figure 161.

1. Remove the CM2 manual sampler from the analyzer.

2. Insert a spanner into the hole A and unscrew the handle14.

CAUTION  The dismounting and re-assembling of the sampler MUST be performed with 
great care and under very clean operating conditions, because the presence of even the 
smaller solid particle in the sampling mechanism may jeopardize the performance of the 
sampler producing high blank values.

Material Required

Spanner

Seals (O-ring)

Screwdriver
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3. Unscrew the locking nut 3.

4. Remove the shaft 2 completely together with parts 12, 4, 15, 7, 13, 6 and 8.

5. Take off the pin 12 from the shaft 2 and remove the ring 4.

6. Remove clip 15 from both ends

7. Take off 6, 7 and 8.

8. Replace the three o-rings 13.

9. Reassemble all parts in the reversed order.

10. When introducing the shaft 2, check that its plane is down and make sure that the hole of 
the body 1 and the hole of 2 are aligned.

11. The manual sampler should slide smoothly and easily into the body. Otherwise check 
again the alignment between the shaft 2 and the pin 12.

12. Screw the locking nut 3.

13. Insert a spanner into the hole A and screw the handle 14.
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Troubleshooting

This chapter provides information necessary to find out instrument troubles and to solve 
them.

Safety Cut Off
Instrument malfunctioning, due to a component failure or to abnormal operating 
conditions, is identified by the red lighting of the Safety Cut Off LED indicator. 
When lit, this LED indicates that the furnaces and detector oven power has been 
cut off for safety reasons. 

The Safety Cut Off status is followed by an error message about the possible cause of error. 

 To Display the Error Message

Proceed as follows:

1. In the Main menu select View > View Elemental Analyzer Status or just press the icon

.

2. In the displayed dialog window, select the option Special Functions. The dialog window 
of Figure 162 is displayed.

3. Read the error message in the reading box located on the lower right side of the window, 
below the buttons Help and OK.

4. Refer to Table 45 to find out the error status and have mode information.

Contents

• Safety Cut Off

• EFC-t Module
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Safety Cut Off
Figure 162. Special function window

The following Table 45 reports the error messages and the explanation of the relevant 
correlated problem. 

1. Error Message Reading Box

Table 45. Error messages

Message Description

Voltage supplied to electric circuit is too low. Not 
significant error. 
When voltage returns within limits, the instrument 
automatically goes back to operating conditions.

Furnaces control SSR relay is overheated

Right furnace has exceeded the set temperature limit. 
Temperature has been set with furnace missing

Left furnace has exceeded the set temperature limit. 

The detector oven temperature exceeds the 220 °C.
Error may be due to a probe malfunction, etc.

The Oxygen pressure supply is too low

1

safety cut off 
Voltage out limit

safety cut off 
SSR thermal protection

safety cut off 
out of limit right

safety cut off 
out of limit left

safety cut off 
Oven limit

safety cut off 
Oxygen pressure too low

CAUTION  The error message is generally due to the specific cause indicated. Sometimes, 
it may generated by different electric factors or caused by failures not depending on the 
system. In this case contact the Technical Service. 
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EFC-t Module
The failures that may be generated on the EFCt Module are connected to the breakage or to 
the malfunctioning of solenoid valves and flow sensors. 

Refer to the Table 46 to find the component responsible of the EFCt module malfunctioning 
and to solve the relevant problem. 

Table 46. EFC-t module troubleshooting

Failure Defective Component Remedy

Oxygen does not flow to the 
point 2 of the autosampler 

EV1 Check voltage supply 
Replace the solenoid valve

EV2 Check voltage supply 
Replace the solenoid valve

The Helium flow measured on 
point 1 or 2 cannot be adjusted

Flow sensor 1 or 2. Replace flow sensor

EVP1 or EVP2 Check voltage supply 
Replace the solenoid valve

The pneumatic circuit is 
perfectly close but the flow value 
don’t decrease up to zero 
performing the Leak Test.

EV3 and/or EV4 Check voltage supply 
Replace the solenoid valve
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A

Customer Communication

Thermo Fisher Scientific provides comprehensive technical assistance worldwide and is 
dedicated to the quality of our customer relationships and services.

How to Contact Us
This appendix contains contact information for Thermo Fisher Scientific office. To contact 
your local Thermo Fisher Scientific office or affiliate, please refer to:

This appendix also contains a one-page Reader Survey. Use this survey to give us feedback on 
this manual and help us improve the quality of our documentation.

Thermo Fisher Scientific

19 Mercers Row, Cambridge, CB5 8BZ
United Kingdom

Tel: +44(0)1223 347400 Fax: +44(0)1223 347403
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Reader Survey
Reader Survey
Product: Flash 2000 Elemental Analyzer
Manual: Operating Manual
Part No.: 317 082 41

Please help us improve the quality of our documentation by completing and returning this 
survey. Circle one number for each of the statements below:

If you would like to make additional comments, please do. (Attach additional sheets if 
necessary).

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

Fax or mail this form to:

Thermo Fisher Scientific

19 Mercers Row
Cambridge
CB5 8BZ
United Kingdom
Tel: +44 (0) 1223 347400
Fax: +44 (0) 1223 347403

Strongly 
Agree

Agree Neutral Disagree Strongly 
Disagree

The manual is well organized. 1 2 3 4 5

The manual is clearly written. 1 2 3 4 5

The manual contains all the information I need. 1 2 3 4 5

The instructions are easy to follow. 1 2 3 4 5

The instructions are complete. 1 2 3 4 5

The technical information is easy to understand. 1 2 3 4 5

Examples of operation are clear and useful. 1 2 3 4 5

The figures are helpful. 1 2 3 4 5

I was able to install the system using this manual. 1 2 3 4 5
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G

Abbreviations

This section lists and defines terms used in this guide. It 
also includes acronyms, metric prefixes, symbols and 
abbreviations.

A  ampere

ac  alternating current

ADC  analog-to-digital converter

b  bit

B  byte (8 b)

baud rate  data transmission speed in events per second

C  Carbon

°C  Celsius

cm  centimeter

CPU  central processing unit (of a computer)

CSE  Customer Service Engineer

<Ctrl>  control key of the keyboard

d  depth

DAC  digital-to-analog converter

dc  direct current

DS  data system

EMC  electromagnetic compatibility

ESD  electrostatic discharge

ºF  Fahrenheit

FSE  Field Service Engineer

ft  foot

g  gram

GND  electrical ground

h  height

h  hour

H  hydrogen

harmonic distortion  A high-frequency disturbance 
that appears as distortion of the fundamental sine 
wave

He  Helium

HPAR  High Performance Alloy Reactor

HV  high voltage

Hz  hertz (cycles per second)

IEC  International Electrotechnical Commission

in.  inch

I/O  input/output

k  kilo (103 or 1024) 

K  Kelvin

kg  kilogram

kPa  kilopascal

l  length

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
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Glossary: 
l  liter

LAN  Local Area Network

lb  pound

LED  light-emitting diode 

m  meter (or milli [10-3])

M  mega (106)

μ  micro (10-6)

min  minute

mL o ml  milliliter

mm  millimeter

m/z  mass-to-charge ratio 

N  nitrogen

n  nano (10-9)

O  oxygen

Ω  ohm

p  pico (10-12)

Pa  pascal

PCB  printed circuit board

PN  part number

psi  pounds per square inch

RAM  random access memory

<Return>  <Return> key on the keyboard

RF  radio frequency

ROM  read-only memory

RS-232  industry standard for serial communication

s  second

slow average  A gradual long-term change in average 
RMS voltage level, with typical duration greater than 
2 s.

surge  A sudden change in average RMS voltage level, 
with typical duration between 50 μs and 2 s.

S  sulphur

TCD  Thermal Conductivity Detector

transient  A brief voltage surge of up to several 
thousand volts, with a duration of less than 50 μs.

V  volt

V ac  volts, alternating current

V dc  volts, direct current

VGA  Video Graphics Array

w  width

W  Watt

When a unit of measure has a quotient (e.g. Celsius degrees 
per minute or grams per liter) this can be written as 
negative exponent instead of the denominator: 
For example:
°C min-1 instead of °C/min 
g L-1 instead of g/L
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A
Adsorption Filter

Filling  80
Adsorption Filters  55
AI 3000/AS 3000 II Autosampler  40
Analyses

Sequence
Execution  163

Analytical Method
CHN Configuration  111
CHN-O Configuration  113
CHNS Configuration  115
CHNS-O Configuration  117
N (Nitrogen) Configuration  123
N Lubricant  131
N-Brew  131
N-Brew Configuration  131
NC Configuration  125
NC-Filters Configuration  129
NC-HT  135
NC-IRMS  133
NCS Configuration  127
NC-Sediments Configuration  129
NC-Soil  129
N-Protein Configuration  131
O (Oxygen) Configuration  121
S (Sulfur) Configuration  119

Analytical Methods
Introduction  110

Analytical Results
Comparison  167

Analytical Section  21, 21
Adsorption Filters  22
Autosampler  22
Chromatographic Columns  22
Furnaces  21
Reactors  22
Thermal Conductivity Detector (TCD)  22

Analytical Troubleshooting  176
Applications

Automatic Oxygen Dosage  182
Introduction  179
Sample Oxidation  179

How to Change the Oxygen Quantity  180
Automation  23

Autosamplers  40
AI 3000/AS 3000 II for Liquid Samples  40
CM2 Manual Sampler  40
MAS 200 for Solids  40

Auto-Start Function  174, 175

B
Balance Parameters Settin  166
Blank Value

Checking with No Printer Available  162
Checking with Printer Available  160
Determination  159

C
Calculation Parameter  155
Calibration Curves  155

View  155
calibration methods  154
Classification  13
CM2 Manual Sampler

Current Maintenance  207
Installation  206
Replacing the Seals  207
Servicing  206

Connecting the Adsorption Filters  91
Connections Panel  35
Control Section  22

Electronic Compartment  23
Pneumatic Compartment  22

Current Maintenance  192
Current Maintenance Program  152
Cutting Off

Gas Flows  173

D
Detection System

Description  32
Detector Compartment  30

Access to the Detector  31
Detector Signal Level  148

Adjustment  148
Directory for Analyses  152
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Index: E
E
Eager Xperience

Installation Menu  140
Eager Xperience Software  140
Edit Standard Table  165
EFC Module  43
Electrical Compartment  33

Low Voltage Section  33
Rechargeable battery  34

Mains Voltage Section  34
Elemental analyzer setup  144
Environmental Conditions  13

F
Filling Materials  56
Fixing Plates for the Reactors  29
Found Values  169
Front Panel  26, 26
Furnaces Compartment  28

G
Gas Chromatographic Column

Replacement  196
Replacing  196

Gas Chromatographic Columns  56

I
Installing the Adsorption Filters  90, 91

Preliminary Operations  91
Installing the CM2 Manual Sampler  206
Installing the MAS Autosampler on the Elemental Analyzer  
200
Installing the Reactors into the Furnaces  83

Preliminary Operations  84
Quartz Reactor  84
Spaecial Steel Reactor  87

Instrument
Classification  13
Cleaning  15
Configuration  15
Safety  15
Sleeping Mode  172

Instrument Calibration  154
Instrument Configuration  144

N Lubricant Analyzer  16
NC-IRMS HT  17
OH-IRMS HT  17
CHN-O Analyzer  16
CHNS Analyzer  16
CHNS-O Analyzer  16
N Analyzer  16
N-Brew Analyzer  17
NC Analyzer  17

NC-Filters Analyzer  17
NCS Analyzer  17
NC-Sediments Analyzer  17
NC-Soil Analyzer  17
N-Protein Analyzer  17
O Analyzer  16
S Analyzer  16

Instrument Maintenance  191
Instrument Start Up

Introduction  139

L
Leak Test  146

Checking  146

M
Maintenance  191

Cleaning the Crucible  195
Replacing the Filling Material in Adsorption Filters  195
Replacing the Filling Material in Quartz Reactor  193
Replacing the Filling Material in Special Steel Reactors  194

Manual Injection Device for Liquids  40
MAS Autosampler

Cleaning the Cylinder  203
Cleaning the Shaft  203
Current Maintenance  203
Installation  200
Installing the Sample Tray  202
Servicing  200
The Sample Tray  201

Maximum relative humidity  13
Method for Oxygen Dosage (Oxy Tune)  182
Modulo EFC  211

N
N Lubricant Analyzer  16
NoBlank Sampling Device  40
Notes  99

O
O-Rings of the Reactors Coupling Unions

Replacing  198

P
Periodic Maintenance  192
Pneumatic Circuit  23

CHN Configurations  45
CHN-O Configurations  44
CHNS Configuration  45
CHNS-O Configurations  44, 44
N  48
N Configuration  48, 49
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NCS Configuration  46
NC-Sediments Configuration  47
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O Configuration  46
OH-IRMS HT Configuration  49
S Configuration  46

Pneumatic Circuits
EFC Module  43
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Powering on the System  139
Preparation of Reactor and Filters

N Lubricant Configurations  67
Preparation of Reactors

Introduction  57
Preparation of Reactors and Adsorpion Filters

N-Brew  71
NC with the Flash HT  73
NC with the Flash IRMS  72
CHN Configuration  58
CHN-O Configuration  59
CHNS Configuration  61
CHNS-O Configuration  62
N (Nitrogen) Configuration  66
NC Configuration  68
NC-Filters Configuration  70
NCS Configuration  69
NC-Sediments Configurations  70
NC-Soil Configurations  70
N-Protein Configuration  71
O (Oxygen) Configuration  65
S (Sulfur) Configuration  64

Preparation of Reactors and Filters N-Brew Configuration  71
Preparing the Adsorption Filters  79
Preparing the Crucible  78
Preparing the Reactors  74
Preparing the Sample

Homogenizing
Carbons  98

Preparing the Samples
Homogenizing  97

Liquids  99
Metals  98
Minerals  98
Plastics  99
Sediments  98
Soils  98
Vegetals  99

Introduction  97

Q
Quartz Reactor

Filling  74

R
Reactors  55
Rear Panel  26
Recalculation  167
Removing Reactors from the Furnaces

Quartz Reactor  93
Special Steel Reactor  94

Removing the Adsorption Filters  95
Removing the Reactors  93
Replacement of the Filling Materials  192
Replacement of the O-Rings of the Reactors Coupling Unions  
198
Replacing Adsorption Filters  192
Replacing Reactors  192
Results

Graphic Display  170
Interpretation  167

RS 232  36

S
Safety Cut Off  34, 209
Safety Cut Off Device  15
Safety Information  14

Nominal Pressure of Gases  15
Purity of Gases  14
Use of Gases  14

Sample table
Fill  156

Sample Weighing Technique  99
Samples

Comparison  169, 169
Shutting Off  173

Detector  173
Furnaces  173

Special Steel Reactor
Filling  76

Standard Outfit  17
Standard Warranty  xiii
Summarize results  167, 170
Synoptic Panel  38

T
Technical Features  14
Temperature  13
Theoretical Values  169
Top Panel  27
Transformers Compartment  37

Devices for the Furnaces Control  37
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U
Units Constituting the Instrument  21
Use of Eager Simplified User Interface  185

V
Voltage variations  13

W
Wake-up Function  174, 174
Weighing Technique  99

Large Quantities of Solid Samples  101
Liquid Samples  100, 105
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Solid Samples  100
Viscous Samples  108
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